# Content

1 Introduction. .......................................................... 5  
1.1 About this Document. .............................................. 5  
1.2 SAP Notes for the Installation. ................................. 6  
1.3 Information Available on SAP Help Portal. .................. 11  
1.4 Naming Conventions. .............................................. 14  

2 Planning. .............................................................. 17  
2.1 Overall System Planning. ......................................... 17  
2.2 System Landscape Variants. ....................................... 20  
   SAP Allocation Management for Retail. ......................... 20  
   SAP Assortment Planning for Retail. .............................. 21  
   SAP Customer Activity Repository. ............................... 25  
   SAP Merchandise Planning for Retail. ............................ 29  

3 Prerequisites. ......................................................... 32  

4 Preparation. .......................................................... 40  
4.1 SAP Assortment Planning for Retail. ......................... 40  
   Verify SAP HANA Users and Privileges. ....................... 40  
   Configure AFL Usage. ............................................. 42  

5 Installation. .......................................................... 44  
5.1 Install Prerequisites and SAP Notes. ......................... 44  
5.2 Install ABAP Back-End Server. ................................. 44  
   Install SAP Customer Activity Repository Retail Applications Bundle. .............................. 44  
   Set Up SAP Client. .................................................. 47  
   Create/Replicate Source Master Data System Tables. .................................................. 49  
5.3 Install ABAP Front-End Server. ................................. 51  
5.4 Install Alternate Storage (Optional). .......................... 54  
   Install and Set Up Integration with SAP IQ. .................... 54  
   Install and Set Up Integration with Apache Hadoop. ............ 56  
   Install and Set Up Integration with SAP HANA Dynamic Tiering. ................................ 61  
   Create the Remote Source in SAP HANA Studio. ............... 62  
   Create the Virtual Table. ......................................... 62  
   Set the Deploy Mode in SAP HANA Transport for ABAP. .......... 62  

6 Post-Installation. ................................................... 64  

Common Installation Guide CARAB 2.0
6.1  SAP Allocation Management for Retail .............................. 64
    Configure Backend System ................................................ 64
    Verify Users, Privileges, and Roles .................................... 65
    Create SAP ERP Tables ..................................................... 65
    Activate SAP HANA Content for SAP Allocation Management for Retail ................................................ 65
    Configure Data Replication .............................................. 66
    Configure SAP Gateway ..................................................... 70
    Configure Index Calculation ............................................. 74
    Configure Central UI Component ....................................... 75
    Activate SAP Allocation Management for Retail OData Services ............................................ 76
    Activate SAP Allocation Management for Retail ICF Services ................................................ 77
    Assign Roles, Catalogs, and Groups in SAP Fiori Launchpad ........ 78

6.2  SAP Assortment Planning for Retail .................................. 79
    Configure the Back-End System ........................................ 80
    Verify Users, Privileges, and Roles .................................... 82
    Activate SAP Assortment Planning for Retail Planning Framework Content ........................................ 84
    Configure Data Replication .............................................. 103
    Run the Validation Report ............................................... 114
    Configure Front-End ...................................................... 114
    Configure SAP Jam (Optional) ........................................... 125

6.3  SAP Customer Activity Repository .................................. 126
    Configure SAP Smart Business for Multichannel Sales Analytics (Optional) ........................................ 128
    Activate SAP HANA Content ............................................. 138
    Generate Time Data ....................................................... 139
    Configure On-Shelf Availability (Optional) ........................ 140
    Ensure that Third Party CRM Sales Orders are Transferred to SAP ERP (Optional) ........................................ 146
    Partition /POSDW/TLOGF Table (Optional) ........................ 147
    Customize Copies of SAP HANA Views (Optional) ................. 147
    Configure Demand Data Foundation (Optional) ...................... 149
    Configure Unified Demand Forecast (Optional) ....................... 154
    Partition Tables for UDF and DDF (Optional) ......................... 157
    Configure Standalone SAP Fiori Apps for SAP Customer Activity Repository (Optional) ....................... 159
    Configure Omnichannel Article Availability and Sourcing for Use with SAP Customer Activity Repository (Optional) ................................................ 164
    Configure Omnichannel Promotion Pricing for Use with SAP Customer Activity Repository ............. 166
    Troubleshooting ............................................................. 166

6.4  SAP Merchandise Planning for Retail ............................... 175
    Configure Demand Data Foundation ..................................... 175
    Activate SAP Merchandise Planning for Retail Planning Framework Content ........................................ 177
    Configure Data Replication Steps ...................................... 210
    Specify Analysis Workbooks Settings ................................. 217
6.5 SAP Promotion Management for Retail. ......................................................... 218
    Activate Internet Communication Framework (ICF) Services. ........................ 218

7 Additional Information. ................................................................................... 220
7.1 Workbook Design Example. ........................................................................... 220
# Introduction

## 1.1 About this Document

### Purpose

This guide provides you with information on the installation and implementation processes of the following SAP applications:

<table>
<thead>
<tr>
<th>Application</th>
<th>SAP Help Portal with Product Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Allocation Management for Retail 1.5</td>
<td><a href="http://help.sap.com/amr15">http://help.sap.com/amr15</a></td>
</tr>
<tr>
<td>SAP Assortment Planning for Retail 2.0</td>
<td><a href="http://help.sap.com/rap">http://help.sap.com/rap</a></td>
</tr>
<tr>
<td>SAP Customer Activity Repository 3.0</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a></td>
</tr>
<tr>
<td>SAP Merchandise Planning for Retail 1.1</td>
<td><a href="http://help.sap.com/mpr">http://help.sap.com/mpr</a></td>
</tr>
<tr>
<td>SAP Promotion Management for Retail 8.2</td>
<td><a href="http://help.sap.com/retail-pm">http://help.sap.com/retail-pm</a></td>
</tr>
</tbody>
</table>

For more information on these applications and their business scenarios, see the Common Master Guide at http://help.sap.com/car/<your release> Installation and Upgrade Information Master Guide.

Technically, the application versions described in this guide are shipped in the following installable product versions:

<table>
<thead>
<tr>
<th>Product Version</th>
<th>Description</th>
<th>More Information in Specific Release Information Note (RIN)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAR RETAIL APPL BUNDLE 2.0</td>
<td>Back-end product version</td>
<td>SAP Note 2377015: RIN SAP Customer Activity Repository retail applications bundle 2.0</td>
</tr>
<tr>
<td>SAP FIORI FOR SAP CARAB 3.0</td>
<td>Front-end product version</td>
<td>SAP Note 2377081: RIN: Release information note SAP FIORI for SAP CARAB 3.0</td>
</tr>
</tbody>
</table>
Installation Versus Implementation

- **Installation**: For a correct installation, you must **always install all components**. This means, all software component versions included in the CAR RETAIL APPL BUNDLE back-end product version and the SAP FIORI FOR SAP CARAB front-end product version. For more information on these product versions, see *Overall System Planning [page 17]*.

- **Implementation**: Once you have completed the installation, you only need to implement and configure those components that are required for your specific **implementation scenario**. For detailed descriptions, see *Implementation Scenarios*.

Upgrade

⚠️ **Caution**

If you have an existing installation of any of these applications, you must perform a software upgrade rather than a new installation:

<table>
<thead>
<tr>
<th>Application</th>
<th>Upgrade Information</th>
</tr>
</thead>
</table>

1.2 **SAP Notes for the Installation**

The following list includes SAP Notes that you must read (and, when appropriate, implement) **before you start the installation**.

Make sure that you have the up-to-date version of each SAP Note, which you can find on the SAP Support Portal at [http://support.sap.com/notes](http://support.sap.com/notes).
<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2379029</td>
<td>Release and Information Note (RIN) - SAP Customer Activity Repository 3.0</td>
<td>This note serves as an entry point for SAP Customer Activity Repository 3.0. It provides up-to-date information on the current release, together with a list of important SAP Notes that you must apply to complete the installation process.</td>
</tr>
<tr>
<td>2183947</td>
<td>Smart Business for SoH (Suite on Hana) delivery</td>
<td>Information on how to install add-on object UI-SAFND1100 when installing the SAP Smart Business Modeler Apps Framework with User Interface Add-On 2.0 for SAP NetWeaver.</td>
</tr>
<tr>
<td>1605140</td>
<td>SAP HANA 1.0: Central Note - SAP LT Replication Server</td>
<td>Collective note for all the relevant SAP Notes for LT Replication Server for SAP HANA.</td>
</tr>
<tr>
<td>1778607</td>
<td>SAP HANA Live for SAP Business Suite</td>
<td>What to consider when implementing SAP HANA Live for SAP Business Suite.</td>
</tr>
<tr>
<td>1791342</td>
<td>Time Zone Support in SAP HANA</td>
<td>How to handle time zone functions UTC_TO_LOCAL and LOCAL_TO_utc.</td>
</tr>
<tr>
<td>2387939</td>
<td>Invalid Selection Input Cause an Empty POS Workbench Screen</td>
<td>How to correct a specific error with the POS Workbench user interface.</td>
</tr>
<tr>
<td>2388066</td>
<td>Move S4H view into dedicated S4H package</td>
<td>Mandatory correction to the SAP HANA content activation report for SAP Customer Activity Repository.</td>
</tr>
<tr>
<td>2390790</td>
<td>HANA Content Activation</td>
<td>Mandatory correction to the SAP HANA content activation report for SAP Customer Activity Repository.</td>
</tr>
<tr>
<td>2392194</td>
<td>CAR Activation Report - Enablement of POSDM on S/4HANA</td>
<td>Mandatory correction to the SAP HANA content activation report for SAP Customer Activity Repository.</td>
</tr>
<tr>
<td>2387956</td>
<td>CAR Activation Report - Fixes for Customer Activity Repository, As-</td>
<td>Corrections to /CAR/ACTIVATE_HTA report.</td>
</tr>
<tr>
<td></td>
<td>sortment Planning and Demand Data Foundation</td>
<td></td>
</tr>
<tr>
<td>2376424</td>
<td>UDF Integration with S4H</td>
<td>Required to use UDF with an SAP S/4HANA source master data system.</td>
</tr>
<tr>
<td>2372802</td>
<td>Analyze Forecast: SAP Fiori ID F1773A - Fix Negative Time Zone Offset Bug</td>
<td>Corrects a time zone issue in the Analyze Forecast SAP Fiori app.</td>
</tr>
<tr>
<td>SAP Note Number</td>
<td>Title</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>2389537</td>
<td>Previous UDF modeling results are deleted if there are issues in new data</td>
<td>Corrects a data issue in demand modeling with UDF.</td>
</tr>
</tbody>
</table>

Table 5: SAP Notes for SAP Allocation Management for Retail

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2374336</td>
<td>Release Information Note (RIN) for SAP Allocation Management for Retail 1.5</td>
<td>This note serves as an entry point for SAP Allocation Management for Retail 1.5.</td>
</tr>
<tr>
<td>2374362</td>
<td>Release Information Note (RIN) for SAP Allocation Management for Retail 1.5</td>
<td>This note contains information, references, and notes in the context of applying SAP Allocation Management for Retail 1.5 <strong>back end</strong> part.</td>
</tr>
<tr>
<td>2374343</td>
<td>Release Information Note (RIN) for SAP Allocation Management for Retail 1.5</td>
<td>This note contains information, references, and notes in the context of applying SAP Allocation Management for Retail 1.5 <strong>UI</strong> part.</td>
</tr>
<tr>
<td>2389316</td>
<td>Collective Note - AMR Correction Wave 1 before RTC</td>
<td>This note comprises all corrections for SAP Allocation Management for Retail for all architecture layers, i.e. SAP Fiori, ABAP (gateway and back end), and SAP HANA DB.</td>
</tr>
<tr>
<td>2340418</td>
<td>SAP HANA DB: RUTDDLSCREATE returns errors for CDS views with external views as base object</td>
<td>SAP HANA DB</td>
</tr>
<tr>
<td>2374190</td>
<td>ABAP CDS: Inconsistency in Reference Table/Field of CDS Views selecting from Table Functions; AMDP Table Function client handling</td>
<td>ABAP CDS: Inconsistency in reference table or field</td>
</tr>
</tbody>
</table>

Table 6: SAP Notes for SAP Assortment Planning for Retail

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2196351</td>
<td>Pre-requisite for SAP Note #2196323</td>
<td>Corrections to SAP Retail data elements.</td>
</tr>
<tr>
<td>2196323</td>
<td>DRFOUT: Only valid current node assignments and article assignments are transferred during Article Hierarchy Replication</td>
<td>Article Hierarchy Transfer replication will transfer all node and article assignments irrespective of the validity.</td>
</tr>
<tr>
<td>SAP Note Number</td>
<td>Title</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2209621</td>
<td>Assortment Listing API: List by DC fix</td>
<td>Functionality on the SAP Retail side to enable PIR integration with SAP Assortment Planning for Retail.</td>
</tr>
<tr>
<td>2286994</td>
<td>New Listing API for Retail Assortment Planning</td>
<td>Supports:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Different listing periods for different products within an assortment</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Changes in the listing after a product has been listed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● In-season listing changes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Multiple validity time periods for the same location</td>
</tr>
</tbody>
</table>

**SAP Notes for Back-End System**

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2022080</td>
<td>Upgrade of PAL AFL and BFL AFL from SAP HANA earlier release to SPS08</td>
<td>Corrections to add privileges removed during upgrade to SAP HANA Platform SPS 08.</td>
</tr>
<tr>
<td>2388066</td>
<td>Move S4H view into dedicated S4H package</td>
<td>Corrections to /CAR/ACTIVATE_HTA report.</td>
</tr>
<tr>
<td>2390790</td>
<td>HANA Content Activation</td>
<td>Corrections to /CAR/ACTIVATE_HTA report.</td>
</tr>
<tr>
<td>2392194</td>
<td>CAR Activation Report - Enablement of POSDM on S/4HANA</td>
<td>Corrections to /CAR/ACTIVATE_HTA report.</td>
</tr>
<tr>
<td>2395997</td>
<td>2395997 - SAP Assortment Planning for Retail 2.0 (FPO) - Season, Collection and Theme issue</td>
<td>Corrections to /CAR/ACTIVATE_HTA report.</td>
</tr>
<tr>
<td>2387956</td>
<td>CAR Activation Report - Fixes for Customer Activity Repository, Assortment Planning and Demand Data Foundation</td>
<td>Corrections to /CAR/ACTIVATE_HTA report.</td>
</tr>
<tr>
<td>2392499</td>
<td>Assortment Planning: Module location validity activates entire cluster</td>
<td>Corrections to Plan Assortment workbook.</td>
</tr>
<tr>
<td>2387526</td>
<td>Performance enhancements for Loc Clustering Capacity and Planned Sales</td>
<td>Performance enhancements.</td>
</tr>
</tbody>
</table>

**SAP Notes for Front-End Server**
### SAP Note Number | Title | Description
--- | --- | ---
2383938 | RIN SAP Fiori for SAP Assortment Planning for Retail 2.0 | Common note containing correction instructions that must be implemented following the installation of the SAP Fiori UI Components on the frontend server.
2296550 | LPD_CUST system Alias is not recognized | Corrections to central SAP Fiori component.

#### SAP Notes for Planning Functionality Used by SAP Assortment Planning for Retail

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1637199</td>
<td>Using the planning applications KIT</td>
<td>Important information for running the Planning Application Kit (PAK).</td>
</tr>
<tr>
<td>2322360</td>
<td>Missing field labels in FIORI applications</td>
<td>Corrections to SAP Fiori label display.</td>
</tr>
<tr>
<td>2336099</td>
<td>Termination when calling input help (SAP HANA model, restriction to long text)</td>
<td>Corrections to input help.</td>
</tr>
<tr>
<td>2327576</td>
<td>BW-PLA-IP: Exit for generation of characteristic combinations with SQLScript</td>
<td>Corrections to the generation of characteristic combinations.</td>
</tr>
<tr>
<td>2338767</td>
<td>HCPR Column View is not generated on after import</td>
<td>Corrections to usage of composite providers.</td>
</tr>
<tr>
<td>1662968</td>
<td>Clarification on setting ResultSetSizeLimit in Analysis Office</td>
<td>Information on changing the default ResultSetSizeLimit registry setting.</td>
</tr>
<tr>
<td>2074801</td>
<td>Dumps and Issues with special InfoObjects like OFISCYEAR, 0CALMONT...</td>
<td>Corrections to in-memory planning.</td>
</tr>
<tr>
<td>2364967</td>
<td>BICS: Delta update result set empty after variable submit or reprocessing of query view</td>
<td>Corrections to reprocessing variables and/or query views.</td>
</tr>
</tbody>
</table>

### Table 7: SAP Notes for SAP Merchandise Planning for Retail

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All SAP notes for SAP Customer Activity Repository are required.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2391503</td>
<td>Release Information Note</td>
<td>The list of all SAP notes relevant for MPR (including BW IP in component SAP_BW).</td>
</tr>
</tbody>
</table>
Table 8: SAP Notes for SAP Promotion Management for Retail

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2026580</td>
<td>Release strategy for the ABAP add-on RTLPROMO</td>
<td>This SAP Note contains information about planning the installation and upgrades of the ABAP add-on RTLPROMO.</td>
</tr>
<tr>
<td>2163602</td>
<td>DRFOUT: Incorrect timestamp send for Moving Average Price</td>
<td>This SAP Note contains information on correcting the timestamp field when using DRFOUT to replicate the Moving Average Price.</td>
</tr>
<tr>
<td>2292852</td>
<td>It is required to transfer Offers in SAP PMR to SAP ERP to enable logistical processing of the articles in the sites</td>
<td>This SAP Note describes ways to send non-transferable offers to SAP ERP by means of custom enhancements.</td>
</tr>
</tbody>
</table>

1.3 Information Available on SAP Help Portal

Table 9: Information on the Applications Provided with SAP Customer Activity Repository Retail Applications Bundle

<table>
<thead>
<tr>
<th>Description</th>
<th>Path</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information on SAP Assortment Planning for Retail</td>
<td><a href="http://help.sap.com/retail-apr2">http://help.sap.com/retail-apr2</a></td>
<td>SAP Assortment Planning for Retail 2.0</td>
</tr>
<tr>
<td>Information on SAP Merchandise Planning for Retail</td>
<td><a href="http://help.sap.com/retail-mpr11">http://help.sap.com/retail-mpr11</a></td>
<td>SAP Merchandise Planning for Retail 1.1</td>
</tr>
<tr>
<td>Information on SAP Promotion Management for Retail</td>
<td><a href="http://help.sap.com/retail-pmr82">http://help.sap.com/retail-pmr82</a></td>
<td>SAP Promotion Management for Retail 8.2</td>
</tr>
</tbody>
</table>

Table 10: Information on Prerequisite Platforms, Applications, and Other Components

<table>
<thead>
<tr>
<th>Description</th>
<th>Path</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Path</td>
<td>Title</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Information on installing SAP HANA database clients</td>
<td><a href="http://help.sap.com/hana_platform">http://help.sap.com/hana_platform</a>&lt;br&gt;&lt;your support package stack&gt;&lt;br&gt;Installation and Update &gt; SAP HANA Client Installation and Update Guide</td>
<td>SAP HANA Client Installation and Update Guide</td>
</tr>
<tr>
<td>Information on installing SAP HANA studio</td>
<td><a href="http://help.sap.com/hana_platform">http://help.sap.com/hana_platform</a>&lt;br&gt;&lt;your support package stack&gt;&lt;br&gt;Installation and Update &gt; SAP HANA Studio Installation and Update Guide</td>
<td>SAP HANA Studio Installation and Update Guide</td>
</tr>
<tr>
<td>Information on installing the SAP LT (Landscape Transformation) Replication Server for SAP HANA</td>
<td><a href="http://help.sap.com/hana">http://help.sap.com/hana</a>&lt;br&gt;SAP HANA&lt;br&gt;SAP HANA Options&lt;br&gt;SAP HANA Real-Time Replication&lt;br&gt;SAP HANA Trigger-Based Data Replication Using SAP LT Replication Server&lt;br&gt;Installation and Upgrade Information</td>
<td>Installation Guide - Trigger-Based Data Replication Using SAP LT Replication Server for SAP HANA</td>
</tr>
<tr>
<td>Information on managing major operational aspects of the SAP LT Replication Server</td>
<td><a href="http://help.sap.com/hana">http://help.sap.com/hana</a>&lt;br&gt;SAP HANA&lt;br&gt;SAP HANA Options&lt;br&gt;SAP HANA Real-Time Replication&lt;br&gt;SAP HANA Trigger-Based Data Replication Using SAP LT Replication Server&lt;br&gt;System Administration and Maintenance Information</td>
<td>Application Operations Guide - Trigger-Based Data Replication Using SAP LT Replication Server for SAP HANA</td>
</tr>
<tr>
<td>Information on using SAP HANA</td>
<td><a href="http://help.sap.com/hana_platform">http://help.sap.com/hana_platform</a>&lt;br&gt;&lt;your support package stack&gt;&lt;br&gt;System Administration &gt; SAP HANA Administration Guide</td>
<td>SAP HANA Administration Guide</td>
</tr>
<tr>
<td>Information for developers on how to use the SAP HANA development tools to create comprehensive analytical models and to build applications with SAP HANA’s interfaces and integrated development</td>
<td><a href="http://help.sap.com/hana_platform">http://help.sap.com/hana_platform</a>&lt;br&gt;&lt;your support package stack&gt;&lt;br&gt;Development and Modeling &gt; SAP HANA Developer Guide (For SAP HANA Studio)</td>
<td>SAP HANA Developer Guide</td>
</tr>
<tr>
<td>Information for modelers (or business analysts) on how to define data models that will be used in SAP HANA</td>
<td><a href="http://help.sap.com/hana_platform">http://help.sap.com/hana_platform</a>&lt;br&gt;&lt;your support package stack&gt;&lt;br&gt;Development and Modeling &gt; SAP HANA Modeling Guide (For SAP HANA Studio)</td>
<td>SAP HANA Modeling Guide</td>
</tr>
<tr>
<td>Description</td>
<td>Path</td>
<td>Title</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
</tbody>
</table>

Table 11: General Quick Links

<table>
<thead>
<tr>
<th>Description</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Notes</td>
<td><a href="http://support.sap.com/notes">http://support.sap.com/notes</a></td>
</tr>
<tr>
<td>SAP Software Download Center</td>
<td><a href="http://support.sap.com/swdc">http://support.sap.com/swdc</a></td>
</tr>
<tr>
<td>Product Availability Matrix</td>
<td><a href="http://support.sap.com/pam">http://support.sap.com/pam</a></td>
</tr>
<tr>
<td>Released platforms and operating systems</td>
<td><a href="http://service.sap.com/platforms">http://service.sap.com/platforms</a></td>
</tr>
<tr>
<td>SAP Solution Manager</td>
<td><a href="http://support.sap.com/solutionmanager">http://support.sap.com/solutionmanager</a></td>
</tr>
</tbody>
</table>
### 1.4 Naming Conventions

Throughout this document the following naming conventions apply.

#### Definitions

The following terms are used consistently in the processes and procedures described in this guide:

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>consuming application</td>
<td>An SAP product designed to consume and utilize data obtained from SAP Customer Activity Repository.</td>
</tr>
</tbody>
</table>

**Example**

- SAP Allocation Management for Retail
- SAP Assortment Planning for Retail
- SAP Merchandise Planning for Retail
- SAP Promotion Management for Retail
**Term**

**Definition**

**back-end system**
The SAP NetWeaver-based back-end server on which SAP Customer Activity Repository and its consuming applications are installed.  
For a visual representation of the back-end system, see Figure 1 in the Overall System Planning section.

**front-end server**
The SAP NetWeaver-based front-end server on which the SAP Gateway, SAP Fiori launchpad, central SAP Fiori UI component, and the product-specific SAP Fiori component are installed.  
For a visual representation of the front-end system, see Figure 1 in the Overall System Planning section.

**source master data system**
SAP Customer Activity Repository retail applications bundle must be installed alongside an SAP Retail (SAP ERP) or SAP S/4HANA central component as a single source of truth for all master data. With this release, there are two possible source master data system options:  
- SAP ERP 6.0 (including the SAP Retail add-on, with or without SAP Fashion Management)  
- SAP S/4HANA, on-premise edition 1610  
Whenever this guide refers to a “source master data system”, it refers to the SAP Retail or SAP S/4HANA central component you choose for your implementation.

---

**Naming Differences**

Due to naming differences between the underlying technical objects of the components, the names of the following business objects are used interchangeably in this document:

<table>
<thead>
<tr>
<th>SAP Customer Activity Repository (all modules except for UDF and DDF)</th>
<th>Unified Demand Forecast (UDF) and Demand Data Foundation (DDF)</th>
<th>SAP Assortment Planning for Retail / SAP Merchandise Planning for Retail</th>
<th>SAP Promotion Management for Retail</th>
<th>SAP Allocation Management for Retail</th>
<th>SAP Retail or SAP S/4HANA</th>
</tr>
</thead>
<tbody>
<tr>
<td>article</td>
<td>product</td>
<td>product</td>
<td>product</td>
<td>product</td>
<td>article</td>
</tr>
<tr>
<td>article variant</td>
<td>product variant</td>
<td>product variant</td>
<td>product variant</td>
<td>product variant or product/color/size</td>
<td>article variant</td>
</tr>
<tr>
<td>store</td>
<td>location</td>
<td>location</td>
<td>location</td>
<td>store</td>
<td>store site</td>
</tr>
</tbody>
</table>
### Variables

Table 14:

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;SAPSID&gt;</td>
<td>SAP system ID in uppercase letters</td>
</tr>
<tr>
<td>&lt;sapsid&gt;</td>
<td>SAP system ID in lowercase letters</td>
</tr>
<tr>
<td>&lt;DBSID&gt;</td>
<td>Database ID in uppercase letters</td>
</tr>
<tr>
<td>&lt;dbsid&gt;</td>
<td>Database ID in lowercase letters</td>
</tr>
<tr>
<td>&lt;INSTDIR&gt;</td>
<td>Installation directory for the SAP system</td>
</tr>
<tr>
<td>&lt;DVD_DIR&gt;</td>
<td>Directory on which a DVD is mounted</td>
</tr>
<tr>
<td>&lt;OS&gt;</td>
<td>Operating system name within a path</td>
</tr>
</tbody>
</table>
2 Planning

2.1 Overall System Planning

The retail applications described in this guide require a layered system landscape, as illustrated in the example below. For more information about the prerequisites for this release, see the following:

- Release information notes (RINs):
  - SAP Note 2377015 for the back-end product version
  - SAP Note 2377081 for the front-end product version
- For initial installations: Prerequisites [page 32]
- For upgrade scenarios: Prerequisites
Figure 1: System Landscape
Product Versions

The installation of SAP Customer Activity Repository and its consuming applications is comprised of the installation of two distinct product versions:

- **SAP Customer Activity Repository retail applications bundle 2.0** (back-end product version CAR RETAIL APPL BUNDLE 2.0)
  
  The back-end product version contains several software components that provide the ABAP back-end functionality and the business content (such as SAP HANA views and SQLScript procedures, local BI Content, application function libraries, and workbooks, where applicable).

- **SAP Fiori 3.0 for SAP Customer Activity Repository retail applications bundle 2.0** (front-end product version SAP FIORI FOR SAP CARAB 3.0)
  
  The front-end product version contains the product-specific SAP Fiori UI component, which includes all the SAP Fiori user interfaces for the applications provided for SAP Customer Activity Repository retail applications bundle.

For more information about the system landscape for SAP Fiori apps, see [http://help.sap.com/fiori_implementation](http://help.sap.com/fiori_implementation).

Central Hub Deployment

For SAP Customer Activity Repository, SAP Assortment Planning for Retail, and SAP Allocation Management for Retail, we recommend that you use central hub deployment, the deployment option recommended by SAP Fiori for SAP Business Suite.

With central hub deployment, the CAR RETAIL APPL BUNDLE product version is installed on a back-end server, and the SAP FIORI FOR SAP CARAB product version is installed on a separate front-end server.

The central hub deployment option decouples the lifecycle of the UI SAP Fiori apps from the back-end components, and offers the following advantages:

- Faster iterations for the UI apps
- Changes to the user interface are possible without having development authorizations in the back-end
- Single point of maintenance for user interface issues, such as browser support and updated versions of SAPUI5 libraries
- Central place for theming and branding SAP Fiori apps

In general, when an SAP solution includes an SAP Fiori user interface, you could potentially use the embedded deployment option, which allows you to use the same SAP NetWeaver server for back-end and front-end components. Although the advantage of this deployment is that you do not require a separate SAP NetWeaver front-end server, this deployment option is not recommended for the retail applications described in this guide.

As we do not recommend the embedded deployment option, the remainder of this document is entirely based on the central hub deployment option.

For more information on deployment options, see:


Common Installation Guide CARAB 2.0 Planning
2.2 System Landscape Variants

2.2.1 SAP Allocation Management for Retail

2.2.1.1 Common Characteristics of Landscape Variants

All SAP Allocation Management for Retail landscape variants share the following common characteristics:

- SAP Allocation Management for Retail is installed as part of SAP Customer Activity Repository retail applications bundle (CAR RETAIL APPL BUNDLE), however, the application is licensed separately.
  
  SAP Customer Activity Repository retail applications bundle is installed as an add-on to SAP NetWeaver Application Server for ABAP, on an underlying SAP HANA Platform.
- SAP Allocation Management for Retail is a consuming application of SAP Customer Activity Repository.
- SAP Allocation Management for Retail uses SAP HANA content that is automatically installed when installing SAP Customer Activity Repository retail applications bundle (CAR RETAIL APPL BUNDLE), including:
  - Demand Data Foundation (DFD) module in SAP Customer Activity Repository (RTLDDF software component)
  - SAP Customer Activity Repository platform layer (RTLCAR software component)
  - SAP Allocation Management for Retail (RTLAPPS consuming applications software component)
- SAP Allocation Management for Retail is embedded into the SAP Assortment Planning for Retail database schema on the SAP HANA Platform (SAP_RAP DB Schema) in addition to the schemas of SAP Customer Activity Repository software components (SAP_DDF DB Schema, SAP_CAR DB Schema).
- SAP Allocation Management for Retail uses master data, sales data, and inventory data originating from connected source system, such as SAP Retail.

2.2.1.2 SAP Allocation Management for Retail Standalone

This deployment option has the following key characteristics:

SAP Allocation Management for Retail is deployed alongside an existing installation of SAP ERP for Retail 6.0:

- Data is imported from SAP ERP into Demand Data Foundation, using the DRFOUT data replication framework, and is persisted in SAP_DDF Schema (subset of data)
- Data is replicated using SAP LT Replication Server (SLT), and is persisted in SAP_ECC Schema.

2.2.1.3 SAP Allocation Management for Retail Co-Deployed with SAP ERP

This deployment option has the following key characteristics:
SAP Allocation Management for Retail is co-deployed with SAP ERP for Retail 6.0 see (Prerequisites [page 32] section for information on supported enhancement packages) on the same SAP HANA Platform but on a different SAP NW stack.

Since SAP Allocation Management for Retail and SAP ERP share the same SAP HANA Platform, SLT replication of data from SAP ERP is not required. SAP Allocation Management accesses SAP ERP data directly from the SAP ERP database schema (SAP_ECC DB Schema).

Data is imported from SAP ERP into DDF using the DRFOUT data replication framework and is persisted in SAP_DDF Schema.

2.2.2 SAP Assortment Planning for Retail

2.2.2.1 Common Characteristics of Landscape Variants

All SAP Assortment Planning for Retail landscape variants share the following common characteristics:

- SAP Assortment Planning for Retail is installed as part of SAP Customer Activity Repository retail applications bundle (CAR RETAIL APPL BUNDLE), however, the application is licensed separately. The SAP Customer Activity Repository retail applications bundle is installed as an add-on to SAP NetWeaver Application Server for ABAP, on an underlying SAP HANA Platform.
- SAP Assortment Planning for Retail is a consuming application of SAP Customer Activity Repository.
- SAP Assortment Planning for Retail uses master data, sales history data, and inventory data originating from connected systems, such as SAP S/4HANA, SAP Retail (SAP ERP) or SAP BW. For more information, see Configure Data Replication [page 103]. SAP Assortment Planning for Retail supports a single or multiple SAP Retail and/or SAP S/4HANA source system(s). These systems do not need to have the same versions installed (for example, one source system can be SAP Retail EPH7, while another system can be SAP S/4HANA). Data from connected SAP Retail and SAP S/4HANA systems is stored in different database schemas, accessed by SAP Assortment Planning for Retail.

You define the source systems in Customizing under Cross-Application Components > Demand Data Foundation > Basic Settings > Define Logical Systems.

- SAP Assortment Planning for Retail uses SAP HANA content that is automatically installed when installing the SAP Customer Activity Repository retail applications bundle (CAR RETAIL APPL BUNDLE), including:
  - Demand Data Foundation (DDF) module in SAP Customer Activity Repository (RTLDDF software component)
  - SAP Customer Activity Repository (RTL CAR software component)
  - SAP Assortment Planning for Retail (included in the RTLAPPS software component)

- SAP Assortment Planning for Retail has its own database schema on the SAP HANA Platform (SAP_RAP DB Schema) in addition to the schemas of SAP Customer Activity Repository software components (SAP_DDF DB Schema, SAP_CAR DB Schema).
2.2.2.2 SAP Assortment Planning for Retail Standalone

This deployment option has the following key characteristics:

- SAP Assortment Planning for Retail is deployed alongside an existing installation of the following:
  - SAP Retail or SAP S/4HANA (see the Prerequisites [page 32] section for information on supported enhancement packages).
  - SAP Assortment Planning for Retail supports a single or multiple SAP Retail (SAP ERP) and/or SAP S/4HANA source system(s). These systems do not need to have the same versions installed (for example, one source system can be SAP ERP EPH7, while another system can be S/4HANA). Data from connected SAP Retail and SAP S/4HANA systems is stored in different database schemas, accessed by SAP Assortment Planning for Retail.
  - You define the source systems in Customizing under Cross-Application Components Demand Data Foundation Basic Settings Define Logical Systems.
  - (Optional) An SAP Business Warehouse system that contains data generated using SAP Planning for Retail, rapid deployment solution. We recommend that you use the SAP Merchandise Planning for Retail application, included in SAP Customer Activity Repository retail applications bundle.

- Data is imported from SAP Retail or SAP S/4HANA into:
  - SAP_ECC and SAP_SH4 schemas using SAP LT Replication Server (SLT), and
  - DDF, using the DRFOUT data replication framework, and is persisted in SAP_DDF Schema (subset of data)
2.2.2.3 SAP Assortment Planning for Retail Co-Deployed with SAP Retail or SAP S/4HANA

This deployment option has the following key characteristics:

- SAP Assortment Planning for Retail is co-deployed with SAP Retail and/or SAP S/4HANA (see the Prerequisites [page 32] section for information on supported enhancement packages) on the same SAP HANA Platform but on a different SAP NetWeaver stack. SAP Assortment Planning for Retail supports a single or multiple SAP Retail (SAP ERP) and/or SAP S/4HANA source system(s). These systems do not need to have the same versions installed (for example, one source system can be SAP ERP EPH7, while another system can be S/4HANA). Data from connected SAP Retail and SAP S/4HANA systems is stored in different database schemas, accessed by SAP Assortment Planning for Retail.

You define the source systems in Customizing under Cross-Application Components > Demand Data Foundation > Basic Settings > Define Logical Systems.

- Since SAP Assortment Planning for Retail and SAP Retail and/or SAP S/4HANA share the same SAP HANA Platform, SLT replication of data from SAP Retail and/or SAP S/4HANA is not required. SAP Assortment Planning accesses SAP Retail and/or SAP S/4HANA data directly from the SAP_ECC and/or SAP_S4H database schemas.
Data is imported from SAP Retail and/or SAP S/4HANA into DDF using the DRFOUT data replication framework and is persisted in SAP_DDF Schema.

2.2.2.4 SAP Assortment Planning for Retail Co-Deployed with SAP BW

This deployment option has the following key characteristics:

- SAP Assortment Planning for Retail is co-deployed with SAP Business Warehouse on the same SAP HANA Platform but on a different SAP NetWeaver stack. Furthermore, SAP Assortment Planning for Retail supports a single or multiple SAP Retail (SAP ERP) and/or SAP S/4HANA source system(s). These systems do not need to have the same versions installed (for example, one source system can be SAP ERP EPH7, while another system can be S/4HANA). Data from connected SAP Retail and SAP S/4HANA systems is stored in different database schemas, accessed by SAP Assortment Planning for Retail.

You define the source systems in Customizing under Cross-Application Components > Demand Data Foundation > Basic Settings > Define Logical Systems.

- Data is imported from SAP Retail or SAP S/4HANA into:
  - SAP ECC and SAP_SH4 schemas using SAP LT Replication Server (SLT), and
  - DDF, using the DRFOUT data replication framework, and is persisted in SAP_DDF Schema (subset of data)

- If you would like to integrate released merchandise planning data, this data needs to be imported into the SAP_DDF Schema. You can import merchandise planning data from the SAP Planning for Retail, rapid
deployment solution or the SAP Merchandise Planning for Retail application, included in SAP Customer Activity Repository retail applications bundle (recommended). For more information, see Configure Data Replication [page 103].

**Note**

InfoProviders and InfoObjects in SAP BW are accessed by SAP Assortment Planning for Retail using SAP HANA views so that data stored in SAP BW can be used in SAP HANA procedures/views.

---

**2.2.3 SAP Customer Activity Repository**

**2.2.3.1 Common Characteristics of Landscape Variants**

All SAP Customer Activity Repository landscape variants share the following common characteristics:

- SAP Customer Activity Repository is installed as part of SAP Customer Activity Repository retail applications bundle (CAR RETAIL APPL BUNDLE), however, the application is licensed separately. The SAP Customer Activity Repository retail applications bundle is installed as an add-on to SAP NetWeaver Application Server for ABAP, on an underlying SAP HANA Platform.
- SAP Customer Activity Repository uses master data from a source master data system, such as SAP S/4HANA or SAP ERP.
- SAP Customer Activity Repository uses SAP HANA content that is automatically installed when installing the SAP Customer Activity Repository retail applications bundle (CAR RETAIL APPL BUNDLE).
- SAP Customer Activity Repository has its own database schemas on the SAP HANA Platform (SAP_CAR DB Schema and SAP_DDF DB Schema).
- POS transactions processed by the repository are persisted in the SAP_CAR schema in the form of transaction logs (TLOG).

### 2.2.3.2 SAP Customer Activity Repository Standalone

This deployment option has the following key characteristics:

- SAP Customer Activity Repository is deployed alongside an existing installation of one of the following:
  - SAP ERP 6.0
  - SAP S/4 HANA, on-premise edition 1610
- The repository has its own database schema on the SAP HANA Platform (SAP_CAR DB Schema).
- SAP ERP data, replicated from a source SAP ERP system into the repository using trigger-based (SLT) replication, is persisted in a separate schema (SAP_ECC DB Schema) on the same SAP HANA Platform.
- SAP ERP data required by the Demand Data Foundation (DDF) and Unified Demand Forecast (UDF) modules in SAP Customer Activity Repository is imported from SAP ERP using the data replication framework (DRF, transaction DRFOUT). For more information, see [http://help.sap.com/car <your release> Application Help Demand Data Foundation Integration Information Master Data Replication from SAP ERP to Demand Data Foundation](http://help.sap.com/car <your release> Application Help Demand Data Foundation Integration Information Master Data Replication from SAP ERP to Demand Data Foundation)
2.2.3.3 SAP Customer Activity Repository Co-Deployed with a Source Master Data System

This deployment option has the following key characteristics:

- SAP Customer Activity Repository is co-deployed with a source master data system on the same SAP HANA Platform, but on a different SAP NetWeaver stack. See the Prerequisites [page 32] section for information on supported releases.
- SLT replication of data from a source master data system is not required. SAP Customer Activity Repository accesses data directly from the SAP_ECC or SAP_S4H database schemas.
This deployment option provides the following advantages:

- No SLT replication is required from SAP ERP to SAP Customer Activity Repository. The repository uses virtual data models to consume data directly (without SLT replication) from SAP ERP tables stored on the shared SAP HANA Platform.
- There are no technical dependencies or limitations between the individual SAP NetWeaver stacks used by SAP Customer Activity Repository and SAP ERP.
- Only one single SAP HANA Platform is required.

However, this deployment option has the following disadvantages:

- Because the SAP HANA Platform is shared by two large applications (SAP Customer Activity Repository and SAP ERP), the size of the required SAP HANA Platform increases substantially.
- Because data is not replicated from SAP ERP to the repository, there is no opportunity to apply transformation rules to correct any potential differences in SAP client numbers. As a result, the SAP client numbers of the source SAP ERP system and of the SAP Customer Activity Repository system must match. For more information, see Set Up SAP Client [page 47].
2.2.3.4 SAP Customer Activity Repository Co-Deployed with SAP BW

This deployment option has the following key characteristics:

- SAP Customer Activity Repository is co-deployed with SAP Business Warehouse on the same SAP HANA Platform, but on a different SAP NetWeaver stack. See the Prerequisites [page 32] section for information on supported releases.
- SLT replication of data from a source master data system is not required. SAP Customer Activity Repository accesses data directly from the SAP_ECC or SAP_S4H database schemas.

![Diagram of SAP Customer Activity Repository Co-Deployed with SAP BW](image)

2.2.4 SAP Merchandise Planning for Retail

2.2.4.1 Common Characteristics of Landscape Variants

All SAP Merchandise Planning for Retail landscape variants share the following common characteristics:

- SAP Merchandise Planning for Retail is a consuming application of SAP Customer Activity Repository. In turn, SAP Customer Activity Repository is installed as an add-on to SAP NetWeaver Application Server for ABAP, on an underlying SAP HANA Platform.
SAP Merchandise Planning is installed as part of SAP Customer Activity Repository retail applications bundle (product version CAR RETAIL APPL BUNDLE 2.0). However, the application is licensed separately.

SAP Merchandise Planning for Retail uses SAP HANA content that is automatically installed when installing:

- Demand Data Foundation module in SAP Customer Activity Repository (RTLDDF software component)
- SAP Customer Activity Repository (RTLPOSDM and RTLCAR software components)
- Syndication Layer (RTLCONS software component)
- SAP Merchandise Planning for Retail (RTLAPPS software component)

SAP Merchandise Planning for Retail has its own database schema on the SAP HANA Platform (SAP_RAP DB Schema) in addition to the schemas of SAP Customer Activity Repository software components (SAP_DDF DB Schema, SAP_CAR DB Schema).

SAP Merchandise Planning for Retail accesses master data from Demand Data Foundation: Data is imported to the DDF module in SAP Customer Activity Repository from an SAP ERP system using the DRFOUT data replication framework.

### 2.2.4.2 SAP Merchandise Planning for Retail Standalone

This deployment option has the following key characteristics:

- SAP Merchandise Planning for Retail is deployed alongside an existing installation of the following:
  - SAP ERP
- Data is imported from SAP ERP into the following:
  - SAP HANA Live for SAP ERP, using SAP LT Replication Server (SLT), and is persisted in SAP_ECC Schema, and
  - DDF, using the DRFOUT data replication framework, and is persisted in SAP_DDF Schema (subset of data)

### 2.2.4.3 SAP Merchandise Planning for Retail Co-Deployed with SAP ERP

This deployment option has the following key characteristics:

- SAP Merchandise Planning for Retail is co-deployed with SAP ERP on the same SAP HANA Platform but on a different SAP NetWeaver stack.
- Since SAP Merchandise Planning for Retail and SAP ERP share the same SAP HANA Platform, SLT replication of data from SAP ERP is not required. SAP Merchandise Planning accesses SAP ERP data directly from the SAP ERP database schema (SAP_ECC_DB Schema).
- Data is imported from SAP ERP into DDF, using the DRFOUT data replication framework and is persisted in SAP_DDF Schema.
2.2.4.4 SAP Merchandise Planning for Retail Co-Deployed with SAP BW

This deployment option has the following key characteristics:

- SAP Merchandise Planning for Retail is co-deployed with SAP Business Warehouse on the same SAP HANA Platform but on a different SAP NetWeaver stack.
- Data is imported from SAP ERP into:
  - SAP HANA Live for SAP ERP, using SAP LT Replication Server (SLT), and is persisted in `SAP_ECC` Schema, and
  - Demand Data Foundation, using the `DRFOUT` data replication framework, and is persisted in `SAP_DDF` Schema (subset of data)
3 Prerequisites

This section lists all the prerequisite platforms, applications, and components that must be installed and configured during an initial installation of this release.

Note

If you are upgrading from a previous release, you must not follow this Common Installation Guide and rather proceed with the Common Upgrade Guide.

For your convenience, the prerequisites are presented to you in two categories:

- common prerequisites, which must be installed regardless of the business scenario you are planning to implement
- application-specific prerequisites, which are only relevant for specific retail applications under specific conditions

Note

The prerequisites should be installed and configured by an experienced SAP Basis administrator. Documentation and support for each prerequisite is available on the SAP Help Portal and the SAP Service Marketplace.

Common Prerequisites

1. SAP HANA Platform
   - SAP HANA database component: The minimum requirement for this release is the last available SAP HANA Maintenance Revision for SAP HANA database SPS 12, regardless of the business scenario you are planning to implement. For more information, see SAP Note 2021789 and consult the information under Last Available Maintenance Revision in SPS. SAP strongly recommends always using the latest SAP HANA Maintenance Revision of the same Support Package Stack.
   - SAP HANA AFL component: The minimum requirement for this release is the SAP HANA AFL revision that is compatible with the selected SAP HANA database revision, regardless of the business scenario you are planning to implement. For each AFL revision that is available for download, the compatible SAP HANA database revision is indicated directly on the SAP Support Portal.
     For guidance on selecting a revision for this release, see the Download and Install the Application Function Library (AFL) section in Install SAP Customer Activity Repository Retail Applications Bundle [page 44]. For installation information, see SAP Notes 2354063 and 2339267, as well as http://help.sap.com/hana_platform.  
2. SAP NetWeaver
   - The minimum requirement for this release is SAP NetWeaver 7.50 SPS 04, regardless of the business scenario you are planning to implement.
   - You must install SAP NetWeaver prior to installing other back-end components.
For installation information, see http://help.sap.com/nw75\Installation and Upgrade Information\Installation Guide\Installation and Upgrade Information\Installation Guide

3. SAP Landscape Transformation Replication Server
The minimum requirement for this release is SAP Landscape Transformation Replication Server for SAP HANA 2.0, regardless of the business scenario you are planning to implement. For installation information, see http://help.sap.com/hana\SAP HANA Options\SAP HANA Real-Time Replication\SAP HANA Trigger-Based Data Replication Using SAP LT Replication Server\Installation and Upgrade Information\Installation Guide

4. SAP Fiori
The minimum requirement for this release is SAP FIORI FRONT-END SERVER 2.0 SPS4, regardless of the business scenario you are planning to implement. For installation information, see SAP Notes 2219596, 2327935, and 2169917, as well as http://help.sap.com/fiori_implementation\App Implementation Information\Installation Guide

5. SAP RTL AFL FOR SAP HANA 200
The minimum requirement for this release is the SAP RTL AFL FOR SAP HANA 200 revision that is compatible with the selected SAP HANA database revision, regardless of the business scenario you are planning to implement. For each AFL revision that is available for download, the compatible SAP HANA database revision is indicated directly on the SAP Support Portal. For installation information, see Install SAP Customer Activity Repository Retail Applications Bundle [page 44].

i Note
Software component version SAP RTL AFL FOR SAP HANA 200 is available as of SAP Customer Activity Repository retail applications bundle 2.0. It contains back-end functionality for two modules in SAP Customer Activity Repository: Unified Demand Forecast and On-Shelf Availability.

The installation of the component is always mandatory, regardless of the business scenario you are planning to implement.

The implementation of Unified Demand Forecast or On-Shelf Availability functionality, however, depends on your business scenario:

- Unified Demand Forecast
  - Mandatory implementation for: SAP Promotion Management for Retail (only for what-if forecasts)
  - Optional implementation for: SAP Allocation Management for Retail, SAP Assortment Planning for Retail, SAP Merchandise Planning for Retail
- On-Shelf Availability
  - Optional implementation for: SAP Allocation Management for Retail, SAP Assortment Planning for Retail, SAP Merchandise Planning for Retail, SAP Promotion Management for Retail
# Application-Specific Prerequisites

## SAP Customer Activity Repository

Table 15: Prerequisites for SAP Customer Activity Repository

<table>
<thead>
<tr>
<th>Product</th>
<th>Prerequisite Version</th>
<th>Mandatory/Optional</th>
<th>Installation Information</th>
</tr>
</thead>
</table>
| SAP ERP                  | The minimum requirement for this release is one of the following:  
  - SAP ERP 6.0 Enhancement Package 4 is mandatory at a bare minimum if installing but not implementing DDF and UDF.  
  - SAP ERP 6.0 Enhancement Package 5 is mandatory when implementing SAP Customer Activity Repository with its DDF and UDF modules.  
  - SAP ERP 6.0 Enhancement Package 7 or higher is mandatory if implementing the SAP Customer Activity Repository Co-Deployed with a Source Master Data System [page 27] system landscape.  
  The following prerequisites apply if you want to implement the Omnichannel Article Availability and Sourcing functionality within SAP Customer Activity Repository:  
  - SAP ERP 6.0 Enhancement Package 7 SPS 13 or SAP ERP 6.0 Enhancement Package 8 SPS 4 | You must install a source master data system; either SAP ERP or SAP S/4HANA must be installed. | http://help.sap.com/erp <your release> Installation and Upgrade Information Installation Guide |
<table>
<thead>
<tr>
<th>Product</th>
<th>Prerequisite Version</th>
<th>Mandatory/Optional</th>
<th>Installation Information</th>
</tr>
</thead>
</table>
| SAP CRM                    | The minimum requirement for this release is one of the following:  
  ● SAP Enhancement Package 2 for SAP CRM 7.0  
  ● SAP Enhancement Package 2 for SAP CRM 7.0, Version for SAP HANA or higher | Optional, depending on whether or not you choose to implement customer determination with SAP CRM. | http://help.sap.com/crm |
<p>| SAP Smart Business         | SAP Smart Business foundation component 1.0 SPS 03 | Optional, depending on whether or not you choose to implement the SAP Smart Business for Multichannel Sales Analytics dashboard within SAP Customer Activity Repository. | SAP Note 2018360 |
| SAP Hybris Marketing       | SAP Hybris Marketing 1.10 or higher | Optional, depending on whether or not you choose to implement customer determination with SAP Hybris Marketing. | <a href="http://help.sap.com/mkt">http://help.sap.com/mkt</a> |
| SAP Hybris Commerce        | SAP Hybris Commerce 6.2 or higher (in particular, the Accelerator, the Data Hub and SAP Asynchronous Order Management) | Optional, depending on whether or not you choose to implement the Omnichannel Article Availability and Sourcing functionality or the Omnichannel Promotion Pricing functionality within SAP Customer Activity Repository. | <a href="http://help.hybris.com">http://help.hybris.com</a> |</p>
<table>
<thead>
<tr>
<th>Product</th>
<th>Prerequisite Version</th>
<th>Mandatory/Optional</th>
<th>Installation Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Hybris Commerce, integration package for SAP for Retail</td>
<td>SAP Hybris Commerce, integration package for SAP for Retail 2.2 or higher</td>
<td>Optional, depending on whether or not you choose to implement the Omnichannel Article Availability and Sourcing functionality or the Omnichannel Promotion Pricing functionality within SAP Customer Activity Repository.</td>
<td>See the Administrator Guide delivered with the software package.</td>
</tr>
<tr>
<td>SAP IQ</td>
<td>SAP IQ 16.0, SP8 or higher</td>
<td>Optional, depending on whether or not you choose to use the Table Content Aging report to move data from SAP Customer Activity Repository to SAP IQ.</td>
<td><a href="http://help.sap.com/iq1608">http://help.sap.com/iq1608</a> Installation and Upgrade Information Installation Guides</td>
</tr>
<tr>
<td>SAP HANA Dynamic Tiering</td>
<td>SAP HANA Dynamic Tiering is delivered with the SAP HANA Platform. See Common Prerequisites.</td>
<td>Optional, depending on whether or not you choose to use the Table Content Aging report to move data from SAP Customer Activity Repository to extended storage using SAP HANA Dynamic Tiering.</td>
<td><a href="http://help.sap.com/hana_options_dt">http://help.sap.com/hana_options_dt</a> Installation and Update</td>
</tr>
<tr>
<td>SAP Jam</td>
<td>SAP Jam, initial release or higher</td>
<td>Optional, depending on whether or not you choose to integrate social media collaboration functionality with SAP Jam.</td>
<td><a href="http://help.sap.com/sapjam">http://help.sap.com/sapjam</a> SAP Jam Collaboration System Administration Information Administrator Guide</td>
</tr>
<tr>
<td>SAP HANA Live for SAP ERP</td>
<td>SAP HANA Live for SAP ERP 1.0 SPS 02 or higher</td>
<td>Optional, depending on whether or not you choose to use the SAP Smart Business Apps for SAP Customer Activity Repository</td>
<td><a href="http://help.sap.com/hba">http://help.sap.com/hba</a> Installation, Security, Configuration, and Operations Information Administrator’s Guide</td>
</tr>
</tbody>
</table>
## SAP Allocation Management for Retail

Table 16: Prerequisites for SAP Allocation Management for Retail

<table>
<thead>
<tr>
<th>Product</th>
<th>Prerequisite Version</th>
<th>Mandatory/Optional</th>
<th>Installation Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP ERP</td>
<td>The minimum requirem</td>
<td>Mandatory</td>
<td><a href="http://help.sap.com/erp">http://help.sap.com/erp</a></td>
</tr>
<tr>
<td></td>
<td>ent for this release</td>
<td></td>
<td>&lt;your release&gt;</td>
</tr>
<tr>
<td></td>
<td>is one of the following:</td>
<td></td>
<td>Installation and Upgrade Information</td>
</tr>
<tr>
<td></td>
<td>● SAP ERP 6.0 Enhance-</td>
<td></td>
<td>Installation Guide</td>
</tr>
<tr>
<td></td>
<td>ment Package 5 is man-</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>datory.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● SAP ERP 6.0 Enhance-</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ment Package 7 or higher</td>
<td>mandatory if imple-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● SAP ERP 6.0 Enhance-</td>
<td>menting the SAP Allocation Management for Retail Co-Deployed with SAP ERP [page 20] system landscape.</td>
<td></td>
</tr>
</tbody>
</table>

## SAP Assortment Planning for Retail

Table 17: Prerequisites for SAP Assortment Planning for Retail

<table>
<thead>
<tr>
<th>Product</th>
<th>Prerequisite Version</th>
<th>Mandatory/Optional</th>
<th>Installation Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP ERP</td>
<td>The minimum requirem</td>
<td>You must install a source master data system; either SAP ERP or SAP S/4HANA must be installed.</td>
<td><a href="http://help.sap.com/erp">http://help.sap.com/erp</a></td>
</tr>
<tr>
<td></td>
<td>ent for this release</td>
<td></td>
<td>&lt;your release&gt;</td>
</tr>
<tr>
<td></td>
<td>is one of the following:</td>
<td></td>
<td>Installation and Upgrade Information</td>
</tr>
<tr>
<td></td>
<td>● SAP ERP 6.0 Enhance-</td>
<td></td>
<td>Installation Guide</td>
</tr>
<tr>
<td></td>
<td>ment Package 5 is man-</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>datory.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● SAP ERP 6.0 Enhance-</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ment Package 7 or higher</td>
<td>mandatory if imple-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● SAP ERP 6.0 Enhance-</td>
<td>menting the SAP Assortment Planning for Retail Co-Deployed with SAP ERP [page 21] system landscape.</td>
<td></td>
</tr>
</tbody>
</table>

|                                  |                                     |                                          | SAP S/4HANA, on-premise edition 1610 Product Documentation Installation Guide |
### SAP Merchandise Planning for Retail

Table 18: Prerequisites for SAP Merchandise Planning for Retail

<table>
<thead>
<tr>
<th>Product</th>
<th>Prerequisite Version</th>
<th>Mandatory/Optional</th>
<th>Installation Information</th>
</tr>
</thead>
</table>
| SAP ERP                              | The minimum requirement for this release is one of the following:  
  - SAP ERP 6.0 Enhancement Package 5 is mandatory.  
  - SAP ERP 6.0 Enhancement Package 7 or higher is mandatory if implementing the SAP Merchandise Planning for Retail Co-Deployed with SAP ERP [page 29] system landscape. | Mandatory | http://help.sap.com/erp <your release> > Installation and Upgrade Information > Installation Guide |
| SAP Jam                              | SAP Jam, initial release or higher            | Optional, depending on whether or not you choose to integrate social media collaboration functionality with SAP Jam. | http://help.sap.com/sapjam SAP Jam Collaboration System Administration Information > Administrator Guide |

**Prerequisites**
### SAP Promotion Management for Retail

Table 19: Prerequisites for SAP Promotion Management for Retail

<table>
<thead>
<tr>
<th>Product</th>
<th>Prerequisite Version</th>
<th>Mandatory/Optional</th>
<th>Installation Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Jam</td>
<td>SAP Jam, initial release or higher</td>
<td>Optional, depending on whether or not you choose to integrate social media collaboration functionality with SAP Jam.</td>
<td><a href="http://help.sap.com/sapjam">http://help.sap.com/sapjam</a> SAP Jam Collaboration System Administration Information Administrator Guide</td>
</tr>
</tbody>
</table>
4 Preparation

4.1 SAP Assortment Planning for Retail

4.1.1 Verify SAP HANA Users and Privileges

Use

The SAP Assortment Planning for Retail application requires a layered system landscape. As an assortment planner or planning administrator, you must assign the necessary users, roles and authorizations in all of the levels of the SAP Assortment Planning for Retail application.

Level 3

SAP NetWeaver Gateway (Front-End Server)

User, roles, groups, and catalogs required to use the collection of SAP Fiori apps that form the SAP Assortment Planning for Retail application user interface.

Level 2

ABAP Back-End Server

Users and roles to access the relevant Customizing activities and use core SAP Assortment Planning for Retail application functionality.

Level 1

SAP HANA Database

Users and privileges allowing the SAP Assortment Planning for Retail application to access SAP HANA views and procedures, which provide access to data and functionality directly on the database level.

Figure 8: Authorization Levels

This procedure lists the required database users and privileges shown as level 1 in the diagram above. These are roles and privileges that you can set up in the database before installing SAP Assortment for Retail on the back-end or front-end systems.
Back-end, level 2 authorizations, are described in the Verify Users, Privileges, and Roles section of the Common Installation Guide. Front-end, level 3 authorizations, are described in the Assign Roles, Catalogs, and Groups in SAP Fiori Launchpad section of the Common Installation Guide.

Procedure

1. Ensure that the SAP HANA database users listed below exist and that they have the required roles/privileges.

<table>
<thead>
<tr>
<th>User</th>
<th>Role/Privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP&lt;SID&gt;</td>
<td>○ System privilege REPO.IMPORT</td>
</tr>
<tr>
<td></td>
<td>○ System privilege ROLE.ADMIN</td>
</tr>
<tr>
<td></td>
<td>○ System privilege STRUCTUREDPRIVILEGE ADMIN</td>
</tr>
<tr>
<td></td>
<td>○ Role CONTENT_ADMIN</td>
</tr>
<tr>
<td></td>
<td>○ Role AFLPM_CREATOR_ERASER_EXECUTE. For more information, see Enable Usage of PAL Functions [page 42] and SAP Note 2046767.</td>
</tr>
<tr>
<td></td>
<td>○ Role AFL__SYS_AFL_OFL_AREA_EXECUTE</td>
</tr>
<tr>
<td>_SYS_REPO</td>
<td>○ Privilege SELECT, with option &quot;Grantable to others&quot;, on the following physical DB schemas:</td>
</tr>
<tr>
<td></td>
<td>○ Physical database schema of your back-end system, typically this is called SAP&lt;SID&gt;</td>
</tr>
<tr>
<td></td>
<td>○ Physical database schema that contains the SAP Retail or SAP S/4HANA tables</td>
</tr>
<tr>
<td></td>
<td>○ Physical database schema that contains the SAP CRM tables</td>
</tr>
<tr>
<td></td>
<td>You can use the following example SQL statement to grant the required privilege:</td>
</tr>
<tr>
<td></td>
<td>GRANT SELECT ON SCHEMA &lt;Your schema name&gt; TO _SYS_REPO WITH GRANT OPTION;</td>
</tr>
<tr>
<td>&lt;Your User Name&gt;*</td>
<td>○ Privilege SELECT on schema _SYS_BI</td>
</tr>
<tr>
<td></td>
<td>○ Privilege SELECT on schema SAP&lt;SID&gt;</td>
</tr>
<tr>
<td></td>
<td>○ Privilege EXECUTE on procedure REPOSITORY_REST</td>
</tr>
</tbody>
</table>

*Your user on SAP HANA database level, back-end system, and on the front-end server (SAP NetWeaver Gateway) must be identical on these three levels.
4.1.2 Configure AFL Usage

4.1.2.1 Activate SAP HANA Script Server

Use

Once all the required AFLs are installed, as listed in the Prerequisites section, ensure that you have activated the script server for the SAP HANA database.

Procedure

Read and implement SAP Note 1650957.

4.1.2.2 Enable Usage of PAL Functions

Use

The installation of SAP HANA Platform includes the installation of the PAL algorithm, a prerequisite for SAP Assortment Planning for Retail.

To enable the usage of the PAL algorithm, as required by SAP Assortment Planning for Retail, perform the following procedure.

Procedure

1. Ensure that the SAP<SID> user has the role AFLPM_CREATOR_ERASER_EXECUTE as described in Verify SAP HANA User and Privileges [page 40] and SAP Note 2046767. This role must be assigned to execute functions of the PAL library. In the case of SAP Assortment Planning for Retail, this role is necessary for the assortment planner to use smart clustering in the Manage Location Clusters SAP Fiori app.
   You do not need to create the AFL_WRAPPER_GENERATOR or AFL_WRAPPER_ERASER procedures, nor do you need to generate any special PAL procedures; this is done automatically.
2. To confirm that the PAL functions were installed successfully, you can run SELECT statements in the three relevant public views as follows:
   - SELECT * FROM SYS.AFL AREAS WHERE AREA NAME = 'AFLPAL'
   - SELECT * FROM SYS.AFL PACKAGES WHERE AREA NAME = 'AFLPAL'
   - SELECT * FROM SYS.AFL_FUNCTIONS WHERE AREA NAME = 'AFLPAL'
More Information

- Prerequisites section

4.1.2.3 Check the OFL Installation

Use

The installation of SAP HANA Platform includes the installation of the OFL algorithm, a prerequisite for SAP Assortment Planning for Retail.

Procedure

1. To confirm that the OFL was installed successfully, you can run SELECT statements in the three relevant public views as follows:
   - SELECT * FROM SYS.AFL AREAS WHERE AREA_NAME = 'OFL AREA'
   - SELECT * FROM SYS.AFL PACKAGES WHERE AREA_NAME = 'OFL AREA'
   - SELECT * FROM SYS.AFL FUNCTIONS WHERE AREA_NAME = 'OFL AREA'

   In the case of a successful installation, each of statements should return 1 row.

More Information

Prerequisites section
5  Installation

5.1  Install Prerequisites and SAP Notes

Before proceeding with the installation, ensure that you have installed and configured all the prerequisites specific to your implementation scenario, as described under Prerequisites [page 32].

Furthermore, you need to verify that all of the SAP Notes required for your scenario have been implemented, as described under SAP Notes for the Installation [page 6].

5.2  Install ABAP Back-End Server

5.2.1  Install SAP Customer Activity Repository Retail Applications Bundle

Use

You use the Maintenance Planner tool to plan your system landscape and generate a stack XML file based on the required product versions. You then install or upgrade components based on this stack XML file using the Software Update Manager (SUM) tool.

⚠️ Caution

Note that it may be possible to install or upgrade components using the SAP Add-On Installation Tool as an alternative, but this alternative procedure is not described in this guide. For more information on whether this is possible for your implementation scenario and on how to proceed, see SAP Note 1803986.

For more information about Maintenance Planner, see SAP Help Portal at http://help.sap.com/maintenanceplanner.

Create the Stack XML Using Maintenance Planner

1. Consult SAP Note 2377015. This is the Release Information Note (RIN) for SAP Customer Activity Repository retail applications bundle 2.0. It provides up-to-date information on the current release, together with a list of important SAP Notes that you must apply to complete the installation process.

3. Choose *Plan a New System*.
4. Choose *Plan*.
5. Choose a system type and enter a three-character system ID.
6. Choose *Install an SAP NetWeaver System*.
7. Select a valid product version (for example, *SAP NETWEAVER 7.5*) and a valid support package stack.
8. Select a valid instance (for example, *Application Server ABAP*).
9. Choose *Confirm Selection*.
10. Choose *Install or Maintain an Add-On*.
11. Select the *CAR RETAIL APPL BUNDLE 2.0* back-end product version and the Initial Shipment Stack instance.
12. Select the *CAR Retail Appl Bundle NW 750 instance*.
13. Choose *Confirm Selection*.
14. Choose *Next*.
15. Select the operating system and database for your implementation scenario.
16. Choose *Confirm Selection*.
17. Review the details of your stack dependent and independent files, then choose *Next*.
18. Choose *Download Stack XML*.

**Download and Install the Stack XML Using Software Update Manager (SUM)**

The Software Update Manager (SUM) tool installs your add-on product using the stack XML file created during the previous procedure.

For detailed instructions on using the SUM tool for your specific operating system/platform and database, see [http://support.sap.com/sltoolset](http://support.sap.com/sltoolset) > *System Maintenance* > *Software Update Manager (SUM) 1.0 <your SP>* > *Guides for SUM 1.0 <your SP>*.

You have now completed the stack XML installation. To finalize the installation of the back-end product version, you must additionally do some manual steps. Continue with the next section.

**Download and Install the Application Function Library (AFL)**

There is one software component that you cannot install with Maintenance Planner and SUM: *SAP RTL AFL FOR SAP HANA 200*. This AFL component is available as of SAP Customer Activity Repository retail applications bundle 2.0. It contains back-end functionality for two modules in SAP Customer Activity Repository:

- Unified Demand Forecast (UDF, provides the demand modeling and forecasting services, the application functions run directly in the SAP HANA database)
- On-Shelf Availability (provides the On-Shelf Availability services, the application functions run directly in the SAP HANA database)

You need to download a revision of *SAP RTL AFL FOR SAP HANA 200* and install it in your SAP HANA database as described in the following.
Dependencies Between AFLs and the SAP HANA Database

For a successful installation, you need to be aware of the following dependencies:

The AFL is released independently of the releases of SAP Customer Activity Repository retail applications bundle. This is because the AFL follows the release cycle of the SAP HANA database. The releases are called “revisions”. Whenever a new revision of the SAP HANA database is released, a new revision of the AFL is released. As a result, multiple revisions of the AFL are available on the SAP Support Portal at any one time.

**Caution**

For each revision of an AFL, there is only one compatible revision of the SAP HANA database. Whenever you upgrade the AFL, you must also upgrade the database and any other AFLs to the compatible revisions. Reversely, whenever you upgrade the database, you must upgrade the AFLs.

This dependency applies not only to SAP RTL AFL FOR SAP HANA but also to the generic SAP HANA AFL. The SAP HANA AFL and the SAP HANA database are components of the SAP HANA Platform (see Prerequisites).

When you download an AFL revision from the SAP Support Portal, the compatible revision of the SAP HANA database is always indicated for your convenience.

You can easily see the dependencies by looking at the release numbers:

<table>
<thead>
<tr>
<th>Release of ...</th>
<th>Released as ...</th>
<th>Example</th>
<th>Guideline</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP HANA Platform</td>
<td>&lt;Support Package Stack&gt;</td>
<td>SAP HANA Platform SPS 12</td>
<td>The number of the support package stack determines the first digits of the revisions.</td>
</tr>
<tr>
<td>SAP HANA Database</td>
<td>&lt;Revision&gt;.&lt;Patch&gt;</td>
<td>SAP HANA Database 122.04</td>
<td>All 12x.xx database revisions belong to SPS 12.</td>
</tr>
<tr>
<td>SAP RTL AFL FOR SAP HANA</td>
<td>&lt;Revision&gt;.&lt;Patch&gt;</td>
<td>SAP RTL AFL FOR SAP HANA 12.4x</td>
<td>The database patch determines the first digit of the AFL patch.</td>
</tr>
<tr>
<td>SAP HANA AFL</td>
<td></td>
<td>SAP HANA AFL 12.4x</td>
<td></td>
</tr>
</tbody>
</table>

**Download and Install** SAP RTL AFL FOR SAP HANA 200

1. Select a revision for the SAP HANA database and the AFL components. 
   Multiple revisions are available on the SAP Support Portal. To select the best revision for your scenario, see the following:
   - SAP Note 2377015: This is the Release Information Note (RIN) for SAP Customer Activity Repository retail applications bundle 2.0. Consult this note for up-to-date information on the current release.
   - Prerequisites: This section indicates the minimum revision of the SAP HANA database and the AFL components. You need at least this revision for the current release.
   - If you want to use a higher revision for your scenario, select one of the “Datacenter Service Point (DSP)” revisions. These are specially verified revisions, which you can find listed in SAP Note 2021789. If you want to know more about DSPs, see the SAP HANA Revision Strategy document linked from the note.
   - SAP Note 1948334: This note lists the supported database update paths for SAP HANA Maintenance Revisions. Consult this note for valid revision combinations for your scenario.
For more information on the release and maintenance strategy of the SAP HANA Platform, see http://support.sap.com/swdc By Alphabetical Index (A-Z) H SAP HANA PLATFORM EDITION SAP HANA PLATFORM EDIT. 1.0 Support Packages and Patches Info.

Once you have selected a revision, this gives you the compatible revisions of the other components.

2. Locate the compatible revisions on the SAP Support Portal:
   - **SAP RTL AFL FOR SAP HANA 200:**
     This component is provided as part of the CAR RETAIL APPL BUNDLE 2.0 back-end product version. You can find it at http://support.sap.com/swdc By Alphabetical Index (A-Z) C CAR RETAIL APPLICATIONS BUNDLE CAR RETAIL APPL BUNDLE 2.0 Support Packages and Patches DOWNLOADS COMPRISED SOFTWARE COMPONENT VERSIONS SAP RTL AFL FOR SAP HANA 200.
   - **SAP HANA AFL and SAP HANA DATABASE:**
     These components are provided as part of the SAP HANA Platform. You can find them at http://support.sap.com/swdc By Alphabetical Index (A-Z) H SAP HANA PLATFORM EDITION SAP HANA PLATFORM EDIT. 1.0 Support Packages and Patches DOWNLOADS HANA AFL.
   - If applicable, other AFLs provided with the SAP HANA Platform that might be relevant for your scenario.

3. Install all AFLs together as described in SAP Note 2377894.

   **Note**
   - If you want to use the UDF functionality in your scenario, you must additionally do some post-installation steps. For more information, see Configure Unified Demand Forecast (Optional) [page 154].
   - If you want to use the On-Shelf Availability functionality in your scenario, you must additionally do some post-installation steps. For more information, see Configure On-Shelf Availability (Optional) [page 140].

**Result**

You have successfully installed the CAR RETAIL APPL BUNDLE 2.0 back-end product version. Continue with the next section.

### 5.2.2 Set Up SAP Client

**Use**

In this procedure, you set up a client on your back-end system.
Procedure for SAP Assortment Planning for Retail or SAP Merchandise Planning for Retail Scenarios

1. Create the necessary client on your back-end system using client maintenance transaction (SCC4).

   **Caution**
   
   If you are performing a client copy, you should only perform the client copy after a successful import of all related software components. Also, you should only import or transfer Customizing tables after this client copy is complete, as described in SAP Note 337623.


   **Note**
   
   This option also defines your multiple ERP clients if required, or if you are using a S4/HANA environment. Review the activity documentation to verify your selection.

Procedure for All Other Scenarios

1. Verify the client numbers in the source SAP Retail or SAP S/4HANA system and in the source systems of optional products you wish to implement with SAP Customer Activity Repository (such as SAP CRM and SAP Hybris Marketing).
   
   This installation includes SAP HANA content that provides views on a combination of client-dependent data authored in these source SAP systems. For instance, sales documents are created in a source SAP Retail system and are replicated to the repository. Likewise, customer information can be optionally replicated from a source SAP CRM or SAP Hybris Marketing system.

2. Create the necessary client on your back-end system using client maintenance transaction (SCC4).

   **Caution**
   
   If you are performing a client copy, you should only perform the client copy after a successful import of all related software components. Also, you should only import or transfer Customizing tables after this client copy is complete, as described in SAP Note 337623.

   If using the same client number is not possible due to the specifics of your implementation and client setup rules, you must use SLT transformation rules before replicating data to transform the source SAP Retail or SAP S/4HANA, and optionally, the source SAP CRM or SAP Hybris Marketing, client(s) to match the client on your back-end system.

   **Example**
   
   If SAP Retail and SAP CRM (or SAP Hybris Marketing) are set up on client 100 in your implementation, you should also set up your installation on client 100. If, for any reason, you are unable to do so, you can transform the source client to 100 using SLT transformation rules.
Cross-system information is client-dependent. As a result, it is required to use the SAP Client (MANDT) attribute as one of the join attributes in the SAP HANA views to combine cross-system sales and master data. All data (whether created or replicated) must be affiliated with the same client number.

More Information

For more information, see http://help.sap.com/nw75 > Application Help > Function-Oriented View > Application Server > Application Server ABAP > Other Services > Services for Administrators > Client Concept.

5.2.3 Create/Replicate Source Master Data System Tables

Create, and optionally replicate, SAP Retail (SAP ERP) and/or SAP S/4HANA tables required for your scenario.

Context

In this procedure, you can decide whether to:

- Simply create the list of tables that is required to activate the SAP HANA Content required by your implementation scenario. This will allow you proceed with the installation without replicating data from source systems.

  Note

  If you are planning to implement SAP Smart Business for Multichannel Sales Analytics, you will also need to create the tables required for SAP HANA Live for SAP ERP. For more information, see the Install SAP HANA Live for SAP ERP section in the Common Installation Guide.

- Replicate the list of tables that is required by your implementation scenario. This will allow you to activate the SAP HANA content and immediately replicate data from the source systems. This is recommended for shortened installation projects.

The tables to create and/or replicate depend on your source master data system:

- **SAP Retail**: SAP Note 2385706, for installations based on the SAP_ECC schema
- **SAP S/4HANA**: SAP Note 2388669, for installations based on the SAP_S4H schema

Procedure

1. Ensure that the SAP Landscape Transformation component (SAP LT Replication Server) is installed.
2. Configure access from the SAP LT Replication Server to the source SAP Retail or SAP S/4HANA system (RFC connection) and from SAP LT Replication Server to the target SAP HANA database.
3. Ensure that your back-end system is connected to SAP HANA studio.

If necessary, set the connection as follows:

1. Log on to SAP HANA studio.
2. Right-click in the Navigator pane and select Add System.
3. Enter the required information in the Specify System dialog:
   - Host Name
   - Instance Number
   - System Description
4. Specify your system User Name and Password in the Connection Properties dialog.

4. Ensure that a database catalog schemas are created on the target SAP HANA database. These are the schemas on your SAP HANA database to which the SAP retail and/or SAP S/4HANA data will be replicated.

For more information, see: http://help.sap.com/hana_platform Development and Modeling SAP HANA Developer Guide Setting up the Persistence Model Creating the Persistence Model with HDBTable Creating a Schema

5. If necessary, map the authoring schema(s) to your particular physical database schema(s).

For more information, see: http://help.sap.com/hana_platform Development and Modeling SAP HANA Modeling Guide Importing Table Definitions and Data Map Authoring Schema to the Physical Schema

6. Create the tables that are required for your scenario. If you want to immediately replicate the tables required by your scenario, proceed to the next step.

1. Log on to the SAP SLT Replication server.
2. Call transaction LTRC.
3. Define and select your replication configuration.
   For more information, see http://help.sap.com/hana_platform Application Help Replicating Data to SAP HANA Replicating Data from ABAP-Based SAP Systems to SAP HANA Creating a Configuration
4. Press “Execute (F8)”. The next screen will show the details of this replication configuration.
5. Select the “table overview” tab. On top the function “data provisioning” will get visible.
6. Execute the function “data provisioning”. On the subsequent pop-up select the function for table creation.
7. Press the multiple selection push button besides the table name field.
8. The following screen allows the entry of multiple table names. It also allows to upload the list of table names from a text file. Make sure, that the text file only contains table names and no other information/data.
9. Upload a text file with the table names and press “Copy (F8)” to return to the previous screen.
10. Press “Execute (F8)” to trigger the table creation.
7. Create the tables that are required for your scenario.
   1. Create and save a CSV file of the required tables.
   2. Make any necessary adjustments to remove or add tables for replication.
3. Open the SAP HANA Studio, select the Modeler perspective. If the Quick Launch panel does not display by default, select Help --> Quick Launch from the main SAP HANA Studio menu.

4. In the Quick Launch page, under Data, select Data Provisioning to open the Data Provisioning Editor.

5. In the Data Provisioning Editor, select the appropriate source system as well as the target schema for replication.

6. Select Replicate to open the Replicate Request screen.

7. Select Load from file and browse to the location where you stored the CSV file.

8. The tables in the file will be added to the Selected column on the right-side. Select Finish to continue. In the Data Provisioning Editor, the action status of the tables can be monitored using Data Load Management.

5.3 Install ABAP Front-End Server

5.3.1 Install ABAP Front-End Server

The ABAP front-end server contains the complete UI layer consisting of the SAP NetWeaver Gateway, the central SAP Fiori UI component, and the product-specific SAP Fiori UI component. To set up the ABAP front-end server, proceed as described in the following sections.

5.3.1.1 Install SAP NetWeaver Gateway on the ABAP Front-End Server

Use

The complete UI layer consisting of the central SAP Fiori UI component, the product-specific SAP Fiori UI components and the SAP NetWeaver Gateway is contained in the ABAP front-end server. SAP NetWeaver Gateway handles the communication between the client and the ABAP back-end server. For a visualization of how these components interact, see the Overall System Planning section in the Common Installation Guide.

When you are implementing the central hub deployment option, you use separate servers for the back-end and front-end components in your landscape.

Procedure

1. Ensure that the necessary SAP NetWeaver version is installed on your front-end server. For more information, see SAP Library for SAP Fiori on SAP Help Portal at http://help.sap.com/fiori_implementation.
5.3.1.2  Install Central SAP Fiori UI Component

Use

The complete UI layer consisting of the central SAP Fiori UI component, the product-specific SAP Fiori UI component, and the SAP NetWeaver Gateway is contained in the ABAP front-end server. The central SAP Fiori UI component contains the SAPUI5 control library and the SAP Fiori launchpad.

When you are implementing the central hub deployment option, you use separate servers for the back-end and front-end components in your landscape. Your front-end server must have the required central SAP Fiori UI component version.

Procedure

1. Ensure that SAP FIORI FRONT-END SERVER 2.0 SPS4 is installed on your front-end server. For more information, see the Prerequisites section in this guide.

5.3.1.3  Install Product-Specific SAP Fiori UI Component

The ABAP front-end server contains the complete UI layer, which consists of the SAP Gateway, the central SAP Fiori UI component, and the product-specific SAP Fiori UI component.

Use

You use the Maintenance Planner tool to plan your system landscape and generate a stack XML file based on the required product versions. You install or upgrade components based on this stack XML file using the Software Update Manager (SUM) tool.

⚠️ Caution

Note that it may be possible to install or upgrade components using the SAP Add-On Installation Tool as an alternative, but this alternative procedure is not described in this guide. For more information on whether this is possible for your implementation scenario and on how to proceed, see SAP Note 1803986.
Create the Stack XML Using Maintenance Planner

1. Consult SAP Note 2377015. This is the Release Information Note (RIN) for SAP Customer Activity Repository retail applications bundle 2.0. It provides up-to-date information on the current release, together with a list of important SAP Notes that you must apply to complete the installation process.
3. Choose Plan a New System.
5. Choose a system type and enter a three-character system ID.
6. Choose Install a SAP NetWeaver System.
7. Select a valid product version (for example, SAP NETWEAVER 7.5) and a valid support package stack.
8. Select a valid instance (for example, Application Server ABAP).
10. Choose Install or Maintain an Add-On.
11. Select the SAP FIORI FOR SAP CARAB 3.0 front-end product version and the Initial Shipment Stack instance.
12. Select the UI for SAP CARAB 3.0 instance.
13. Select the SAP FIORI FRONT-END SERVER 3.0 product version and the Initial Shipment Stack instance.
15. Choose Next.
16. Select the operating system and database for your implementation scenario.
17. Choose Confirm Selection.
18. Review the details of your stack dependent and independent files, then choose Next.
19. Choose Download Stack XML.

Download and Install the Stack XML Using Software Update Manager (SUM)

The Software Update Manager (SUM) tool installs your add-on product using the stack XML file created during the previous procedure.

For detailed instructions on using the SUM tool for your specific operating system/platform and database, see http://help.sap.com/sltoolset/ System Maintenance Software Update Manager (SUM) 1.0 Guides for SUM 1.0.

You have now completed the stack XML installation. To finalize the installation of the back-end product version, you must additionally do some manual steps. Continue with the next section.

Note

If you are using SAP Assortment Planning for Retail, consult SAP Note 2383938, which lists the SAP Notes relevant for your release.

If you are using SAP Allocation Management for Retail, consult SAP Note 2331499.
5.4 Install Alternate Storage (Optional)

The following section only requires implementation if you plan on using the Table Content Aging report delivered with SAP Customer Activity Repository. This report allows you to copy your transaction log (TLOG) data and its extensions from your SAP HANA database to an alternate storage technology such as SAP IQ or Hadoop, thereby reducing your total cost of hardware ownership.

For more information, see SAP Help Portal at http://help.sap.com/car<your release> Application Help SAP Customer Activity Repository POS Data Transfer and Audit Implementing a POS Transaction Data Storage Strategy Using the Table Content Aging Report.

Note

When modeling and forecasting demand using the Unified Demand Forecast (UDF) module, we recommend retaining the historical sales data in memory.

Process Flow

In order to successfully install alternate storage, you must execute the following procedures:

1. Do one of the following:
   ○ Install and set up integration with SAP IQ, or
   ○ Install and set up integration with Apache Hadoop, or
   ○ Install and set up integration with SAP HANA Dynamic Tiering
2. Create the remote source in SAP HANA studio (not applicable for integration with SAP HANA Dynamic Tiering).
3. Create the virtual table.
4. Set the deploy mode in SAP HANA Transport for ABAP.

5.4.1 Install and Set Up Integration with SAP IQ

You use these procedures to install and set up SAP IQ to support the Table Content Aging report (transaction /CAR/TABLE_AGING) delivered with SAP Customer Activity Repository.

The SAP HANA database points to your SAP IQ database using SAP HANA smart data access (SDA), which exposes data from SAP IQ remote sources as virtual tables.

For more information, see SAP Help Portal at http://help.sap.com/car<your release> Application Help POS Data Transfer and Audit Implementing a POS Transaction Data Storage Strategy Using the Table Content Aging Report.
Install SAP IQ

A detailed procedure is described in the *SAP IQ 16.0 SP08 Installation and Configuration Guide*.

For more information, see SAP Help Portal at http://help.sap.com/iq1608\>
Installation and Upgrade Information \>
Installation and Configuration Guide for <your operating system>.

Configure SAP IQ

1. Allocate sufficient space into which your data will be loaded.

   **Note**

   The default DBSpaces provided during installation are intended to be used for SAP IQ system management. You should create your own DBSpace under the *Main* store with a DB File that is large enough to satisfy your sizing requirements.

   For more information, see SAP Help Portal at http://help.sap.com/iq1608\>
   Reference Administration \>
   Operations Information \>
   Reference:Statements and Options \>
   SQL Statements \>
   CREATE DBSPACE Statement.

2. Create an in-memory row-level versioning (RLV) store.

   For more information, see SAP Help Portal at http://help.sap.com/iq1608\>
   System Administration and Maintenance Information \>
   Application Operations Guides \>
   Administration: In-Memory Row-Level Versioning \>
   About In-Memory Row-Level Versioning.

3. Create a database under the content created at the beginning of this procedure.

   **Note**

   Ensure the following:
   ○ The SAP IQ stores are configured with a large enough cache configuration, main memory, and temporary memory.
   ○ The page size should be set to 128KB.
   ○ The concurrency aligns with the amount of processes that will be triggered during the data copy.

   For more information, see SAP Help Portal at http://help.sap.com/iq1608\>
   Configuration and Deployment Information \>
   Configuration Guide.

4. Create tables */POSDW/TLOGF*, */POSDW/TLOGF_EXT* and */POSDW/TLOGF_X* tables in the DBSpace created at the beginning of the procedure.

   **Note**

   These tables should have the same structure as the tables in your SAP HANA system. One possible way is to export the table structure via Export SQL on the SAP HANA side, and import it on the SAP IQ side using the SQL console.
The SQL statement requires some modifications, such as:

- Converting all the column names in the exported SQL statement to lower case (for example, "RETAILSTOREID becomes "retailstoreid"). You can simply convert the entire SQL statement into lower case and then only convert the table name to upper case to keep the table name unchanged.
- Renaming of NVARCHAR to VARCHAR.
- Removing references to CS_* (for example, CS_FIXED).

5. Enable the RLV for the tables you just created.
6. Set the snapshot versioning property of the transaction to row-level.

**Example**

```sql
set option Snapshot_Versioning = 'Row-level';
```

7. Enable connection blocking and set the blocking timeout threshold.

**Example**

```sql
set option blocking = 'On';
set option blocking_timeout = '0';
```

**Install SAP IQ Drivers**

Install and configure the ODBC database drivers required to connect to the remote source.

**Note**

Each data source driver setup is described in its own section. The prerequisites are given as a simple guide; you will need to consult the original driver documentation provided by the driver manufacturer for more detailed information.

A detailed procedure is described in the **SAP HANA Administration Guide**.

For more information, see SAP Help Portal at [http://help.sap.com/hana_platform](http://help.sap.com/hana_platform) ➔ **System Administration ➔ SAP HANA Administration Guide ➔ SAP HANA Data Provisioning ➔ SAP HANA Smart Data Access ➔ Setting Up Database Drivers ➔ SAP IQ Driver Setup**

### 5.4.2 Install and Set Up Integration with Apache Hadoop

You use these procedures to install and set up Apache Hadoop to support the **Table Content Aging** report (transaction `/CAR/TABLE_AGING`) delivered with SAP Customer Activity Repository.

The SAP HANA database points to your Hadoop cluster using SAP HANA smart data access (SDA), which exposes data from Hadoop remote sources as virtual tables.
For more information, see SAP Help Portal at http://help.sap.com/car<your release> ➤ Application Help ➤ POS Data Transfer and Audit ➤ Implementing a POS Transaction Data Storage Strategy ➤ Using the Table Content Aging Report.

Process Flow

To successfully install and set up integration with Apache Hadoop, you must execute the following procedures:

1. Install Apache Hadoop.
2. Do one of the following:
   - Install and set up the Apache Hive ODBC driver, or
   - Install and set up the SAP HANA Spark controller.
3. Create and partition tables in Apache Hive.
4. Create a NFS mount on SAP NetWeaver.

Install Apache Hadoop

According to the SAP HANA Administration Guide, SAP HANA smart data access is supported by Hortonworks Distribution for Apache Hadoop: version 2.3 (supported on Intel-based hardware platforms only).


For more information on installing Apache Hadoop, see http://docs.hortonworks.com ➤ All ➤ HDP ➤ 2.3 ➤ HDP 2.3.0 (GA).

Install and Set Up Apache Hive ODBC Driver

**Note**

Integration between SAP HANA and Apache Hadoop requires either an Apache Hive ODBC driver or an SAP HANA Spark controller.

Implement this procedure only if you wish to integrate SAP HANA with Apache Hadoop via the Apache Hive ODBC driver.

1. According to the SAP HANA Administration Guide, SAP HANA smart data access is supported by Hortonworks Distribution for Apache Hadoop: version 2.3 (This includes Apache Hadoop version 1.0.3 and Apache Hive 0.9.0; supported on Intel-based hardware platforms only). For more information on integration between SAP HANA and Apache Hadoop, see SAP Help Portal at http://help.sap.com/hana_platform ➤ System Administration ➤ SAP HANA Administration Guide ➤ SAP HANA Data Provisioning ➤ SAP HANA Smart Data Access.
For more information on installing the Apache Hive ODBC driver, see http://docs.hortonworks.com.

2. Set up the driver as described in the SAP HANA Administration Guide at http://help.sap.com/hana_platform
   System Administration > SAP HANA Administration Guide > SAP HANA Data Provisioning > SAP HANA Hadoop Integration > Hive ODBC Driver.

Install and Set Up the SAP HANA Spark Controller

**Note**
Integration between SAP HANA and Apache Hadoop requires either an Apache Hive ODBC driver or a SAP HANA Spark controller.

Implement this procedure only if you wish to integrate SAP HANA with Apache Hadoop via the SAP HANA Spark controller.

1. Read SAP Note 2290350 to confirm the right combination of versions required between SAP HANA, Apache Spark, and the SAP HANA Spark controller.
2. Install and set up the SAP HANA Spark controller as described in SAP Note 2273047.

For more information on installing and setting up the SAP HANA Spark controller, see SAP Help Portal at http://help.sap.com/hana_platform System Administration > SAP HANA Administration Guide > SAP HANA Data Provisioning > SAP HANA Hadoop Integration > SAP HANA Spark Controller.

Create and Partition Tables

Create the SAP schema, tables, and table partitions as described in SAP Note 2317597.

Create a NFS Mount on SAP NetWeaver

The TLOG data and its extensions are copied from your SAP HANA database to Hadoop using the HDFS NFS Gateway on your Hadoop system. To enable this you must create a mount point on your SAP NetWeaver system for the data files to be created directly in the Hadoop File System (HDFS).

**Note**
The following steps are only guidelines which provide an example of how to mount Network File System (NFS) on an SAP NetWeaver Linux-based client.
1. Make sure the NFS client is installed based on the examples provided:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red Hat, CentOS</td>
<td><code>sudo yum install nfs-utils</code></td>
</tr>
<tr>
<td>Ubuntu</td>
<td><code>sudo apt-get install nfs-common</code></td>
</tr>
<tr>
<td>SUSE</td>
<td><code>sudo zypper install nfs-client</code></td>
</tr>
</tbody>
</table>

2. List the NFS shares exported on the server.
   Example
   `showmount -e <host>`

3. Set up a mount point for an NFS share.
   Example
   `sudo mkdir <folder>`

   Note
   You must ensure that the folder paths share the same naming conventions, as follows:

<table>
<thead>
<tr>
<th>Temporary data folder</th>
<th>/tmp/tct_csv_out/temp</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data folder</td>
<td>/tmp/tct_csv_out/data</td>
</tr>
</tbody>
</table>

4. Mount the cluster using NFS.
   Example
   `sudo mount -o hard, nolock <host> <folder>`

On your HDFS, the different tables are stored under a folder using the following convention:

`<data directory>/<schema>/<table>/<businessdaydate=partition_value>{files}`

On the SAP NetWeaver file system, the Hadoop files are stored under a physical path and file name that is derived from a customer-definable logical path or file name. The configuration is provided via the FILE transaction. Inside the FILE transaction, you also need to make use of parameters PARAM_1 and PARAM_2. PARAM_1 will be populated during runtime by the program (generated file name) and PARAM_2 will be populated by the program during runtime `<schema>/<table>/<businessdaydate=partition_value>`.

Example (Data Directory)

If the Hadoop data files are stored in Unix/Linux folder `/tmp/tct_csv_out/data/hdp/apps/hive/warehouse/<schema>/<table>/businessdaydate=partition_value/{files}`, the data directory should point to physical file PARAM_1.CSV and physical directory `/tmp/tct_csv_out/data/hdp/apps/hive/warehouse/<PARAM_2><FILENAME>`.
You create the following logical path in the FILE transaction as follows:

Table 24:

<table>
<thead>
<tr>
<th>Logical path</th>
<th>/CAR/HDFS_DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>HDFS Data</td>
</tr>
<tr>
<td>Syntax group</td>
<td>UNIX</td>
</tr>
<tr>
<td>Physical path</td>
<td>/tmp/tct_csv_out/data/hdp/apps/hive/warehouse/&lt;PARAM_2&gt;&lt;FILENAME&gt;</td>
</tr>
</tbody>
</table>

You create the following logical file in the FILE transaction as follows:

Table 25:

<table>
<thead>
<tr>
<th>Logical file</th>
<th>/CAR/HDFS_DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>HDFS Data</td>
</tr>
<tr>
<td>Physical file</td>
<td>&lt;PARAM_1&gt;.CSV</td>
</tr>
<tr>
<td>Data format</td>
<td>WK1</td>
</tr>
<tr>
<td>Application area</td>
<td>IS</td>
</tr>
<tr>
<td>Logical path</td>
<td>/CAR/HDFS_DATA</td>
</tr>
</tbody>
</table>

Example (Temporary Directory)

On top of the Hadoop data files, you also need to provide a temporary directory in which the program will populate script files and also temporarily store data files to be compressed.

If the temporary files are stored in Unix/Linux folder /tmp/tct_csv_out/temp/{files}, you create the following logical path in the FILE transaction as follows:

Table 26:

<table>
<thead>
<tr>
<th>Logical path</th>
<th>/CAR/HDFS_TEMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>HDFS Temp</td>
</tr>
<tr>
<td>Syntax group</td>
<td>UNIX</td>
</tr>
<tr>
<td>Physical path</td>
<td>/tmp/tct_csv_out/temp/&lt;FILENAME&gt;</td>
</tr>
</tbody>
</table>

You create the following logical file in the FILE transaction as follows:

Table 27:

<table>
<thead>
<tr>
<th>Logical file</th>
<th>/CAR/HDFS_TEMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>HDFS Temp</td>
</tr>
</tbody>
</table>
5.4.3 Install and Set Up Integration with SAP HANA Dynamic Tiering

You use these procedures to install and set up SAP HANA Dynamic Tiering to support the Table Content Aging report (transaction /CAR/TABLE_AGING) delivered with SAP Customer Activity Repository.

SAP HANA Dynamic Tiering adds the SAP HANA dynamic tiering service to your SAP HANA system. You use this service to create the extended store and extended tables. Extended tables behave like all other SAP HANA tables, but their data resides in the disk-based extended store.

For more information, see SAP Help Portal at http://help.sap.com/car <your release> > Application Help > POS Data Transfer and Audit > Implementing a POS Transaction Data Storage Strategy > Using the Table Content Aging Report

Install SAP HANA Dynamic Tiering

A detailed procedure is described in the SAP HANA Dynamic Tiering: Installation and Update Guide.

For more information, see SAP Help Portal at http://help.sap.com/hana_options_dt > Installation and Update > Installation and Update.

Create Extended Storage

A detailed procedure is described in the SAP HANA Dynamic Tiering: Administration Guide.

For more information, see SAP Help Portal at http://help.sap.com/hana_options_dt > System Administration > SAP HANA Dynamic Tiering: Administration Guide and consult the following subsections:

- System Administration > Managing Extended Storage > Create Extended Storage
- System Administration > Managing Tables > Extended Store Tables > Convert HANA Tables to Extended Store Tables Using the SAP HANA Cockpit
5.4.4 Create the Remote Source in SAP HANA Studio

Note
This step is not applicable if you are integrating the alternate storage feature with SAP HANA Dynamic Tiering.

Create a remote source by selecting the appropriate adapter and configuring the connection properties and user credentials.

A detailed procedure is described in the SAP HANA Administration Guide.

For more information, see SAP Help Portal at http://help.sap.com/hana_platform ➔ System Administration ➔ SAP HANA Administration Guide ➔ SAP HANA Data Provisioning ➔ SAP HANA Smart Data Access ➔ Creating and Configuring Remote Data Sources ➔ Create Remote Data Sources.

5.4.5 Create the Virtual Table

Create the following virtual tables to access the data stored in remote tables:

Table 28:

<table>
<thead>
<tr>
<th>Virtual Table</th>
<th>Remote Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>VT_TLOGF_NLS</td>
<td>/POSDW/TLOGF</td>
</tr>
<tr>
<td>VT_TLOGF_X_NLS</td>
<td>/POSDW/TLOGF_X</td>
</tr>
<tr>
<td>VT_TLOGF_EXT_NLS</td>
<td>/POSDW/TLOGF_EXT</td>
</tr>
</tbody>
</table>

A detailed procedure is described in the SAP HANA Administration Guide.


5.4.6 Set the Deploy Mode in SAP HANA Transport for ABAP

1. In your back-end system, start the SAP HANA Transport for ABAP (SCTS_HTA) transaction.
2. Enter sap.is.retail.car.nls in the SAP HANA Repository Package field and choose Execute.
3. Choose F6 to select all synchronizable packages and objects.
4. Choose Utilities ➔ Deploy Mode ➔
5. Choose Mode P.
For more information, see SAP Help Portal at http://help.sap.com/nw74 Application Help Function-Oriented View Solution Lifecycle Management Software Logistics Transport Scenarios for SAP HANA Content SAP HANA Transport for ABAP Deploy Mode in SAP HANA Transport for ABAP.
6 Post-Installation

6.1 SAP Allocation Management for Retail

Post-installation of SAP Allocation Management for Retail.

Note
Some of the activities in this section may have already been performed in the corresponding section under SAP Customer Activity Repository. Such activities do not need to be repeated during the setup and installation of consuming applications.

6.1.1 Configure Backend System

SAP Allocation Management for Retail uses master data and time series data stored in the Demand Data Foundation (DDF). As such, prior to using the SAP Allocation Management for Retail application, you must ensure that DDF is fully configured and operational.

This procedure highlights key configuration steps required to use the SAP Allocation Management for Retail application.

Procedure

1. Follow the steps of procedure Configure Demand Data Foundation (Optional) [page 149] to configure the DDF module in SAP Customer Activity Repository.
2. Ensure that you have activated all the required event type linkages and have enabled the specified event queues in transaction SWETYPV. This ensures that the product hierarchy and location hierarchy flattener structures get created. For more information, see SAP Note 1425876.
3. Make sure to set up the Customizing for Demand Date Foundation in the SAP Customizing Implementation Guide by choosing SAP Customer Activity Repository Demand Data Foundation.
6.1.2 Verify Users, Privileges, and Roles

Prior to proceeding with the post-installation steps for the application, you need to ensure that the required database users and back end application users have all the required privileges, roles, and authorizations.

Procedure

1. Ensure that the SAP HANA database users exist and that they have the required additional roles and privileges.
2. Ensure that your back end application user has the SAP_ISR_DDF_MASTER and your front-end users have the role SAP_AMR_BCR_ALLOCATOR_T.
3. Ensure that the user names of each individual user on the SAP HANA database level, on the back end system level, and on the front-end server (SAP NetWeaver Gateway) are identical on these three levels. Furthermore, verify that the front-end application user has all the necessary roles assigned. Here, refer in particular to the SAP Allocation Management for Retail specific authorization object /AMR/BE.

i Note

For more information, see the Security Information section in the SAP Allocation Management for Retail Administration Guide.

6.1.3 Create SAP ERP Tables

In this step, you must create the new SAP ERP tables that are required for SAP Allocation Management for Retail. Specify which SAP ERP tables to create using information from 2385706 for installations based on the SAP_ECC schema.

i Note

You must create the tables before proceeding. Failure to do so will result in SAP HANA content activation and deployment failures.

6.1.4 Activate SAP HANA Content for SAP Allocation Management for Retail

In this procedure, you perform the initial activation of SAP HANA content (views, stored procedures, and AMDPs) required by the SAP Allocation Management for Retail application.
Prerequisites

- As a mandatory prerequisite you must run the report /CAR/ACTIVATE_HTA and ensure that the following has been activated for all SAP HANA content for SAP CARAB:
  ○ SAP ERP
  ○ SAP Fashion Management
  ○ Customer Activity Repository
  ○ Demand Data Foundation
- Use transaction SAP HANA Transport for ABAP - Deployment (SCTS_HTA_DEPLOY) to deploy repository package SAP.IS.DDF.CROSS including the subpackages. The deployment is a prerequisite for the successful execution of report Activate SAP Allocation Management for Retail HANA Content /AMR/ACTIVATE_HANA_CONTENT.
- Furthermore, apply SAP Note 2298340 (SAP HANA DB: CDS views with external views as base objects cannot be created in the DB).

Procedure

1. Ensure that the _SYS_REPO user has the authorizations required to successfully activate SAP HANA content.
   1. Provide user _SYS_REPO with object privilege SELECT, with option "Grantable to others", on the following physical DB schemas:
      ○ Physical database schema of your back-end system, typically this is called SAP<SID>.
      ○ Physical database schema that contains the SAP ERP tables.
      You can use the following example SQL statement to grant the required privilege:
      ```sql
      GRANT SELECT ON SCHEMA <Your schema name> TO _SYS_REPO WITH GRANT OPTION;
      ```
   2. Run program /AMR/ACTIVATE_HANA_CONTENT in transaction SE38 to activate SAP Allocation Management for Retail HANA content.
   3. Run program RADMASG0 in transaction SE38 for collective CDS and external view activation.

6.1.5 Configure Data Replication

SAP Allocation Management for Retail uses master data, such as product, store, and product hierarchy, and so on, that is replicated from SAP ERP to DDF using DRFOUT.
6.1.5.1 Initial Load of Data to DDF Using DRFOUT

Prerequisites

Prior to replicating data from SAP ERP to DDF using DRFOUT, the following prerequisites must be fulfilled:

- Your SAP ERP installation is SAP Enhancement Package 6 for SAP ERP SP07 or higher or SAP Enhancement Package 5 for SAP ERP SP10 or higher.
- The following business functions are activated in SAP ERP:
  - ISR_APPL_OUTBOUND_DMF
  - ISR_RETAIL_OUTBOUND_DMF

Procedure

1. SAP Allocation Management for Retail specifically requires that the following master data is replicated sequentially from a connected SAP ERP system using DRFOUT:

   Table 29:

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Master Data</th>
<th>Technical Details</th>
<th>For more information, see:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Product Hierarchy</td>
<td>○ SAP ERP Description: Material Group Hierarchy</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a>&lt;your release&gt; Application Help Demand Data Foundation Integration Information Inbound Interfaces For Remote Function Call (RFC) Communication Product Hierarchy Master Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ DRFOUT Outbound Implementation: PMCH</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ DDF Inbound Interface: /DMF/MDIF_PROD_HIER_INBOUND</td>
<td></td>
</tr>
<tr>
<td>Sequence</td>
<td>Master Data</td>
<td>Technical Details</td>
<td>For more information, see:</td>
</tr>
<tr>
<td>----------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2</td>
<td>Product</td>
<td>○ SAP ERP Description: Material &lt;br&gt;○ DRFOUT Outbound Implementation: PMAT &lt;br&gt;○ DDF Inbound Interface: /DMF/MDIF_PROD_INBOUND</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a>&lt;br&gt;→ &lt;your release&gt; → Application Help → Demand Data Foundation → Integration Information → Inbound Interfaces For Remote Function Call (RFC) Communication → Product Master Data</td>
</tr>
<tr>
<td>3</td>
<td>Location</td>
<td>○ SAP ERP Description: Plant &lt;br&gt;○ DRFOUT Outbound Implementation: PPLT &lt;br&gt;○ DDF Inbound Interface: /DMF/MDIF_LOCATION_INBOUND</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a>&lt;br&gt;→ &lt;your release&gt; → Application Help → Demand Data Foundation → Integration Information → Inbound Interfaces For Remote Function Call (RFC) Communication → Product Location Master Data</td>
</tr>
<tr>
<td>4</td>
<td>Product Location</td>
<td>○ SAP ERP Description: Material/Plant &lt;br&gt;○ DRFOUT Outbound Implementation: PMPL &lt;br&gt;○ DDF Inbound Interface: /DMF/MDIF_PROD_LOC_INBOUND</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a>&lt;br&gt;→ &lt;your release&gt; → Application Help → Demand Data Foundation → Integration Information → Inbound Interfaces For Remote Function Call (RFC) Communication → Product Location Master Data</td>
</tr>
<tr>
<td>5</td>
<td>Product Location</td>
<td>○ SAP ERP Description: Sales Price &lt;br&gt;○ DRFOUT Outbound Implementation: PSPR &lt;br&gt;○ DDF Inbound Interface: /DMF/MDIF_PROD_LOC_INBOUND</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a>&lt;br&gt;→ Application Help → Demand Data Foundation → Integration Information → Inbound Interfaces For Remote Function Call (RFC) Communication → Product Location Master Data</td>
</tr>
<tr>
<td>6</td>
<td>Inventory</td>
<td>○ SAP ERP Description: Inventory &lt;br&gt;○ DRFOUT Outbound Implementation: PINV &lt;br&gt;○ DDF Inbound Interface: /DMF/OPIF_INVENTORY_INBOUND</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a>&lt;br&gt;→ &lt;your release&gt; → Application Help → Demand Data Foundation → Integration Information → Inbound Interfaces For Remote Function Call (RFC) Communication → Inventory Master Data</td>
</tr>
<tr>
<td>Sequence</td>
<td>Master Data</td>
<td>Technical Details</td>
<td>For more information, see:</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>7</td>
<td>Transportation Lane</td>
<td>○ SAP ERP Description: Source of Supply</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a>&lt;your release&gt; Application Help Demand Data Foundation Integration Information Inbound Interfaces For Remote Function Call (RFC) Communication Transportation Lane Master Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ DFRF OUT Outbound Implementation: PSOS</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ DDF Inbound Interface: /DMF/MDIF_LANE_INBOUND</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Location</td>
<td>○ SAP ERP Description: Vendor</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a>&lt;your release&gt; Application Help Demand Data Foundation Integration Information Inbound Interfaces For Remote Function Call (RFC) Communication Location Master Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ DFRF OUT Outbound Implementation: PVEN</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ DDF Inbound Interface: /DMF/MDIF_LOCATION_INBOUND</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Product Hierarchy</td>
<td>○ SAP ERP Description: Article Hierarchy</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a> Application Help Demand Data Foundation Integration Information Inbound Interfaces For Remote Function Call (RFC) Communication Product Hierarchy Master Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ DFRF OUT Outbound Implementation: PARY</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ DDF Inbound Interface: /DMF/MDIF_PROD_HIER_INBOUND</td>
<td></td>
</tr>
</tbody>
</table>

You can import the data into staging tables, and then transfer this data to production tables using report /DMF/PROCESS_STAGING_TABLES. Or you can skip the staging tables, and import the data directly into the production tables. For more information, see:

- [http://help.sap.com/car<your release> Application Help Demand Data Foundation Integration Information Inbound Processing](http://help.sap.com/car<your release> Application Help Demand Data Foundation Integration Information Inbound Processing)

### More Information

For more information on monitoring the replication, see:

- Periodic Tasks (5.2.4) section of the Administrator's Guide, SAP Allocation Management for Retail 1.0.
6.1.5.2 Load of Time-Dependent Article

SAP Allocation Management for Retail supports the use of time-dependent article hierarchies.

Procedure

To enable the use of time-dependent article hierarchies in SAP Allocation Management for Retail, do the following:

1. Implement SAP Notes 2196323 and 2196351 in the connected SAP ERP system.
2. If your hierarchy is already a time-dependent hierarchy, you need to re-import the product hierarchies into SAP Allocation Management for Retail using the DRFOUT framework.
   - SAP ERP Description: Article Hierarchy
   - DRFOUT Outbound Implementation: PAHY
   - DDF Inbound Interface: /DMF/MDIF_PROD_HIER_INBOUND

6.1.5.3 Delta Load of Data to DDF Using DRFOUT

When performing a delta load of master data from SAP ERP using the DRFOUT framework, you must ensure that the product location data required to enhance the sales records with historical sales cost is loaded prior to the sales data.

Furthermore, we recommend that you schedule a weekly periodic task to replicate inventory data (outbound implementation PINV) from the SAP ERP system to the system for SAP Allocation Management for Retail. This replication builds up the inventory history data that is needed by SAP Allocation Management for Retail.

6.1.6 Configure SAP Gateway

6.1.6.1 Perform General SAP Gateway

Prior to connecting the SAP Gateway on your front-end server to your back-end system, you need to perform a series of general SAP Gateway configuration steps. These configuration steps include the setting of profile parameters, ICF (Internet Communication Framework) services, language settings, and so on.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation referenced below.
Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
   - SAP Gateway for SAP NetWeaver 7.31
   - SAP Gateway for SAP NetWeaver 7.40
   - SAP Gateway for SAP NetWeaver 7.50

6.1.6.2 Connect SAP Gateway to Your Back-End System

In this procedure, you configure the OData Channel, that is, set up a connection between SAP Gateway on your front-end server and your back-end system.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation referenced below.

Procedure

1. Set up the required roles on the front-end server and assign your user to these roles.
2. Specify the connection settings on the SAP Gateway hub system, which include:
   - Connection from the SAP Gateway to consumer systems
     These settings allow the connection between the SAP Gateway host and the consumer systems (clients from which you access the SAP Fiori user interfaces).
   - Connection from the SAP Gateway to SAP back-end system
     These settings allow the connection between SAP Gateway to your back-end system. These settings include:
       - Creating a type 3 connection from the SAP Gateway host to your back-end system.
       - Defining a trust relationship between your back-end system and the SAP Gateway host.
○ Configuring your back-end system to accept SAP assertion tickets from the SAP Gateway host.
○ Configuring your SAP Gateway host to accept SAP assertion tickets from your back-end system.
○ Configuring the necessary system aliases.

More Information


For SAP NetWeaver 7.4, see SAP Library for SAP NetWeaver on SAP Help Portal at http://help.sap.com/nw74 ➤ Application Help ➤ Function-Oriented View ➤ SAP NetWeaver Gateway Foundation (SAP_GWFND) ➤ SAP NetWeaver Gateway Foundation Configuration Guide ➤ SAP Gateway Configuration ➤ Connection Settings for the SAP Gateway Hub System ➤

For SAP NetWeaver 7.5, see SAP Library for SAP NetWeaver on SAP Help Portal at http://help.sap.com/nw75 ➤ Application Help ➤ Function-Oriented View ➤ SAP NetWeaver Gateway Foundation (SAP_GWFND) ➤ SAP NetWeaver Gateway Foundation Configuration Guide ➤ General Configuration Settings ➤

6.1.6.3 Activate SAP Gateway

Before you can use SAP Gateway functionality, you have to activate it globally on your front-end server.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation referenced below.

Procedure

1. Determine the SAP NetWeaver version of your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
   ○ SAP Gateway for SAP NetWeaver 7.31
   ○ SAP Gateway for SAP NetWeaver 7.4
   ○ SAP Gateway for SAP NetWeaver 7.5
6.1.6.4 Activate Common OData Services

A number of OData services are required to run the SAP Fiori launchpad. These OData services are delivered with the central UI component (SAP_UI 750 SP12 or equivalent).

For security reasons, all OData services are delivered in an inactive state. To use the SAP Fiori launchpad, you must activate the common SAP Fiori OData services.

Procedure

1. Log on to your front-end system (your SAP Gateway system).
2. Go to Customizing (transaction SPRO).
3. Navigate to SAP NetWeaver Gateway OData Channel Administration General Settings Activate and Maintain Services.
   You are presented with the service catalog. This is a list of all the services that are currently active on your SAP Gateway.
4. Get common SAP Fiori OData services:
   1. Choose Add Service.
      The Add Service screen is displayed.
   2. Enter the system alias of your local front-end system.
      This is the alias created in the Connect SAP Gateway to Your Back-End System [page 71] procedure. For example, LOCAL.
   3. Enter /UI2* in the Technical Service Name field.
      The Add Selected Services screen is displayed.
5. Select the common SAP Fiori OData services that you would like to activate, and choose Add Selected Services.

Table 30:

<table>
<thead>
<tr>
<th>Service Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>/UI2/PAGE_BUILDER_CONF</td>
</tr>
<tr>
<td>/UI2/PAGE_BUILDER_CUST</td>
</tr>
<tr>
<td>/UI2/PAGE_BUILDER_PERS</td>
</tr>
<tr>
<td>/UI2/TRANSPORT</td>
</tr>
</tbody>
</table>
The selected OData services are now active in your SAP Gateway.

More Information

  
  Application Help ➤ SAP Fiori Launchpad ➤ Setting Up the Launchpad ➤ Activating SAP Gateway OData Services

- For SAP NetWeaver 7.40, see the documentation on SAP Help Portal at [http://help.sap.com/nw74](http://help.sap.com/nw74)
  
  Application Help ➤ UI Technologies in SAP NetWeaver with SAP_UI 740 ➤ SAP Fiori Launchpad ➤ Setting Up the Launchpad ➤ Activating SAP Gateway OData Services

- For SAP NetWeaver 7.5, see the documentation on SAP Help Portal at [http://help.sap.com/nw75](http://help.sap.com/nw75)

  Application Help ➤ UI Technologies in SAP NetWeaver with SAP_UI 750 ➤ SAP Fiori Launchpad ➤ Setting Up the Launchpad ➤ Activating SAP Gateway OData Services

6.1.7 Configure Index Calculation

The SAPUI5 application index provides an indexing and caching mechanism for information related to SAPUI5 apps, components, and libraries that are contained in SAPUI5 repositories on the SAP NetWeaver Application Server for ABAP. This index, calculated by the Calculation of SAPUI5 Application Index for SAPUI5 Repositories report (/UI5/APP_INDEX_CALCULATE), makes it possible to retrieve and find this information significantly faster than when carrying out the calculations each time it's requested.

We recommend that you schedule the Calculation of SAPUI5 Application Index for SAPUI5 Repositories report as to run as a background job on your front-end server.

Following any changes to the content of the SAPUI5 ABAP repository (for example, installation of a new version of the SAPUI5 distribution layer or implementation of an SAP Note containing changes to a SAPUI5 app), the SAPUI5 application index should be updated using the calculation report. This report has to be executed in every system whenever the content of the SAPUI5 ABAP repository has changed.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
   - SAP Gateway for SAP NetWeaver 7.31
6.1.8 Configure Central UI Component

The central UI component (delivered as part of the SAP Fiori front-end server) contains the SAP UI5 control library and the SAP Fiori launchpad. Prior to being able to use the SAP Fiori apps that constitute the user interface of the retail applications described in this guide, you may need to configure the SAP Fiori launchpad.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation referenced below.

For more information, see the Prerequisites section in this guide.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
   - SAP Gateway for SAP NetWeaver 7.31
     - http://help.sap.com/nw-uiaddon20 Application Help > SAP Fiori Launchpad, and
   - SAP Gateway for SAP NetWeaver 7.40
     - http://help.sap.com/nw74 Application Help > UI Technologies in SAP NetWeaver with SAP_UI 740 > SAP Fiori Launchpad, and
     - http://help.sap.com/nw74 Application Help > UI Technologies in SAP NetWeaver with SAP_UI 740 > SAP NetWeaver User Interface Services > Configuration and Operations > Content Administration > SAP Fiori LaunchePage > Setting Up the SAP Fiori Launch Page
   - SAP Gateway for SAP NetWeaver 7.50
     - http://help.sap.com/nw75 Application Help > UI Technologies in SAP NetWeaver with SAP_UI 750 > SAP Fiori Launchpad, and
6.1.9 Activate SAP Allocation Management for Retail OData Services

A number of OData services are required to run the SAP Allocation Management for Retail application.

For security reasons, all OData services are delivered in an inactive state. You must activate these application-specific OData services to use the SAP Fiori user interface of the SAP Allocation Management for Retail application.

Procedure

1. Log on to your front-end system (your SAP NetWeaver system).
2. Go to Customizing (transaction `SPRO`).
3. Navigate to `SAP NetWeaver > Gateway > OData Channel > Administration > General Settings > Activate and Maintain Services`.
   You are presented with the service catalog. This is a list of all the services that are currently active on your SAP Gateway.
4. Get SAP Allocation Management for Retail OData services:
   1. Choose `Add Service`.
      The `Add Service` screen is displayed.
   2. Enter the system alias of your back-end system.
      This is the alias created for your back-end system in the `Connect SAP Gateway to Your Back-End System` procedure. For example `RTLCLNT100`.
   3. Enter `/DMF*` in the `Technical Service Name` field.
5. Select the SAP Allocation Management for Retail OData services you would like to activate, and choose `Add Selected Services`.

   Table 31:

<table>
<thead>
<tr>
<th>OData Service</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/DMF/DIST_CURVE</td>
<td>OData Service for <code>Configure Distribution Curves</code></td>
</tr>
</tbody>
</table>

   The selected OData services are now active in your SAP Gateway.

6. Enter `/AMR*` in the `Technical Service Name` field.
7. Choose `Get Services`.

Common Installation Guide CARAB 2.0
Post-Installation
The Add Selected Services screen is displayed.

8. Select the SAP Allocation Management for Retail OData services you would like to activate, and choose Add Selected Services.

Table 32:

<table>
<thead>
<tr>
<th>OData Service</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/AMR/OD_ALLOCATIONPLAN_SRV</td>
<td>OData service for My Allocation Plans</td>
</tr>
<tr>
<td>/AMR/OD_COMMON_SRV</td>
<td>Common OData service used by multiple apps</td>
</tr>
<tr>
<td>/AMR/OD_MARKETUNIT_SRV</td>
<td>OData service for Manage Market Units</td>
</tr>
<tr>
<td>/AMR/OD_PARAM_SRV</td>
<td>OData service for Manage Allocation Parameters</td>
</tr>
<tr>
<td>/AMR/OD_WORKLOAD_SRV</td>
<td>OData service for My Allocation Workload</td>
</tr>
</tbody>
</table>

More Information

- For SAP NetWeaver 7.31, see SAP Library for User Interface Add-On 1.0 on SAP Help Portal at http://help.sap.com/nw-uiaddon20
- For SAP NetWeaver 7.4, see the documentation on SAP Help Portal at http://help.sap.com/nw74
- For SAP NetWeaver 7.5, see the documentation on SAP Help Portal at http://help.sap.com/nw75

6.1.10 Activate SAP Allocation Management for Retail ICF Services

For security reasons, all Internet Communication Framework (ICF) services relevant to your SAP Allocation Management for Retail application are made available in an inactive state.

You have activated the central ICF services in the Perform General SAP Gateway [page 70] and Configure Central UI Component [page 75] procedures. This procedure provides the instructions to activate ICF services required for the SAP Allocation Management for Retail SAP Fiori apps.
Procedure

1. Log on to your front-end server.
2. Open service maintenance (transaction SICF).
3. In the Maintain Service screen, select the Location Clustering service by specifying the following:
   - Hierarchy Type: SERVICE
   - Virtual Host: DEFAULT_HOST
   - Service Path: /sap/bc/ui5_ui5/sap/amr_alloplan/
4. Choose Execute.
5. To activate the service, choose Service/host Activate.
6. Repeat steps 3 to 5 to ensure that all of the following services are activated:
   - /sap/bc/ui5_ui5/sap/amr_allo_params
   - /sap/bc/ui5_ui5/sap/amr_dist_config
   - /sap/bc/ui5_ui5/sap/amr_lib_reuse
   - /sap/bc/ui5_ui5/sap/amr_marketunit
   - /sap/bc/ui5_ui5/sap/amr_workload

6.1.11 Assign Roles, Catalogs, and Groups in SAP Fiori Launchpad

To be able to access SAP Fiori apps that constitute the SAP Allocation Management for Retail user interface from the SAP Fiori launchpad, your front-end system user must have the necessary roles assigned. Based on the roles assigned to your user, you can access certain business catalogs and business catalog groups.

Your SAP Allocation Management for Retail application is delivered with a predefined role, catalog, and group. These include technical content as well as business content:

<table>
<thead>
<tr>
<th>Front-End Server Business Content</th>
<th>Front-End Technical Content</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Business Role</strong></td>
<td><strong>Business Catalog</strong></td>
</tr>
<tr>
<td>SAP_AMR_BCR_ALLOCATOR_T</td>
<td>SAP_AMR_BCR_ALLOCATOR_T</td>
</tr>
<tr>
<td>SAP_AMR_BCR_ALLOCATOR_T</td>
<td>SAP_AMR_BCR_ALLOCATOR_T</td>
</tr>
</tbody>
</table>

To test the installation of SAP Allocation Management for Retail from the SAP Fiori launchpad, you need to assign the roles above to your user on the front-end system.

Procedure

1. Log on to your front-end system.
2. Launch *User Maintenance* (transaction SU01).
3. Enter your user name in the *User* field and choose *Change*.
4. On the *Roles* tab, assign the roles `SAP_AMR_BCR_AP_ALLOCATOR` to your user.

**Caution**

If you already have an SAP Fiori launchpad open, you must clear your browser cache to apply any modifications made to your user roles. Otherwise, your changes will not be reflected in the SAP Fiori user interface.

**More Information**

*Security Information* section of the *SAP Allocation Management for Retail Administration Guide*.

### 6.2 SAP Assortment Planning for Retail

**Note**

Some of the activities in this section may have already been performed in the corresponding section under *SAP Customer Activity Repository*. Such activities do not need to be repeated during the setup and installation of consuming applications.

The following diagram depicts the post-installation process for SAP Assortment Planning for Retail 2.0.
6.2.1 Configure the Back-End System

6.2.1.1 Configure Demand Data Foundation

Use

SAP Assortment Planning for Retail uses master data and time series data stored in Demand Data Foundation (DDF). As such, prior to using the SAP Assortment Planning for Retail application, you must ensure that DDF is fully configured and operational.

This procedure highlights key DDF configuration steps required to use the SAP Assortment Planning for Retail application.

Procedure

1. Read the **Configure Demand Data Foundation (Optional) [page 149]** section or this guide.
Ensure that you have carried out all the necessary configuration listed in this section, in particular, that you have activated all the required event type linkages and have enabled the specified event queues in transaction SNETYPV. This ensures that the product hierarchy and location hierarchy flattener structures get created. For more information, see SAP Note 1425876.

2. Perform the necessary configuration steps in DDF.

The Configuring Demand Data Foundation (DDF) lists all of the Customizing activities that must be configured for DDF. DDF Customizing activities that are explicitly relevant for SAP Assortment Planning for Retail are also referenced under SAP Customizing Implementation Guide > Cross-Application Components > Assortment Planning for Retail > Imported Demand Data Foundation Settings.

### 6.2.1.2 Configure Assortment Planning for Retail

#### Use

To use SAP Assortment Planning for Retail, you must define several application-specific settings in Customizing.

#### Procedure

1. Verify that the DDF Customizing activities have been configured.

   DDF Customizing activities are accessible under SAP Customizing Implementation Guide > Cross-Application Components > Demand Data Foundation. Activities that are explicitly relevant for SAP Assortment Planning for Retail are also available under SAP Customizing Implementation Guide > Cross-Application Components > Assortment Planning for Retail > Imported Demand Data Foundation Settings.

   **Note**

   In the SAP Customizing Implementation Guide > Cross-Application Components > Assortment Planning for Retail > Imported Demand Data Foundation Settings > Basic Settings > Define Default Values Customizing activity, you do not need to maintain the Logical System ID or the Hierarchy ID settings. These are only required in an upgrade scenario.

2. Define the required number ranges.

   You must set all of the number ranges under SAP Customizing Implementation Guide > Cross-Application Components > Assortment Planning for Retail > Number Range.

6.2.1.3 Configure Unified Demand Forecast (Optional)

Use

During the installation, you have installed SAP RTL AFL FOR SAP HANA 200, which includes the functionality for the Unified Demand Forecast (UDF) module. For more information, see Install SAP Customer Activity Repository Retail Applications Bundle [page 44].

Currently, SAP Assortment Planning for Retail does not use the demand forecasting services provided by the UDF module, and only uses the sales projection functionality provided in the DDF module. As a result, the implementation (or configuration) of UDF is not mandatory.

Procedure

1. If you do wish to use UDF outside of the context of SAP Assortment Planning for Retail, see the following:
   ○ Setup: Configure Unified Demand Forecast (Optional) [page 154] section, earlier in this guide.

6.2.2 Verify Users, Privileges, and Roles

Use

Prior to proceeding with the post-installation steps for the application, you need to ensure that the required database users and back-end application users have all the required privileges, roles, and authorizations.

Prerequisites

You have read and implemented the procedure described in Verify SAP HANA User and Privileges [page 40].

Procedure

1. Ensure that the SAP HANA database users listed below exist and that they have the required additional roles/privileges.
Table 34:

<table>
<thead>
<tr>
<th>User</th>
<th>Role/Privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP&lt;SID&gt;</td>
<td>○ <strong>Privilege</strong> EXECUTE on procedure <strong>TRUNCATE_PROCEDURE_OBJECTS</strong></td>
</tr>
<tr>
<td></td>
<td>○ <strong>Privilege</strong> EXECUTE on procedure <strong>GET_PROCEDURE_OBJECTS</strong></td>
</tr>
<tr>
<td>_SYS_REPO</td>
<td></td>
</tr>
<tr>
<td>&lt;Your User Name&gt;*</td>
<td>○ <strong>Privilege</strong> REPO.READ on package bw2hana/SAP&lt;SID&gt;<em>/RAP/</em>&lt;InfoCube&gt;_REPORTING</td>
</tr>
<tr>
<td></td>
<td>The corresponding privileges will be created automatically when activating</td>
</tr>
<tr>
<td></td>
<td>BI Content.</td>
</tr>
<tr>
<td></td>
<td>○ <strong>Session Client</strong> of this database user has to be set to the appropriate</td>
</tr>
<tr>
<td></td>
<td>back-end system client.</td>
</tr>
<tr>
<td></td>
<td>1. Log on to SAP HANA studio.</td>
</tr>
<tr>
<td></td>
<td>2. Open the <strong>Modeler</strong> perspective and use the <strong>Navigator</strong> to access your</td>
</tr>
<tr>
<td></td>
<td>back-end system.</td>
</tr>
<tr>
<td></td>
<td>3. Under <strong>Security</strong>, select a user.</td>
</tr>
<tr>
<td></td>
<td>4. Set the <strong>Session Client</strong> to the client number created in **Set Up SAP Cli-</td>
</tr>
<tr>
<td></td>
<td>ent [page 47].</td>
</tr>
<tr>
<td></td>
<td>This step is necessary to use the SAP Assortment Planning for Retail</td>
</tr>
<tr>
<td></td>
<td>planning framework, where SAP BusinessObjects Analysis, edition for</td>
</tr>
<tr>
<td></td>
<td>Microsoft Office workbooks obtains data from SAP HANA views.</td>
</tr>
<tr>
<td></td>
<td>For more information, see the <strong>Assign Default Client</strong> section in the SAP</td>
</tr>
<tr>
<td></td>
<td>HANA Modeling Guide.</td>
</tr>
</tbody>
</table>

*The user name on SAP HANA database level, back-end system, and on the front-end server (SAP NetWeaver Gateway) must be identical.

2. Ensure that your back-end application user has the following roles/authorizations.
Table 35:

<table>
<thead>
<tr>
<th>User</th>
<th>Role/Authorization</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Your User Name&gt;*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>○ SAP_ISR_DDF_MASTER</td>
</tr>
<tr>
<td></td>
<td>○ SAP_ISR_AP_MASTER</td>
</tr>
<tr>
<td></td>
<td>○ /RAP/BW_AP_WORKBOOKS</td>
</tr>
<tr>
<td></td>
<td>○ Set SAP HANA User Mapping to C (DBMS user, else SAP HANA user with same name as BW user) in transaction RS2HANA_VIEW.</td>
</tr>
<tr>
<td></td>
<td>○ Verify that authorizations for generating SAP HANA views out of local BI Content objects is set up by running transaction RS2HANA_CHECK.</td>
</tr>
<tr>
<td></td>
<td>○ For more information, see <a href="http://help.sap.com/nw75">Application Help</a></td>
</tr>
<tr>
<td></td>
<td>○ Function-Oriented View SAP Business Warehouse Using the SAP HANA Database Data Modeling When Using a SAP HANA Modeling and Analysis for Business Users Mixed Modeling (SAP BW and SAP HANA) Generating SAP HANA Views from the BW System Authorizations for Generating SAP HANA Views</td>
</tr>
<tr>
<td></td>
<td>○ The user profile must have the following parameters maintained (transaction SU3, Parameters tab):</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSPLS_HDB_PE_TRACE</td>
<td>Y</td>
</tr>
<tr>
<td>RSPLS_HDB_SUPPORT</td>
<td>HDB_ON</td>
</tr>
</tbody>
</table>

*The user name on SAP HANA database level, back-end system, and on the front-end server (SAP NetWeaver Gateway) must be identical.

3. Ensure that your front-end application user name is identical to the user name on SAP HANA database level and on the back-end system. Furthermore, verify that the front-end application user has all the necessary roles assigned. For more information, see the Security Information section in the SAP Assortment Planning for Retail Administrator's Guide.

### 6.2.3 Activate SAP Assortment Planning for Retail Planning Framework Content

The planning framework used by SAP Assortment Planning for Retail consists of the following elements:

- **Business Intelligence Content (BI Content) Objects**: A collection of local BI Content objects is used as the basis for the SAP BusinessObjects Analysis, edition for Microsoft Office workbooks. SAP BusinessObjects Analysis, edition for Microsoft Office workbooks are designed to consume data from BI Content objects. The local BI Content objects that are provided with the SAP Assortment Planning for Retail applications use the integrated planning engine in SAP Business Warehouse (SAP BW). These local BI Content objects are used as an interface between the SAP HANA views and the SAP BusinessObjects Analysis, edition for Microsoft Office workbooks.
Note

The local BI Content provided with the SAP Assortment Planning for Retail application is entirely independent of the SAP Business Warehouse BI Content and BI Content Extensions add-on. You can use this local BI Content directly in SAP Assortment Planning for Retail.

- **SAP BusinessObjects Analysis, edition for Microsoft Office Workbooks**: Microsoft Excel-based spreadsheets that you use to plan assortments for the different locations in your retail business.

This section of the guide provides information on the SAP HANA content activation, BI Content activation and configuration, and data upload activities required to set up the SAP Assortment Planning for Retail planning framework.

Note

If you have already activated SAP HANA content for SAP Customer Activity Repository, as described in Activate SAP HANA Content [page 138], you can proceed to the Activate SAP HANA Content for SAP Assortment Planning for Retail - Part 1 [page 85] procedure.

6.2.3.1 Activate SAP HANA Content for SAP Assortment Planning for Retail - Initial Activation

Use

In this procedure, you activate all SAP HANA Transport for ABAP (HTA) content required for SAP Assortment Planning for Retail. For each SAP HANA content package, there is one HTA object.

Caution

This initial activation results in a partial activation of the SAP HANA content for SAP Assortment Planning for Retail. Several SAP HANA views depend on local BI Content objects, and as such, have to be activated following the activation of these BI Content objects. For more information, see Activate SAP HANA Content for SAP Assortment Planning for Retail - Final Activation [page 93].

Prerequisites

- You must have successfully completed all of the procedures listed in the previous sections of this guide.
- You must have created all the necessary tables, as described in the Create/Replicate Source Master Data System Tables section of the Common Installation Guide.
- You have implemented SAP Notes 2395997, 2388066, 2390790, 2392194.
Procedure

1. In your back-end system, start transaction SE38.
2. Enter /CAR/ACTIVATE_HTA and choose *Execute*.
3. Select all applicable source master data systems, the *Assortment Planning* business scenarios, and external systems for which you wish to activate HTA content.
4. Optionally, choose the *Perform Prerequisite Check* option to validate the processing and read the system log prior to applying any database changes.
5. Choose *Execute*.

More Information

- If you encounter issues during the activation, see the *Troubleshooting [page 166]* section for possible solutions.
- For more information about HTAs, see the Application Help for SAP NetWeaver 7.5 at [https://help.sap.com/saphelp_nw75/helpdata/en/ff/7652bd542849b18b218efe8d2f2373/content.htm?frameset=/en/34/dfb3083df34453beb9eb8ade7bd4ed/frameset.htm&current_toc=/en/4e/bfa9a86e391d14adc9ffe4e204223/plain.htm&node_id=7&show_children=false].

6.2.3.2 Activate SAP Assortment Planning for Retail Local BI Content

### 6.2.3.2.1 Activate Technical Content

**Use**

The first time you enter the Data Warehousing Workbench, the system runs a background job to activate technical content. Technical content consists of technical information that is generated by the system, for example, data required for the general operation of BI Content, or time data.

**Procedure**

1. On your back-end system, open the Data Warehousing Workbench (transaction RSA1).
2. If prompted, in the *Replicate Metadata* dialog box, choose *Only Activate*.
3. If a message appears that you are only authorized to work in client ..., refer to SAP Note 316923 (do not import the support package, but use the description under section *Workaround*).
4. Select **Do not show this question Again** in the dialog that appears.
5. Choose **Yes**.

Make sure that the current job has finished before you proceed with the next step. Check the status of the background job using transaction SM37 or SLG1. If there are problems, you must first solve them. You can use transaction RSTCO_ADMIN to restart the activation of the technical content and to verify the status of the activation.

**Note**

In the case that you get the shot-dump "RAISE_EXCEPTION" when installing InfoObjects from the BI content, see SAP Note 1637935 for a possible solution. Also, see SAP Notes 2090845 and 2056106 for important information on technical content activation.

Following activation, you can locate the technical content in the Data Warehousing Workbench as follows:
1. Selecting **Modeling** in the left-hand frame.
2. Expand **InfoObjects**.
3. In the right-hand frame, locate **Technical Content**.

### 6.2.3.2.2 Activate Application BI Content

**Use**

In this procedures, you perform a sequential, step-by-step activation of the local BI Content objects delivered with the SAP Assortment Planning for Retail application.

**Note**

To ensure correct activation of the local BI Content objects, carry out the activation sequentially, as specified in the following procedures. Also, the default BI setting to collect and activate all dependencies must not be disabled by the user. The instructions below activate a minimum subset of objects, and it assumed that all their dependencies will be collected and activated.

**Procedure**

1. On your back-end SAP Assortment Planning for Retail system, open the Data Warehousing Workbench (transaction RSA1).
2. Verify transport connections.
   1. Select **Transport Connection** in the left-hand frame.
   2. Select **Object Types**.
   3. Expand **Source System**.
4. Use **Select Objects** to ensure that the back-end system is selected as the source system.
5. Choose **Transfer Selections**.
6. At the top of the right-hand frame, above the list of **Collected objects**, choose **Grouping** and select **Only Necessary Objects**.
7. At the top of the right-hand frame, choose **Collection Mode** and select **Collect Automatically**.
3. Select **BI Content** in the left-hand frame.

4. Determine your BI Content installation requirements and apply these to each subsequent step. If you are carrying out a brand new installation, proceed to the next step.

**Recommendation**

If, however, you have previously installed/activated any of the */RAP/* BI Content, you need to apply special considerations to the installation/activation of BI Content following a system upgrade.

- If you have modified any of the previously installed */RAP/* BI Content objects, we recommend that for the modified objects, you enable the **Match (X) or copy** option. When this option is selected, you will be asked to carry out an additional **Transfer selections** step during which you select to install the **Active Version** (that is, your modified version) or the **Content Version** (that is, the SAP delivered, and possibly updated version of the object).
- If you have not modified any of the previously installed */RAP/* BI Content objects, you do not need to enable the **Match (X) or copy** option for any of the BI Content objects, and you don’t need to choose whether to install the **Active Version** or the **Content Version** of the objects.

5. Activate InfoObject catalogs.
   1. Expand **InfoObject Catalog**.
   2. Use **Select Objects** to select the */RAP/CHAR_CAT and the */RAP/KYF_CAT catalogs, that is, all the InfoObject catalogs that starting with */RAP/*.
   3. Choose **Transfer Selections**.
   4. In the right-hand frame, in the list of **Collected objects**, verify that both InfoObject catalogs are listed.
5. Right-click on each of the InfoObject catalogs, and choose **Install all Below**.

6. Choose **Install**.
   If an information dialog box appears, choose **Continue**. Choose **Local Object** or enter a package if you need to transport the objects.

6. Activate **Variable** /RAP/DISTM_MSM_01.
   1. Expand **Query Elements**.
   2. Use **Select Objects** to select the /RAP/DISTM_MSM_01 Variable.
   3. Choose **Transfer Selections**.
   4. In the right-hand frame, in the list of **Collected objects**, verify that the /RAP/DISTM_MSM_01 Variable is listed and that the option in the **Install** column is enabled.
   5. Choose **Install**.
   If an information dialog box appears, choose **Continue**. Choose **Local Object** or enter a package if you need to transport the objects.

7. Select **Modeling** in the left-hand frame.

8. Maintain version master data.
   1. Expand **InfoObjects**.
   2. Search for InfoObject /RAP/VERSN, located under **Assortment Planning for Retail > RAP Character InfoObject Catalog**.
   3. Right-click the InfoObject /RAP/VERSN, choose **Maintain Master Data** from the context menu, and maintain the following entries on the **Time Independent** tab:

<table>
<thead>
<tr>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>AP1</td>
</tr>
<tr>
<td>AP2</td>
</tr>
<tr>
<td>AW1</td>
</tr>
<tr>
<td>AW2</td>
</tr>
<tr>
<td>APF</td>
</tr>
<tr>
<td>OP1</td>
</tr>
<tr>
<td>OP2</td>
</tr>
<tr>
<td>PRJ</td>
</tr>
<tr>
<td>REF</td>
</tr>
<tr>
<td>000</td>
</tr>
<tr>
<td># - An empty version value that you must maintain</td>
</tr>
</tbody>
</table>

   The supported planning versions are described in detail in the **Maintain Customizing Table /RAP/RS_VARCUST [page 95]** procedure.
9. Select Bi Content in the left-hand frame.
10. Activate DataStore Objects.
    1. Expand More Types DataStore Object (Classic).
    2. Use Select Objects to select all DataStore Objects starting with /RAP/*.
    3. Choose Transfer Selections.
    4. In the list of Collected objects, verify that the option in the Install column is enabled for each of the objects.
    5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a package if you need to transport the objects.
If during the installation, you are presented with a dialog asking you to add objects to a personal list, select No.
If activation warnings similar to the ones displayed below appear, you can ignore them.

![Figure 12: Warnings](image)

11. Activate InfoCubes.
    1. Expand InfoCube.
    2. Use Select Objects to select all InfoCubes starting with /RAP/RC*.
4. Choose **Transfer Selections**.

5. In the list of **Collected objects**, verify that the option in the **Install** column is enabled for each of the objects.

6. Choose **Install**. If an information dialog box appears, choose **Continue**. Choose **Local Object** or enter a package if you need to transport the objects. If activation warnings similar to the ones displayed below appear, you can ignore them.

![Figure 13: Warnings](image)

---

12. **Activate Aggregation Levels.**

   1. Expand **Planning > Aggregation Level**.
   
   2. Use **Select Objects** to select the following Aggregation Levels:
      - /RAP/D20A01
      - /RAP/R20A02
      - /RAP/R20A06
      - /RAP/R20A08
      - /RAP/R20A11
      - /RAP/R20A12
      - /RAP/R20A15
      - /RAP/R20A17

   3. Choose **Transfer Selections**.

   4. In the list of **Collected objects**, verify that the option in the **Install** column is enabled for each of the objects.

   5. Choose **Install**. If an information dialog box appears, choose **Continue**. Choose **Local Object** or enter a package if you need to transport the objects.

---

13. **Activate Planning Sequence Objects.**

   1. Expand **Planning > Planning Sequence**.

   2. Use **Select Objects** to select the following Planning Sequences:
      - /RAP/C21A01_PS01
      - /RAP/D23A01_PS01
      - /RAP/D24A01_PS01
      - /RAP/R20A08_PS01

   3. Choose **Transfer Selections**.
4. In the list of Collected objects, verify that the option in the Install column is enabled for each of the objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a package if you need to transport the objects.

   1. Expand More Types Analysis Office Excel Workbook.
   2. Use Select Objects to select the following workbooks:
      ○ /RAP/PLANASSORTMENT
      ○ /RAP/PLANOPTIONS
   3. Choose Transfer Selections.
   4. In the list of Collected objects, verify that the option in the Install column is enabled for each of the objects.
   5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a package if you need to transport the objects.

15. Choose Exit to leave the transaction.

6.2.3.3 Activate SAP HANA Content for SAP Assortment Planning for Retail - Final Activation

Use

In this procedure, you perform the final activation of SAP HANA content (views and stored procedures) required by the SAP Assortment Planning for Retail application. This final activation results in a full activation of the SAP HANA content for SAP Assortment Planning for Retail. Several SAP HANA views depend on local BI Content objects, and as such, have to be activated following the activation of these BI Content objects, as described in this procedure.

Prerequisites

As a mandatory prerequisite for a successful activation of SAP HANA content for SAP Assortment Planning for Retail, you must have successfully completed all of the procedures listed in the previous sections of this guide. In particular, Activate SAP HANA Content for SAP Assortment Planning for Retail - Initial Activation [page 85].

Procedure

1. In your back-end system, start transaction SE38.
2. Enter /CAR/ACTIVATE_HTA and choose Execute.
3. Select all applicable source master data systems, the Assortment Planning (Final) business scenarios, and external systems for which you wish to activate HTA content.
4. Optionally, choose the **Perform Prerequisite Check** option to validate the processing and read the system log prior to applying any database changes.

5. Choose **Execute**.

**More Information**

- If you encounter issues during the activation, see the [Troubleshooting](#) section for possible solutions.
- For more information about HTAs, see the Application Help for SAP NetWeaver 7.5 at [https://help.sap.com/saphelp_nw75/helpdata/en/ff/7652bd542849b18b218efe8d2f2373/content.htm?frameset=/en/34/dfb3083df34453beb5eb8ade7bd4ed/frameset.htm&current_toc=/en/4e/bfa9a86e391014adc9ffe4e204223/plain.htm&node_id=7&show_children=false].

### 6.2.3.4 Configure SAP Assortment Planning for Retail Local BI Content

#### 6.2.3.4.1 Enable the Planning Application Kit (PAK)

**Use**

To be able to use the SAP BusinessObjects Analysis, edition for Microsoft Office workbooks provided as part of the SAP Assortment Planning for Retail planning framework content, you must enable the Planning Application Kit.

**Procedure**

1. Read SAP Note [1637199](http://help.sap.com/).
2. In your back-end system, launch table/view maintenance (transaction SM30).
3. Enter RSPLS_HDB_ACT in the **Table/View** field and choose **Maintain**.
4. Choose **New Entries**.
5. In the **HANA Integratn. Actve** column select **Deep HANA Integration Active** and in the **Functn. Actve** column, enable the checkbox.
6.2.3.4.2 Maintain Customizing Table /RAP/RS_VARCUST

Use

In this procedure, you maintain entries in the variable customizing table /RAP/RS_VARCUST in the back-end system. For each SAP Assortment Planning for Retail query, the entries of this table specify a mapping of a data version (for example, actual data versus planning data) to the source of data (InfoCube).

Procedure

1. Log on to your back-end system.
3. Determine whether you want to overwrite the existing entries in the /RAP/RS_VARCUST table. If you do want to overwrite the contents of the table, enable the Remove Existing Entries option. If you don't want to overwrite the contents of the table, but want to append the new entries, disable the Remove Existing Entries option.

   ![i Note]
   Duplicate entries can potentially be created if you choose to disable the Remove Existing Entries option. This could result in an error.

4. Enable the Test option and choose Execute to run the report in test mode. Running the report in test mode allows you to verify that you can successfully update the /RAP/RS_VARCUST table. No entries are persisted in the table as a result.
5. Once you have successfully executed the /RAP/SEED_BW_CUSTOMIZING_DATA report in test mode, disable the Test option and choose Execute to run the report.
6. Optionally, once the report has finished executing, you can verify the entries of the /RAP/RS_VARCUST variable customizing table.
   If required, you can make changes to any of the entries made by the /RAP/SEED_BW_CUSTOMIZING_DATA report by doing the following:
   1. Open the Data Browser (transaction SE16).
   2. Enter /RAP/RS_VARCUST in the Table Name field and choose Create Entries.
   3. Choose Execute followed by Create.
      On the Table /RAP/RS_VARCUST Insert screen, you will be able to make the following entries:

   ![Table 38]
<table>
<thead>
<tr>
<th>Field Name</th>
<th>User Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPID</td>
<td>SAP Assortment Planning for Retail technical query name. For example, /RAP/C23A01_IRQ01.</td>
</tr>
<tr>
<td>Field Name</td>
<td>User Entry</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VNAM_ICUBE</td>
<td>InfoCube variable name. For example, /RAP/INFOPROV_ESM_21.</td>
</tr>
<tr>
<td>INFOCUBE</td>
<td>InfoCube identifier. For example, /RAP/RC21.</td>
</tr>
<tr>
<td>VNAM_VERS</td>
<td>Version variable name. For example, /RAP/VERSN_MSM_21.</td>
</tr>
<tr>
<td>VERSION</td>
<td>Version Identifier. There are several supported planning versions:</td>
</tr>
<tr>
<td></td>
<td>○ AP1: Location level version 1. Version that is typically used as the planning version.</td>
</tr>
<tr>
<td></td>
<td>○ AP2: Location level version 2. Version typically used to simulate different scenarios without having to change your planned version.</td>
</tr>
<tr>
<td></td>
<td>○ AW1: Week level version 1. Version that is typically used as the planning version.</td>
</tr>
<tr>
<td></td>
<td>○ AW2: Week level version 2. Version typically used to simulate different scenarios without having to change your planned version.</td>
</tr>
<tr>
<td></td>
<td>○ OP1: Option plan version 1. Version that is typically used as the planning version.</td>
</tr>
<tr>
<td></td>
<td>○ OP2: Option plan version 2. Version typically used to simulate different scenarios without having to change your planned version.</td>
</tr>
<tr>
<td></td>
<td>○ APF: Final version (planned data). After completing the planning, the user will select the plan they want to finalize and review in the Plan Weekly Sales and Receipts workbook. Only the APF version is available in Plan Weekly Sales and Receipts.</td>
</tr>
<tr>
<td></td>
<td>○ REF: Reference version (past data). This is historical data for the items from the time frame of the reference period. This data is used to pre-populate the planning version by using the copy function. This allows the planner to have a baseline when starting the planning process. It is recommended to seed the planning version with the REF data.</td>
</tr>
<tr>
<td></td>
<td>○ 000: Actual version (current data). The user can see current inventory values with this such as Actual Inventory and Open Orders.</td>
</tr>
<tr>
<td></td>
<td>○ PRJ: Sales projection version.</td>
</tr>
<tr>
<td>F4HELP</td>
<td>Flag that specifies whether the field provides F4 help or not.</td>
</tr>
</tbody>
</table>

4. **Maintain entries in the /RAP/RS_VARCUST table as required.**
   For example you can change the InfoCube used as the source of data for a particular planning version.

5. **Choose Save.**
6.2.3.4.3 Maintain Fiscal Year Variant

Use

In this procedure you maintain the required fiscal year variant (OFISCVARNT 'RW'). SAP Assortment Planning for Retail uses time objects OFISCPER (fiscal year period) and OFISCVARNT (fiscal year variant), provided as part of the technical BI Content, and activated in the Activate Technical Content [page 86] procedure.

⚠️ Caution

You must maintain fiscal year variants for at least one year past the years for which you are planning. For example, if your assortment plans extend to December 2018, you must maintain fiscal year variants until December 2019.

The steps provided in this procedure allow you to maintain OFISCVARNT 'RW' using the standard 4-5-4 calendar entries. If you are using alternative fiscal periods in your retail business, for example, each week starting on a Sunday instead of Saturday, you can provide your own entries instead of the ones suggested in this guide.

Procedure

1. Log on to your back-end system.
2. Launch fiscal year variant maintenance (transaction GVAR).
3. Choose New Entries.
4. On the New Entries: Overview of Added Entries screen make the following sets of entries:

- **Figure 14: Create New Fiscal Year Variant**

5. Choose **Enter**.
   An information message is displayed about creating more than 16 periods, choose **Continue**.
6. Choose **Back**.
   You can see the newly created entry.
7. Mark the entry **RW** and double-click on **Shortened Fiscal Years** from the **Dialog Structure**.
8. Enter **2012** in the **Fiscal year** field and choose **Continue**.
9. Choose **New Entries**.
10. Enter **52** in the **No. of posting periods** field in the **Shortened Fiscal Years** section.
11. Choose **Back** twice.
12. Open SAP Note **2112634** , locate the entries for year 2012, and enter the data by copy-and-paste.
13. Repeat steps 7-12 to maintain the weekly fiscal year variant for years 2013, 2014, 2015, 2016, 2017, 2018, 2019, and 2020, entering each year as shortened fiscal year. The corresponding tables are available in SAP Note **2112634**.
14. Choose **Save** after you have finished the maintenance for year 2020.
6.2.3.5 Activate External Views

Use

During the activation of SAP HANA content for SAP Assortment Planning for Retail, several external views are not automatically activated.

Procedure

1. Read and implement SAP Note 2067030 to manually activate external views. You can use either transaction SE11 or SE80 to activate the views.

6.2.3.6 Verify the Connection Between SAP Assortment Planning for Retail System and SAP BusinessObjects Analysis, edition for Microsoft Office

Use

The SAP Assortment Planning for Retail application includes several SAP BusinessObjects Analysis, edition for Microsoft Office workbooks. These workbooks, which are installed on your back-end system as part of the local BI Content, can only be opened using SAP BusinessObjects Analysis, edition for Microsoft Office.

In this procedure, you verify that you can open an SAP Assortment Planning for Retail workbook from SAP BusinessObjects Analysis, edition for Microsoft Office.

Prerequisites

You have installed SAP BusinessObjects Analysis, edition for Microsoft Office as a prerequisite to the installation of the SAP Assortment Planning for Retail application, as described in the Prerequisites [page 32] section.

Procedure

2. From the File menu, select Analysis -> Open Workbook (Open Workbook from SAP NetWeaver).
3. Select your back-end system.
   Tip: The list of systems corresponds to the systems available in your SAP Logon.
4. If single sign-on is not configured provide your user information.
5. Search for /RAP/* on the Search tab.
   Alternatively, open the Folder tab and navigate to Assortment planning workbooks > Workbooks
6. Open any of the workbooks from the list of SAP Assortment Planning for Retail workbooks.
   The opening of the workbook indicates that there are no issues with the connection between your back-end
   system and SAP BusinessObjects Analysis, edition for Microsoft Office.

6.2.3.7 Specify Analysis Workbooks Settings

SAP Assortment Planning for Retail is delivered with a number of SAP BusinessObjects Analysis, edition for
Microsoft Office workbooks. These are template workbooks that you can adapt to use in your retail business.
For an example of how to create customized versions of the workbooks, see Workbook Design Example [page
220].

6.2.3.7.1 Enable Macros

Use

In this procedure, you enable your SAP BusinessObjects Analysis, edition for Microsoft Office workbooks to use
macros.

Procedure

1. Open SAP BusinessObjects Analysis, edition for Microsoft Office from Start > All Programs > SAP
   Business Intelligence > SAP BusinessObjects Analysis > Analysis for Microsoft Excel
2. Choose File > Options > Customize Ribbon
3. Under Customize the Ribbon, select Main Tabs.
4. Enable the entry Developer and confirm by choosing OK.
5. Now you will see the new Developer tab in your SAP BusinessObjects Analysis, edition for Microsoft Office.
7. Choose Enable all macros.
6.2.3.7.2 Set Language for Ribbons and Buttons in Workbooks

Use

In this procedure, you can set the desired language of the following user interface objects that are specific to the workbooks of SAP Assortment Planning for Retail:

- Ribbons *Planning Functions, Refinement Functions*, and *Extended Features*
- Tooltips for planning functions
- Message texts
- Buttons.

The content of the workbooks consists of multiple parts:

- The language of the standard menus and standard ribbons depends on the language set for Microsoft Excel.
- The language of the contents in the cells (mainly KPIs) depends on the user-selected system language of the back-end system.
- The language of the user interface objects that are specific to the workbooks of SAP Assortment Planning for Retail, is not set by the selected system language of the back-end system, but you can change it for each workbook according to the following procedure. The default language is English.

Procedure

1. Unhide the worksheet `SAP_TEXT_CUSTOMIZING` using standard functionality of Microsoft Excel.
2. On the worksheet `SAP_TEXT_CUSTOMIZING`, copy the column of the desired language to column B - Custom Text.
3. Hide the worksheet `SAP_TEXT_CUSTOMIZING`.
4. Save your changes in the worksheet on the SAP NetWeaver Server by choosing **File > Analysis > Save Workbook to SAP NetWeaver**.

**Note**

To allow for correct interpretation of the texts by screen readers, make sure that the language for all parts of the workbooks is set to the same desired one. Set the language as described in this section.
6.2.3.7.3 Set ResultSetSizeLimit Registry Setting

Use

By default, SAP BusinessObjects Analysis, edition for Microsoft Office workbooks are set to display 500,000 cells. This setting might not be sufficient for the productive use of SAP Assortment Planning for Retail. For example, if you have more than 300 products in your assortment plan, you might encounter the following error message:

![Figure 15: Size Limit Error](image)

To resolve this issue, you need to increase the default setting of the `ResultSetSizeLimit` registry setting.

Procedure

Read and implement SAP Note 1662968.

**Note**

As the administrator overseeing the installation of SAP Assortment Planning for Retail, you need to carry out the steps listed in this procedure on the workstation of each SAP Assortment Planning for Retail user.
6.2.4 Configure Data Replication

SAP Assortment Planning for Retail uses master data, sales history data, inventory data, and merchandise planning data originating from connected systems, such as SAP Retail (SAP ERP) or SAP BW.

The general flow of data in the SAP Assortment Planning for Retail is illustrated in the diagram below.

![Diagram of Data Flow to SAP Assortment Planning for Retail](image)

Figure 16: Data Flow to SAP Assortment Planning for Retail

The following subsections describe the data replication tasks that you carry out to configure the data flow to the SAP Assortment Planning for Retail application.

6.2.4.1 Initial Load of Data to DDF Using DRFOUT

Use

SAP Assortment Planning for Retail uses master data, such as product, location, and product hierarchy, that is replicated from SAP Retail or SAP S/4HANA to DDF using DRFOUT. SAP Assortment Planning for Retail only works with imported product hierarchies of type article hierarchy, maintained in the the source master data system (SAP Retail or SAP S/4HANA). When configuring the import of product hierarchies, you must ensure to import article hierarchies.
Prerequisites

Prior to replicating data from SAP Retail or SAP S/4HANA to DDF using DRFOUT, the following prerequisites must be fulfilled:

- You must maintain the required article hierarchy(ies) in the source master data system (SAP Retail or SAP S/4HANA) to be imported and used to perform planning in SAP Assortment Planning for Retail.
- Your SAP Retail installation is SAP Enhancement Package 6 for SAP ERP SP07 or higher or SAP Enhancement Package 5 for SAP ERP SP10 or higher.
- The following business functions are activated in SAP Retail or SAP S/4HANA:
  - ISR_APPL_OUTBOUND_DM
  - ISR_RETAIL_OUTBOUND_DM
- You have noted the different terms for the following objects:

<table>
<thead>
<tr>
<th>SAP Retail or SAP S/4HANA</th>
<th>SAP Retail</th>
<th>DDF/SAP Assortment Planning for Retail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material</td>
<td>Article</td>
<td>Product</td>
</tr>
<tr>
<td>Plant</td>
<td>Site</td>
<td>Location</td>
</tr>
</tbody>
</table>

Procedure

1. Read *Enabling Demand Data Foundation and Creating Demand Forecast*.
2. Read *Configuring Data Replication from SAP ERP to DDF*.
3. Replicate the required data.
   If you are using SAP Promotion Management for Retail and SAP Assortment Planning for Retail, define a replication model as described in *Configuring Data Replication from SAP ERP to DDF*. Otherwise, see the additional instructions below.
SAP Assortment Planning for Retail requires that the following master data is replicated sequentially from a connected SAP Retail or SAP S/4HANA system using **DRFOUT**: 

**Table 40:**

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Master Data</th>
<th>Technical Details</th>
<th>For more information, see:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Product Hierarchy</td>
<td>○ <strong>SAP Retail or SAP S/4HANA Description:</strong> Material Group Hierarchy&lt;br&gt;○ <strong>DRFOUT Outbound Implementation:</strong> PMLCH&lt;br&gt;○ <strong>DDF Inbound Interface:</strong> /DMF/MDIF_PROD_HIER_INBOUND</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a> release &gt; Application Help &gt; Demand Data Foundation &gt; Integration &gt; Inbound Interfaces For Remote Function Call (RFC) &gt; Communication &gt; Product Hierarchy Master Data</td>
</tr>
<tr>
<td>2</td>
<td>Product</td>
<td>○ <strong>SAP Retail or SAP S/4HANA Description:</strong> Material&lt;br&gt;○ <strong>DRFOUT Outbound Implementation:</strong> PMAT&lt;br&gt;○ <strong>DDF Inbound Interface:</strong> /DMF/MDIF_PRODUCT_INBOUND</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a> release &gt; Application Help &gt; Demand Data Foundation &gt; Integration &gt; Inbound Interfaces For Remote Function Call (RFC) &gt; Communication &gt; Product Master Data</td>
</tr>
<tr>
<td>3</td>
<td>Location</td>
<td>○ <strong>SAP Retail or SAP S/4HANA Description:</strong> Plant&lt;br&gt;○ <strong>DRFOUT Outbound Implementation:</strong> PPLT&lt;br&gt;○ <strong>DDF Inbound Interface:</strong> /DMF/MDIF_LOCATION_INBOUND</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a> release &gt; Application Help &gt; Demand Data Foundation &gt; Integration &gt; Inbound Interfaces For Remote Function Call (RFC) &gt; Communication &gt; Product Location Master Data</td>
</tr>
<tr>
<td>4</td>
<td>Product Location</td>
<td>○ <strong>SAP Retail or SAP S/4HANA Description:</strong> Material/Plant&lt;br&gt;○ <strong>DRFOUT Outbound Implementation:</strong> PMPL&lt;br&gt;○ <strong>DDF Inbound Interface:</strong> /DMF/MDIF_PROD_LOC_INBOUND</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a> release &gt; Application Help &gt; Demand Data Foundation &gt; Integration &gt; Inbound Interfaces For Remote Function Call (RFC) &gt; Communication &gt; Product Location Master Data</td>
</tr>
<tr>
<td>Sequence</td>
<td>Master Data</td>
<td>Technical Details</td>
<td>For more information, see:</td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>5</td>
<td>Product Location</td>
<td>○ SAP Retail or SAP S/4HANA Description: Sales Price&lt;br&gt;○ DRFOUT Outbound Implementation: PSPR&lt;br&gt;○ DDF Inbound Interface: /DMF/MDIF_PROD_LOC_INBOUND</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a> &lt;your release&gt; Application Help Demand Data Foundation Integration Information Inbound Interfaces For Remote Function Call (RFC) Communication Product Location Master Data</td>
</tr>
<tr>
<td>6</td>
<td>Inventory</td>
<td>○ SAP Retail or SAP S/4HANA Description: Inventory&lt;br&gt;○ DRFOUT Outbound Implementation: PINV&lt;br&gt;○ DDF Inbound Interface: /DMF/OPIF_INVENTORY_INBOUND</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a> &lt;your release&gt; Application Help Demand Data Foundation Integration Information Inbound Interfaces For Remote Function Call (RFC) Communication Inventory Master Data</td>
</tr>
<tr>
<td>7</td>
<td>Product Location</td>
<td>○ SAP Retail or SAP S/4HANA Description: Moving Average Price&lt;br&gt;○ DRFOUT Outbound Implementation: PMAP&lt;br&gt;○ DDF Inbound Interface: /DMF/MDIF_PROD_LOC_INBOUND</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a> &lt;your release&gt; Application Help Demand Data Foundation Integration Information Inbound Interfaces For Remote Function Call (RFC) Communication Product Location Master Data</td>
</tr>
<tr>
<td>8</td>
<td>Transportation Lane</td>
<td>○ SAP Retail or SAP S/4HANA Description: Source of Supply&lt;br&gt;○ DRFOUT Outbound Implementation: PSOS&lt;br&gt;○ DDF Inbound Interface: /DMF/MDIF_LANE_INBOUND</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a> &lt;your release&gt; Application Help Demand Data Foundation Integration Information Inbound Interfaces For Remote Function Call (RFC) Communication Transportation Lane Master Data</td>
</tr>
<tr>
<td>9</td>
<td>Location</td>
<td>○ SAP Retail or SAP S/4HANA Description: Vendor&lt;br&gt;○ DRFOUT Outbound Implementation: PVEN&lt;br&gt;○ DDF Inbound Interface: /DMF/MDIF_LOCATION_INBOUND</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a> &lt;your release&gt; Application Help Demand Data Foundation Integration Information Inbound Interfaces For Remote Function Call (RFC) Communication Location Master Data</td>
</tr>
</tbody>
</table>
You can import the data into staging tables, and then transfer this data to production tables using report /DMF/PROCESS_STAGING_TABLES. Or you can skip the staging tables, and import the data directly into the production tables. For more information, see:

- http://help.sap.com/car<your release> Application Help Demand Data Foundation Integration Information Inbound Processing

More Information

For more information on monitoring the replication, see:

- Periodic Tasks section under Management

### 6.2.4.2 Load of Time-Dependent Article Hierarchies

**Use**

SAP Assortment Planning for Retail supports the use of time-dependent article hierarchies.

**Procedure**

To enable the use of time-dependent article hierarchies in SAP Assortment Planning for Retail, do the following:

1. Implement SAP Notes 2196323 and 2196351 in the connected SAP ERP system.
2. If your hierarchy is already a time-dependent hierarchy, you need to re-import the product hierarchies into SAP Assortment Planning for Retail using the DRFOUT framework.
   - SAP ERP Description: Article Hierarchy
DRFOUT Outbound Implementation: PAHY
DDF Inbound Interface: /DMF/MDIF_PROD_HIER_INBOUND

6.2.4.3 Initial Load of Sales Data

Use

The initial load of historical sales data can vary depending on your particular landscape.

Procedure

Initial Load from SAP BW

If you have accumulated large amounts of historical sales data using SAP POS Data Management or SAP Customer Activity Repository, it is possible that you are storing these large data sets in a connected SAP BW system. In such a case, you can perform the initial load of the sales time series (historical POS data) data into DDF using the BI Interface for Time Series report.

1. Log on to your back-end system.
2. Execute transaction SE38.
4. Read the documentation associated with the report, carry out the described Customizing, and run the report accordingly.

Recommendation

Specify ORPA_C01, ORPA_C02, and ORPA_C03 data sources in the BI DataSource field of the Interface for Initial Data from BI to Time Series - Profile Customizing activity.

Initial Load from SAP Customer Activity Repository

If you are using SAP Customer Activity Repository and storing your historical sales data in the /POSDW/TLOGF table, you can use the standard outbound task 0050 to send data to DDF. This outbound task sends data using an RFC connection and the /DMF/BI_SALES_DATA function module.

For more information, see http://help.sap.com/car<your release> Application Help POS Data Transfer and Audit Task Processing Tasks for Sending Data to Follow-On Applications Sending Data to DMF-Based Applications.

Enhancements for Historical Cost

Once the initial load of sales data is complete, we recommend that you enhance the sales records with the historical cost of the products at the locations where they were sold. As illustrated in the diagram below, you add the historical cost to the sales records using the BAdi: Determination of Purchase Price for Sales History Record. This BAdi is located in Customizing under Cross-Application Components Demand Data Foundation Imported Data Time Series Enhancements Using Business Add-Ins.
When performing a delta load of master data from SAP Retail or SAP S/4HANA using the `DRFOUT` framework, you must ensure that the product location data required to enhance the sales records with historical sales cost is loaded prior to the sales data.

Furthermore, we recommend that you schedule a weekly periodic task to replicate inventory data (outbound implementation `PINV`) from the SAP Retail or SAP S/4HANA system to the system for SAP Assortment Planning for Retail. This replication builds up the inventory history data that is needed by SAP Assortment Planning for Retail.
### 6.2.4.5 Delta Load of Sales Data in SAP Customer Activity Repository

#### Use

Once the initial load of historical sales data is completed, or, if you are working on a brand new system implementation and do not have to perform an initial sales data load, you need to configure the periodic delta load of sales data in SAP Customer Activity Repository.

#### Procedure

1. Ensure that you have properly configured the POS Sales Transfer and Audit functionality in SAP Customer Activity Repository to receive transaction data from your connected POS systems.
   For more information, see Performing POS Data Transfer and Audit.
2. Ensure that you have configured the Supply - DMF-Based Applications outbound tasks to load sales data from POS Sales Transfer and Audit to DDF.
   For more information, see http://help.sap.com/car <your release> Application Help POS Data Transfer and Audit Task Processing Tasks for Sending Data to Follow-On Applications Sending Data to DMF-Based Applications.
4. Specify Point of Sale Data as the source of sales data in Customizing under Cross-Application Components Assortment Planning for Retail Imported Demand Data Foundation Settings Data Maintenance Define Time Series Source.

#### More Information


### 6.2.4.6 Replicate SAP Retail or SAP S/4HANA Tables for SAP Assortment Planning for Retail

#### Use

In this procedure, you ensure that all SAP Retail or SAP S/4HANA tables that are relevant for SAP Assortment Planning for Retail have not only been created but have also been filled with data. More specifically, you replicate the contents of relevant tables from the source SAP Retail or SAP S/4HANA system to your back-end system.
**Note**

If you have already replicated the relevant tables in the Create/Replicate Source Master Data System Tables [page 49] procedure, you can skip this procedure.

The steps outlined in this procedure are required when you are implementing one of the system landscape variants that require data to be replicated from a source SAP Retail or SAP S/4HANA system. If your source SAP Retail or SAP S/4HANA system and your back-end system are co-deployed on the same SAP HANA database, proceed to the next procedure. For more information, see System Landscape Variants.

**Procedure**

1. Ensure that you have created an SAP Client and specified the required Customizing settings as described in Set Up SAP Client [page 47].

2. Specify which SAP Retail or SAP S/4HANA tables to replicate using information from one of the two following sources:
   - SAP Note 2385706, for installations based on the SAP_ECC schema
   - SAP Note 2388669, for installations based on the SAP_S4H schema

   For more information, see:

**Caution**

This procedure includes the replication of tables from your source SAP Retail or SAP S/4HANA system. Trigger-based replication includes deletion in source tables by archiving activities (since on the database level it is impossible to distinguish between delete actions caused by archiving and regular deletion of data records). As a result, SAP LT (Landscape Transformation) Replication Server replicates archiving activities as delete actions in the SAP HANA database.

More specifically, when data is archived in your source SAP Retail or SAP S/4HANA system, records are deleted from their respective database tables. Therefore, when these tables are replicated to another SAP HANA database, the records that were archived in the source tables are deleted in the target database tables.

When deciding on the frequency at which to archive data in the source SAP Retail or SAP S/4HANA system, you must consider and balance the performance requirements of your SAP Retail or SAP S/4HANA system and the amount of historical data that should be replicated to and available in your back-end system.
6.2.4.7 Load Product Attributes into SAP Assortment Planning for Retail

Use

SAP Assortment Planning for Retail allows you to view product attributes imported from SAP Retail or SAP S/4HANA. To enable this functionality, you must first run reports that import product characteristics (attributes), as well as their assignments to products, defined in SAP Retail or SAP S/4HANA.

Procedure

1. Log on to your back-end system.
2. Navigate to SAP Customizing Implementation Guide ➤ Cross-Application Components ➤ Assortment Planning for Retail ➤ Imported Demand Data Foundation Settings ➤ Data Maintenance ➤ Attributes and ensure that you have specified all the required entries in the following Customizing activities:
   ○ Define Function Types
   ○ Maintain Number Range for Attributes
   ○ Maintain Number Range for Attribute Values
   If necessary, provide custom implementations for the BAdIs listed in this Customizing node, for example, to import additional attributes or values.
   ○ BAdI: Support Assignment of User-Defined Attribute Types
   ○ BAdI: Manage Attributes and Function Types
   ○ BAdI: Extraction of Location Attributes
3. Ensure that you have implemented SAP Note 2197010.
4. Run reports /DMF/ATR_IMPORT and /DMF/PROD_ATR_IMPORT (transaction SE38).

More Information

For more information, see Periodic Tasks section of the SAP Assortment Planning for Retail Administrator’s Guide.

6.2.4.8 Load Merchandise Planning Data

Use

Merchandise planning data, can be used by the SAP Assortment Planning for Retail application to help set planning targets. To access merchandise plan data in SAP Assortment Planning for Retail, this data must first be imported into the DDF module in your back-end system.
By default, SAP Assortment Planning for Retail is configured to consume merchandise planning data from SAP Merchandise Planning for Retail, another consuming application of SAP Customer Activity Repository.

If you are using the SAP Planning for Retail, rapid-deployment solution for merchandise planning, KPIs (including planned sales, open orders, and purchase quantities) are stored in SAP Business Warehouse (SAP BW) InfoProviders. To access these figures from SAP Assortment Planning for Retail, this data must first be imported from the SAP BW system to your back-end system, as described in SAP Note 2208191.

**Procedure**

To consume merchandise planning data from the SAP Merchandise Planning for Retail application, do the following:

1. Verify that in the Define SAP BW Application for Merchandise Planning Customizing activity, under Cross-Application Components Assortment Planning for Retail Imported Demand Data Foundation Settings Integration, the default settings are applied as follows:
   - Destination: LOCAL
     If this field is empty, the application assumes that the InfoProvider exists in the back-end system, which is the case if SAP Assortment Planning for Retail and SAP Merchandise Planning for Retail are installed on the same back-end system.
   - InfoProvider: /RAP/MPRC01
2. Remaining in the Define SAP BW Application for Merchandise Planning Customizing activity, specify the same Fiscal Year Variant as the one maintained under Cross-Application Components Assortment Planning for Retail Maintain fiscal year variant.
3. Verify that in the Define Field Mapping for Merchandise Planning Customizing activity, also under Cross-Application Components Assortment Planning for Retail Imported Demand Data Foundation Settings Integration, the default settings for field-mapping to the SAP Merchandise Planning for Retail InfoProvider are maintained.
4. Set up the SAP BW to Merchandise Plan Interface report (/DMF/BI_IF_MERCH_PLAN in transaction SE38) to run as a background job to regularly import any updates from SAP Merchandise Planning for Retail to DDF.

**More Information**

- [http://help.sap.com/bicontent](http://help.sap.com/bicontent) &lt;your release&gt; SAP Library BI Content &amp; BI Content Extensions BI Content Industry Solutions Trading Industries Retail Trade Merchandise and Assortment Planning Retail Planning MultiProvider Merchandise Retail Plan
- [http://service.sap.com](http://service.sap.com) Products SAP Rapid Deployment Solutions (RDS) A-Z Index P SAP Planning for Retail rapid-deployment solution
6.2.5 Run the Validation Report

1. Run transaction /DMF/VAL_CAR_INSTALL. Alternatively, run transaction SE38 and execute the /DMF/VALIDATE_CAR_INSTALLATION report.
2. Select the Assortment Planning scenario and select Execute. Running this report allows you verify the success of the installation, providing a log of potential issues. For example, you may be presented with the following results:

![Validation Report Results](image)

Figure 18: Validation Report Results

View the long text associated with each message to see the link to the documentation describing the procedure you need to troubleshoot.

6.2.6 Configure Front-End

6.2.6.1 Configure SAP Gateway

6.2.6.1.1 Perform General SAP Gateway Configuration

Use

Prior to connecting the SAP Gateway on your front-end server to your back-end system, you need to perform a series of general SAP Gateway configuration steps. These configuration steps include the setting of profile parameters, ICF (Internet Communication Framework) services, language settings, and so on.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation referenced below.
Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
   ○ SAP Gateway for SAP NetWeaver 7.31
   ○ SAP Gateway for SAP NetWeaver 7.40
   ○ SAP Gateway for SAP NetWeaver 7.50

6.2.6.1.2 Connect SAP Gateway to Your Back-End System

Use

In this procedure, you configure the OData Channel, that is, set up a connection between SAP Gateway on your front-end server and your back-end system.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation referenced below.

Procedure

1. Set up the required roles on the front-end server and assign your user to these roles.
   For more information, see http://help.sap.com/nw75 Application Help Function-Oriented View SAP Gateway Foundation (SAP_GWFND) SAP Gateway Foundation Configuration User, Developer and Administrator Roles.
2. Specify the connection settings on the SAP Gateway hub system, which include:
   ○ Connection from the SAP Gateway to consumer systems
     These settings allow the connection between the SAP Gateway host and the consumer systems (clients from which you access the SAP Fiori user interfaces).
   ○ Connection from the SAP Gateway to SAP back-end system
     These settings allow the connection between SAP Gateway to your back-end system.
     These settings include:
     ○ Creating a type 3 connection from the SAP Gateway host to your back-end system.
     ○ Defining a trust relationship between your back-end system and the SAP Gateway host.
     ○ Configuring your back-end system to accept SAP assertion tickets from the SAP Gateway host.
○ Configuring your SAP Gateway host to accept SAP assertion tickets from your back-end system.
○ Configuring the necessary system aliases.

More Information

For SAP NetWeaver 7.31, see SAP Library for SAP NetWeaver Gateway on SAP Help Portal at http://help.sap.com/nwgateway20

○ Application Help ➤ Support Package Stack ➤ SAP NetWeaver Gateway Configuration Guide ➤ OData Channel Configuration ➤ Connection Settings on the SAP NetWeaver Gateway Hub System

For SAP NetWeaver 7.4, see SAP Library for SAP NetWeaver on SAP Help Portal at http://help.sap.com/nw74

‖ Application Help ➤ Function-Oriented View ➤ SAP NetWeaver Gateway Foundation (SAP_GWFND) ➤ SAP NetWeaver Gateway Foundation Configuration Guide ➤ SAP Gateway Configuration ➤ Connection Settings for the SAP Gateway Hub System

For SAP NetWeaver 7.5, see SAP Library for SAP NetWeaver on SAP Help Portal at http://help.sap.com/nw75

‖ Application Help ➤ Function-Oriented View ➤ SAP Gateway Foundation (SAP_GWFND) ➤ SAP Gateway Foundation Configuration Guide ➤ SAP Gateway Configuration ➤ Connection Settings for the SAP Gateway Hub System

6.2.6.1.3 Activate SAP Gateway

Use

Before you can use SAP Gateway functionality, you have to activate it globally on your front-end server.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation referenced below.

Procedure

1. Determine the SAP NetWeaver version of your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
   ○ SAP Gateway for SAP NetWeaver 7.31
   ○ SAP Gateway for SAP NetWeaver 7.4
6.2.6.1.4 Activate Common OData Services

Use

A number of OData services are required to run the SAP Fiori launchpad. These OData services are delivered as part of the SAP Fiori front-end server. For more information, see the Prerequisites section in this guide.

For security reasons, all OData services are delivered in an inactive state. To use the SAP Fiori launchpad, you must activate the common SAP Fiori OData services.

Procedure

1. Log on to your front-end system (your SAP Gateway system).
2. Go to Customizing (transaction SPRO).
3. Navigate to 
   SAP NetWeaver ➤ Gateway ➤ OData Channel ➤ Administration ➤ General Settings ➤ Activate and Maintain Services.
   You are presented with the service catalog. This is a list of all the services that are currently active on your SAP Gateway.
4. Get common SAP Fiori OData services:
   1. Choose Add Service.
      The Add Service screen is displayed.
   2. Enter the system alias of your local front-end system.
      This is the alias created in the Connect SAP NetWeaver Gateway to your Back-End System [page 115] procedure. For example, LOCAL.
   3. Enter /UI2* in the Technical Service Name field.
      The Add Selected Services screen is displayed.
   5. Select the common SAP Fiori OData services that you would like to activate, and choose Add Selected Services.

Table 41:

<table>
<thead>
<tr>
<th>Service Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>/UI2/PAGE_BUILDER_CONF</td>
</tr>
<tr>
<td>/UI2/PAGE_BUILDER_CUST</td>
</tr>
</tbody>
</table>
The selected OData services are now active in your SAP Gateway.

More Information


6.2.6.2 Configure Index Calculation

Use

The SAPUI5 application index provides an indexing and caching mechanism for information related to SAPUI5 apps, components, and libraries that are contained in SAPUI5 repositories on the SAP NetWeaver Application Server for ABAP. This index, calculated by the Calculation of SAPUI5 Application Index for SAPUI5 Repositories report ([UI5/APP_INDEX_CALCULATE](http://help.sap.com/nw74)), makes it possible to retrieve and find this information significantly faster than when carrying out the calculations each time it’s requested.

We recommend that you schedule the Calculation of SAPUI5 Application Index for SAPUI5 Repositories report as to run as a background job on your front-end server.

Following any changes to the content of the SAPUI5 ABAP repository (for example, installation of a new version of the SAPUI5 distribution layer or implementation of an SAP Note containing changes to an SAPUI5 app), the SAPUI5 application index should be updated using the calculation report. This report has to be executed in every system whenever the content of the SAPUI5 ABAP repository has changed.
Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
   - SAP Gateway for SAP NetWeaver 7.31
   - SAP Gateway for SAP NetWeaver 7.40
     http://help.sap.com/nw74 Application Help UI Technologies in SAP NetWeaver with SAP_UI 740 SAPUI5: UI Development Toolkit for HTML5 Using the SAPUI5 Repository SAPUI5 Application Index Alternatively, you can launch the Calculation of SAPUI5 Application Index for SAPUI5 Repositories report (/UI5/APP_INDEX_CALCULATE) from Customizing under SAP NetWeaver UI Technologies SAP Fiori Initial Setup Schedule SAPUI5 Application Index Calculation
   - SAP Gateway for SAP NetWeaver 7.50
     http://help.sap.com/nw75 Application Help UI Technologies in SAP NetWeaver with SAP_UI 750 SAPUI5: UI Development Toolkit for HTML5 Developing Apps The SAPUI5 ABAP Repository and the ABAP Back-End Infrastructure SAPUI5 Application Index

6.2.6.3 Configure Central SAP Fiori UI Component

Use

The central SAP Fiori UI component (delivered as part of the SAP Fiori front-end server) contains the SAPUI5 control library and the SAP Fiori launchpad. Prior to being able to use the SAP Fiori apps that constitute the user interface of the retail applications described in this guide, you may need to configure the SAP Fiori launchpad.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation referenced below.

For more information, see the Prerequisites section in this guide.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
   - SAP Gateway for SAP NetWeaver 7.31
     http://help.sap.com/nw-uiaddon20 Application Help SAP Fiori Launchpad and
6.2.6.4 Activate SAP Assortment Planning for Retail OData Services

Use

A number of OData services are required to run the SAP Assortment Planning for Retail application.

For security reasons, all OData services are delivered in an inactive state. You must activate these application-specific OData services to use the SAP Fiori user interface of the SAP Assortment Planning for Retail application.

Procedure

1. Log on to your front-end system (your SAP NetWeaver system).
2. Go to Customizing (transaction SPRO).
3. Navigate to SAP NetWeaver Gateway OData Channel Administration General Settings Activate and Maintain Services. You are presented with the service catalog. This is a list of all the services that are currently active on your SAP Gateway.
4. Get SAP Assortment Planning for Retail OData services:
   1. Choose Add Service. The Add Service screen is displayed.
   2. Enter the system alias of your back-end system. This is the alias created for your back-end system in the Connect SAP NetWeaver Gateway to your Back-End System [page 115] procedure. For example RAPCLNT100.
   3. Enter /DMF* in the Technical Service Name field.
   4. Choose Get Services. The Add Selected Services screen is displayed.
5. Select the SAP Assortment Planning for Retail OData services you would like to activate, and choose Add Selected Services.

Table 42:

<table>
<thead>
<tr>
<th>OData Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>/DMF/CURRENCY_LIST_SRV</td>
</tr>
<tr>
<td>/DMF/LOCATION_CLUSTERSET_SRV</td>
</tr>
<tr>
<td>/DMF/MODULE_MANAGEMENT_SRV</td>
</tr>
<tr>
<td>/DMF/OBJ_ATTRIBUTE_SRV</td>
</tr>
<tr>
<td>/DMF/SEARCH_LOCATIONS_SRV</td>
</tr>
<tr>
<td>/DMF/SEARCH_PRODUCTS_SRV</td>
</tr>
<tr>
<td>/DMF/SEASONS_SRV</td>
</tr>
<tr>
<td>/DMF/MASTER_DATA_SRV</td>
</tr>
</tbody>
</table>

The selected OData services are now active in your SAP Gateway.

6. Enter /RAP* in the Technical Service Name field.

7. Choose Get Services.

The Add Selected Services screen is displayed.

8. Select the SAP Assortment Planning for Retail OData services you would like to activate, and choose Add Selected Services.

Table 43:

<table>
<thead>
<tr>
<th>OData Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>/RAP/ASSORTMENT_LIST_SRV/</td>
</tr>
<tr>
<td>/RAP/OPTION_PLAN_SRV</td>
</tr>
<tr>
<td>/RAP/PHP_MATCH_SRV</td>
</tr>
<tr>
<td>/RAP/VALIDITY_PERIOD_SRV</td>
</tr>
</tbody>
</table>

The selected OData services are now active in your SAP Gateway.

More Information

For SAP NetWeaver 7.31, see SAP Library for User Interface Add-On 1.0 on SAP Help Portal at http://help.sap.com/nw-uiaddon20 Application Help » SAP Fiori Launchpad Setting Up the Launchpad Activating SAP Gateway OData Services ».
6.2.6.5 Activate SAP Assortment Planning for Retail ICF Services

Use

For security reasons, all Internet Communication Framework (ICF) services relevant to your SAP Assortment Planning for Retail application are made available in an inactive state.

You have activated the central ICF services in the Perform General SAP NetWeaver Gateway Configuration [page 114] and Configure Central UI Component [page 119] procedures. This procedure provides the instructions to activate ICF services required for the SAP Assortment Planning for Retail SAP Fiori apps.

Procedure

1. Log on to your front-end server.
2. Open service maintenance (transaction SICF).
3. In the Maintain Service screen, select the Location Clustering service by specifying the following:
   ○ Hierarchy Type: SERVICE
   ○ Virtual Host: DEFAULT_HOST
   ○ Service Path: /sap/bc/ui5_ui5/sap/locclsts_v2/
4. Choose Execute.
5. To activate the service, choose Service/host Activate.
6. Repeat steps 3 to 5 to ensure that all of the following services are activated:
   ○ /sap/bc/ui5_ui5/sap/attribmgmt_v2/
   ○ /sap/bc/ui5_ui5/sap/assortlist/
   ○ /sap/bc/ui5_ui5/sap/ddfreuse_v2/
   ○ /sap/bc/ui5_ui5/sap/locclsts_v2/
   ○ /sap/bc/ui5_ui5/sap/modulemgmt_v2/
   ○ /sap/bc/ui5_ui5/sap/optionplan_v2/
   ○ /sap/bc/ui5_ui5/sap/phpmatch_v2/
6.2.6.6 Define System Alias for Back-End Transactions

Use

A number of SAP Assortment Planning for Retail SAP Fiori apps, installed on your front-end system, launch transactions directly on the back-end system. For example, the Manage Products tile actually launches the Demand Data Foundation (DDF) POWL_EASY WebDynpro application.

To enable this behavior, you need to create a dedicated RFC connection between the front-end and the back-end systems.

Procedure

1. Log on to your front-end system, that is, the system where you have installed the user interface (UI) components of the SAP Assortment Planning for Retail application.
2. Launch Configuration of RFC Connections (transaction SM59).
3. Create an RFC connection with the RFC Destination set to SAP_ISR_CARAB and Connection Type set to H (HTTP connection).
   Ensure to maintain all of the settings required to connect to your back-end system, in particular, the Target Host entry on the Technical Settings tab.
4. Create another RFC connection with the RFC Destination set to SAP_ERP_ISR_CARAB and Connection Type set to H (HTTP connection).
   Ensure to maintain all of the settings required to connect to your front-end system to the SAP Retail or SAP S/4HANA system, in particular, the Target Host entry on the Technical Settings tab.
5. Save your changes.
6. Open Launchpad Customizing (transaction LPD_CUST).
7. Select the SAP Assortment Planning for Retail role (UIRAP001), and choose Display.
   The two catalogs, Assortment Planner and Planning Administrator, are displayed.
8. In each of the catalogs, selecting one app at a time, make the following settings:

<table>
<thead>
<tr>
<th>Catalog</th>
<th>App</th>
<th>System Alias</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assortment Planner</td>
<td>View Log</td>
<td>SAP_ISR_CARAB</td>
<td>This setting allows the My Assortment Plans (Version 2) app to launch transaction SLG1 on the back-end system.</td>
</tr>
</tbody>
</table>

Note

This application is only used to configure a link to the back-end system; you do not need to add this app to your SAP Fiori launchpad.
<table>
<thead>
<tr>
<th>Catalog</th>
<th>App</th>
<th>System Alias</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View ExtAssort Listing Conditions</td>
<td><a href="#">View ExtAssort Listing Conditions</a></td>
<td>SAP_ERP_ISR_CARAB</td>
<td>This setting allows the My Assortment Plans (Version 2) app to launch transaction <strong>WSL10</strong> on the connected SAP Retail or SAP S/4HANA system.</td>
</tr>
<tr>
<td>View External Assortments</td>
<td><a href="#">View External Assortments</a></td>
<td>SAP_ERP_ISR_CARAB</td>
<td>This setting allows the My Assortment Plans (Version 2) app to launch transaction <strong>WRF_WSOA3</strong> on the connected SAP Retail or SAP S/4HANA system.</td>
</tr>
<tr>
<td>Assortment Planner</td>
<td>Manage Category responsibilities <a href="#">Manage Category responsibilities</a></td>
<td>SAP_ISR_CARAB</td>
<td>This setting allows the Manage Category Responsibilities app to launch the corresponding DDF WebDynpro application.</td>
</tr>
<tr>
<td></td>
<td>Manage Products <a href="#">Manage Products</a></td>
<td>SAP_ISR_CARAB</td>
<td>This setting allows the Manage Products app to launch the corresponding DDF WebDynpro application.</td>
</tr>
<tr>
<td></td>
<td>Manage Locations <a href="#">Manage Locations</a></td>
<td>SAP_ISR_CARAB</td>
<td>This setting allows the Manage Locations app to launch the corresponding DDF WebDynpro application.</td>
</tr>
</tbody>
</table>

### 6.2.6.7 Assign Roles, Catalogs, and Groups in SAP Fiori Launchpad

**Use**

To be able to access SAP Fiori apps that constitute the SAP Assortment Planning for Retail user interface from the SAP Fiori launchpad, your front-end system user must have the necessary roles assigned. Based on the role(s) assigned to your user, you can access certain business catalogs and business catalog groups.
Your SAP Assortment Planning for Retail application is delivered with two predefined roles, catalogs, and groups. These include technical content as well as business content:

Table 45:

<table>
<thead>
<tr>
<th>Front-End Server Business Content</th>
<th>Front-End Technical Content</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Business Role</strong></td>
<td><strong>Business Catalog</strong></td>
</tr>
<tr>
<td>SAP_RAP_BCR_AP_PLANNER</td>
<td>SAP_RAP_BC_AP_PLANNER</td>
</tr>
<tr>
<td>SAP_RAP_BCR_PLANNING_ADMIN</td>
<td>SAP_RAP_BC_PLANNING_ADMIN</td>
</tr>
</tbody>
</table>

To test the installation of SAP Assortment Planning for Retail from the SAP Fiori launchpad, you need to assign the roles above to your user on the front-end system.

### Procedure

1. Log on to your front-end system.
2. Launch User Maintenance (transaction SU01).
3. Enter your user name in the User field and choose Change.
4. On the Roles tab, assign the roles SAP_RAP_BCR_AP_PLANNER and SAP_RAP_BCR_PLANNING_ADMIN to your user.

⚠️ Caution

If you already have an SAP Fiori launchpad open, you must clear your browser cache to apply any modifications made to your user roles. Otherwise, your changes will not be reflected in the SAP Fiori user interface.

### More Information

Security Information section of the SAP Assortment Planning for Retail Administrator’s Guide.

### 6.2.7 Configure SAP Jam (Optional)

#### Use

Your retail application uses collaboration SAP UI5 components to define key ABAP-based SAP business object data that can be consumed by the SAP Jam social collaboration platform.
If you are using SAP Jam, you can configure the integration between your retail application and SAP Jam. The integration, enabled by Social Media Integration, allows you to share, or expose, the pre-defined ABAP-based SAP business object data directly from your retail application with members of your organization, through SAP Jam.

The steps to enable the integration between your retail application and SAP Jam are not specific to this guide and are described in the User Interface Add-On 1.0 for SAP NetWeaver product documentation referenced below.

Prerequisites

To enable the integration of your retail application with SAP Jam, you must have a license for SAP Jam Collaboration, enterprise edition, and your SAP Jam instance must be configured for productive use.

Procedure

1. Read the documentation for the user interface add-on available on SAP Help Portal at [http://help.sap.com/netweaver](http://help.sap.com/netweaver) > User interface add-on 1.0 for SAP NetWeaver > Application Help > Social Media Integration. This documentation provides important information on configuring the integration of your retail application with SAP Jam, including the following sections:
   - About SAP Jam Integration
   - Understanding the Overall Process for Integrating Collaboration for a Business Object
   - Implementation of ABAP Social Media Integration (ABAP SMI)
   - Implementation of Collaboration Components
   - Connecting to SAP Jam with ABAP SMI
   - Configuring ABAP SMI for SAP Fiori Apps

More Information


6.3 SAP Customer Activity Repository

The following diagram depicts the post-installation process for SAP Customer Activity Repository 2.0.
Figure 19: Post-Installation Workflow for SAP Customer Activity Repository
6.3.1 Configure SAP Smart Business for Multichannel Sales Analytics (Optional)

6.3.1.1 Install the SAP Smart Business Modeler Apps Framework

The SAP Smart Business for Multichannel Sales Analytics apps included in this installation are based on the SAP Smart Business Modeler Apps Framework. Installation and setup of this framework includes the following:

- Installation of SAP Smart Business Modeler apps on the front-end server
- Installation of SAP Smart Business products on the SAP HANA Server
- Installation of SAP Web Dispatcher
- Communication channels
- App implementation

For more information on these topics, see [http://help.sap.com/nw-uiaddon](http://help.sap.com/nw-uiaddon) <your release> Application Help SAPUI5: UI Development Toolkit for HTML5 SAPUI5 Application Frameworks SAP Smart Business Setting up the SAP Smart Business Modeler Apps Framework.

**Note**

If you are installing User Interface Add-On 2.0 for SAP NetWeaver, you must download and install add-on object UISAFND1100 as described in SAP Note [2183947](http://help.sap.com/nw-uiaddon).

6.3.1.2 Install SAP HANA Live for SAP ERP

This section describes how to install SAP HANA Live under different implementation conditions:

- If you are implementing a deployment option that requires data to be replicated from a source SAP ERP system, see Deployment Scenario: SAP Customer Activity Repository Standalone or Co-Deployed with SAP BW [page 129].
- If you are implementing a deployment option in which your source SAP ERP system and SAP Customer Activity Repository are co-deployed on the same SAP HANA database, see Deployment Scenario: SAP Customer Activity Repository Co-Deployed with SAP ERP [page 130].

For more information, see System Landscape Variants.
6.3.1.2.1 Deployment Scenario: SAP Customer Activity Repository Standalone or Co-Deployed with SAP BW

Use

SAP Smart Business for Multichannel Sales Analytics requires that SAP HANA Live for SAP ERP is installed, configured, and connected to the same SAP HANA database that you plan to use for SAP Customer Activity Repository.

For more information on installing SAP HANA Live for SAP ERP, see http://help.sap.com/hba Installation, Security, Configuration, and Operations Information > Administrator’s Guide.

⚠️ Caution

SAP Customer Activity Repository does not require that you execute all of the installation steps exactly as they are described in the Administrator’s Guide, SAP HANA Live for SAP Business Suite. Prior to executing steps that describe the creation and replication of SAP ERP tables, be sure to read the additional instructions for SAP Customer Activity Repository provided in this guide.

Process

1. Ensure that the SAP Landscape Transformation component (SAP LT Replication Server) is installed.
2. Configure access from the SAP LT Replication Server to the source SAP ERP system (RFC connection) and from SAP LT Replication Server to the target SAP HANA database.
   For more information, see:
3. Ensure that your back-end system is connected to SAP HANA studio.
   If necessary, set the connection as follows:
   1. Log on to SAP HANA studio.
   2. Right-click in the Navigator pane and select Add System.
   3. Enter the required information the Specify System dialog:
      - Host Name
      - Instance Number
      - System Description
   4. Specify your system User Name and Password in the Connection Properties dialog.
4. Ensure that a database catalog schema is created on the target SAP HANA database. This is the schema on your SAP HANA database to which the SAP ERP data will be replicated.
For more information, see:

  Installation, Security, Configuration, and Operations Information
  Administrator’s Guide
  Pre-Installation Steps

- http://help.sap.com/hana_platform
  Development and Modeling
  SAP HANA Developer Guide
  Setting up the Persistence Model
  Creating the Persistence Model with HDBTable
  Creating a Schema

5. Map the authoring schema of the sap.hba.ecc content package to your particular physical database schema, described in the previous step. If the physical database schema to which the SAP ERP data will be replicated is already called SAP_ECC, this schema mapping is not required.

<table>
<thead>
<tr>
<th>Authoring Schema</th>
<th>Physical Schema</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP_ECC</td>
<td>&lt;Name of Your Schema for Storing SAP ERP Data&gt;</td>
</tr>
</tbody>
</table>

For more information, see:

  Installation, Security, Configuration, and Operations Information
  Administrator’s Guide
  Pre-Installation Steps

- http://help.sap.com/hana_platform
  Development and Modeling
  SAP HANA Modeling Guide
  Importing Table Definitions and Data
  Map Authoring Schema to the Physical Schema

6. Create the tables that are required by SAP HANA Live for ERP views on the target SAP HANA database using the instructions provided in SAP Note 1799313. The tables that are required to be created are listed in the following SAP Notes:

- 1782065
- 1781992

The creation of the tables on the target SAP HANA database is required so that the content package of SAP HANA Live for ERP can be deployed and activated correctly.

⚠️ Caution

You must not replicate any data to these tables at this point. Data replication is performed during post-installation.

7. Deploy the SAP HANA Live for ERP content package on the SAP HANA database.

For more information, see http://help.sap.com/hba
Installation, Security, Configuration, and Operations Information
Administrator’s Guide
Pre-Installation Steps

6.3.1.2.2 Deployment Scenario: SAP Customer Activity Repository Co-Deployed with SAP ERP

Use

SAP Customer Activity Repository requires that SAP HANA Live for SAP ERP is installed, configured and connected to the same SAP HANA database that you plan to use for SAP Customer Activity Repository.

⚠️ **Caution**

SAP Customer Activity Repository does not require that you execute all of the installation steps exactly as they are described in the *Administrator’s Guide, SAP HANA Live for SAP Business Suite*. Be sure to read the additional instructions for SAP Customer Activity Repository provided in this guide.

**Process**

1. Ensure that your back-end system is connected to SAP HANA studio. If necessary, set the connection as follows:
   1. Log on to SAP HANA studio.
   2. Right-click in the *Navigator* pane and select *Add System*.
   3. Enter the required information in the *Specify System* dialog:
      - Host Name
      - Instance Number
      - System Description
   4. Specify your system *User Name* and *Password* in the *Connection Properties* dialog.

2. Map the authoring schema of the `sap.hba.ecc` content package to your particular physical database schema. If the physical database schema is already called `SAP_ECC`, this schema mapping is not required.

   Table 47:
   
<table>
<thead>
<tr>
<th>Authoring Schema</th>
<th>Physical Schema</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP_ECC</td>
<td>&lt;Name of Your Schema for Storing SAP ERP Data&gt;</td>
</tr>
</tbody>
</table>

   For more information, see:

3. Ensure that all the standard SAP ERP tables listed in SAP Notes 1782065 and 1781992 are present on your SAP HANA database.
   The presence of these tables on the SAP HANA database is required so that the content package of SAP HANA Live for ERP can be deployed and activated correctly.

4. Deploy the SAP HANA Live for ERP content package on the SAP HANA database.
6.3.1.3  Configure SAP NetWeaver Gateway

6.3.1.3.1  Perform General SAP Gateway Configuration

Use

Prior to connecting the SAP Gateway on your front-end server to your back-end system, you need to perform a series of general SAP Gateway configuration steps. These configuration steps include the setting of profile parameters, ICF (Internet Communication Framework) services, language settings, and so on. These steps are not specific to this guide and are described in the SAP NetWeaver product documentation referenced below.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
   ○ SAP Gateway for SAP NetWeaver 7.31
     See [http://help.sap.com/nw20][1] [Application Help] [SAP NetWeaver Gateway Configuration Guide] [Basic Configuration Settings]
   ○ SAP Gateway for SAP NetWeaver 7.40
     See [http://help.sap.com/nw74][2] [Application Help] [Function-Oriented View] [SAP NetWeaver Gateway Foundation (SAP_GWFND)] [SAP NetWeaver Gateway Foundation Configuration Guide] [General Configuration Settings]
   ○ SAP Gateway for SAP NetWeaver 7.50
     See [http://help.sap.com/nw75][3] [Application Help] [Function-Oriented View] [SAP Gateway Foundation (SAP_GWFND)] [SAP Gateway Foundation Configuration Guide] [General Configuration Settings]

6.3.1.3.2  Connect SAP Gateway to Your Back-End System

Use

In this procedure, you configure the OData Channel, that is, set up a connection between SAP Gateway on your front-end server and your back-end system.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation referenced below.
Procedure

1. Set up the required roles on the front-end server and assign your user to these roles.
   

2. Specify the connection settings on the SAP Gateway hub system, which include:

   ▪ Connection from the SAP Gateway to consumer systems
     These settings allow the connection between the SAP Gateway host and the consumer systems (clients from which you access the SAP Fiori user interfaces).

   ▪ Connection from the SAP Gateway to SAP back-end system
     These settings allow the connection between SAP Gateway to your back-end system. These settings include:
       ▪ Creating a type 3 connection from the SAP Gateway host to your back-end system.
       ▪ Defining a trust relationship between your back-end system and the SAP Gateway host.
       ▪ Configuring your back-end system to accept SAP assertion tickets from the SAP Gateway host.
       ▪ Configuring your SAP Gateway host to accept SAP assertion tickets from your back-end system.
       ▪ Configuring the necessary system aliases.

More Information


6.3.1.3.3 Activate SAP Gateway

Use

Before you can use SAP Gateway functionality, you have to activate it globally on your front-end server.
These steps are not specific to this guide and are described in the SAP NetWeaver product documentation referenced below.

**Procedure**

1. Determine the SAP NetWeaver version of your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
   - SAP Gateway for SAP NetWeaver 7.31
   - SAP Gateway for SAP NetWeaver 7.4
   - SAP Gateway for SAP NetWeaver 7.5

### 6.3.1.3.4 Activate Common OData Services

**Use**

A number of OData services are required to run the SAP Fiori launchpad. These OData services are delivered as part of the SAP Fiori front-end server. For more information, see the Prerequisites section in this guide.

For security reasons, all OData services are delivered in an inactive state. To use the SAP Fiori launchpad, you must activate the common SAP Fiori OData services.

**Procedure**

1. Log on to your front-end system (your SAP Gateway system).
2. Go to Customizing (transaction SPRO).
3. Navigate to SAP NetWeaver Gateway OData Channel Administration General Settings Activate and Maintain Services.
   - You are presented with the service catalog. This is a list of all the services that are currently active on your SAP Gateway.
4. Get common SAP Fiori OData services:
   - Choose Add Service.
The Add Service screen is displayed.

2. Enter the system alias of your local front-end system.
   This is the alias created in the Connect SAP NetWeaver Gateway to your Back-End System [page 115] procedure. For example, LOCAL.

3. Enter /UI2* in the Technical Service Name field.

   The Add Selected Services screen is displayed.

5. Select the common SAP Fiori OData services that you would like to activate, and choose Add Selected Services.

   Table 48:
<table>
<thead>
<tr>
<th>Service Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>/UI2/PAGE_BUILDER_CONF</td>
</tr>
<tr>
<td>/UI2/PAGE_BUILDER_CUST</td>
</tr>
<tr>
<td>/UI2/PAGE_BUILDER_PERS</td>
</tr>
<tr>
<td>/UI2/TRANSPORT</td>
</tr>
<tr>
<td>/UI2/INTEROP</td>
</tr>
</tbody>
</table>

   The selected OData services are now active in your SAP Gateway.

More Information

- For SAP NetWeaver 7.4, see the documentation on SAP Help Portal at http://help.sap.com/nw74 ➤ Application Help ➤ UI Technologies in SAP NetWeaver with SAP_UI 740 ➤ SAP Fiori Launchpad ➤ Setting Up the Launchpad ➤ Activating SAP Gateway OData Services.
- For SAP NetWeaver 7.5, see the documentation on SAP Help Portal at http://help.sap.com/nw75 ➤ Application Help ➤ UI Technologies in SAP NetWeaver with SAP_UI 750 ➤ SAP Fiori Launchpad ➤ Setting Up the Launchpad ➤ Activating SAP Gateway OData Services.

6.3.1.4 Configure the SAP Web Dispatcher

If you use any other reverse proxy, see the manufacturer’s documentation for more information.

6.3.1.5 Configure Central SAP Fiori UI Component

Use

The central SAP Fiori UI component (delivered as part of the SAP Fiori front-end server) contains the SAPUI5 control library and the SAP Fiori launchpad. Prior to being able to use the SAP Fiori apps that constitute the user interface of the retail applications described in this guide, you may need to configure the SAP Fiori launchpad.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation referenced below.

For more information, see the Prerequisites section in this guide.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
   - SAP Gateway for SAP NetWeaver 7.31
   - SAP Gateway for SAP NetWeaver 7.40
     - [http://help.sap.com/nw74](http://help.sap.com/nw74) Application Help ➤ UI Technologies in SAP NetWeaver with SAP_UI 740 ➤ SAP Fiori Launchpad, and
     - [http://help.sap.com/nw74](http://help.sap.com/nw74) Application Help ➤ UI Technologies in SAP NetWeaver with SAP_UI 740 ➤ SAP NetWeaver User Interface Services ➤ Configuration and Operations ➤ Content Administration ➤ SAP Fiori Launchpad ➤ Setting Up the SAP Fiori Launch Page
   - SAP Gateway for SAP NetWeaver 7.50
     - [http://help.sap.com/nw75](http://help.sap.com/nw75) Application Help ➤ UI Technologies in SAP NetWeaver with SAP_UI 750 ➤ SAP Fiori Launchpad, and
     - [http://help.sap.com/nw75](http://help.sap.com/nw75) Application Help ➤ UI Technologies in SAP NetWeaver with SAP_UI 750 ➤ SAP NetWeaver User Interface Services ➤ Configuration and Operations ➤ Content Administration ➤ SAP Fiori Launchpad ➤ Setting Up the SAP Fiori Launch Page
6.3.1.6 Configure SAP Jam (Optional)

Use

Your retail application uses collaboration SAP UI5 components to define key ABAP-based SAP business object data that can be consumed by the SAP Jam social collaboration platform.

If you are using SAP Jam, you can configure the integration between your retail application and SAP Jam. The integration, enabled by Social Media Integration, allows you to share, or expose, the pre-defined ABAP-based SAP business object data directly from your retail application with members of your organization, through SAP Jam.

The steps to enable the integration between your retail application and SAP Jam are not specific to this guide and are described in the User Interface Add-On 1.0 for SAP NetWeaver product documentation referenced below.

Prerequisites

To enable the integration of your retail application with SAP Jam, you must have a license for SAP Jam Collaboration, enterprise edition, and your SAP Jam instance must be configured for productive use.

Procedure

1. Read the documentation for the user interface add-on available on SAP Help Portal at http://help.sap.com/netweaver/User interface add-on 1.0 for SAP NetWeaver Application Help Social Media Integration. This documentation provides important information on configuring the integration of your retail application with SAP Jam, including the following sections:
   ○ About SAP Jam Integration
   Sections under Information for Administrators:
   ○ Understanding the Overall Process for Integrating Collaboration for a Business Object
   ○ Implementation of ABAP Social Media Integration (ABAP SMI)
   ○ Implementation of Collaboration Components
   ○ Connecting to SAP Jam with ABAP SMI
   ○ Configuring ABAP SMI for SAP Fiori Apps

More Information

- For the latest updates on SAP Jam, see SAP Help Portal at http://help.sap.com/sapjam.
- For configuration and maintenance information for SAP Jam, see http://help.sap.com/sapjam SAP Jam Collaboration System Administration Information Administrator Guide.
6.3.2 Activate SAP HANA Content

Use

In this procedure, you activate all SAP HANA Transport for ABAP (HTA) content required in your implementation scenario. For each SAP HANA content package, there is one HTA object.

This activation report can be run as many times as your implementation scenario requires.

Example

- You can run this report during your initial implementation which includes only the SAP Business Suite on HANA and SAP Customer Activity Repository.
- Later on in the lifecycle of your implementation project, you can run this report again when you add Assortment Planning as a new business scenario and integration of customer data with SAP Hybris Marketing.
- When you upgrade your support package stack in the future and decide to migrate your source master data system from SAP Business Suite on SAP HANA to SAP S/4HANA, you can run this report yet again.

Prerequisites

- You have implemented the following mandatory SAP Notes for the activation report: 2388066, 2390790, and 2392194.
- You have successfully completed all of the procedures listed in the previous sections of this guide.
- You have created all the necessary tables, as described in Create/Replicate Source Master Data System Tables.
- If you want to use UDF forecasting in your scenario, you must first set up the required roles and privileges as described in Authorization Requirements for Unified Demand Forecast. This ensures that the HTA content for UDF can be activated correctly. Additionally, you must select the Business Scenarios Activation Forecasting option in the activation report.

Procedure

1. In your back-end system, start transaction SE38.
2. Enter /CAR/ACTIVATE_HTA and choose Execute.
3. Select all applicable source master data systems, business scenarios, and external systems for which you wish to activate HTA content.
4. Optionally, choose the Perform Prerequisite Check option to validate the processing and read the system log prior to applying any database changes.
5. Choose Execute.
6.3.3 Generate Time Data

Use

In this procedure, you generate time data that is required by time-dependent views included in SAP HANA content for SAP Customer Activity Repository. In particular, time data is required for all query views that are based on one of the Sales Analysis virtual data models.

⚠️ Caution

If you are not using the time-dependent views provided in SAP HANA content for SAP Customer Activity Repository, you do not need to execute this procedure.

For example, if you are using SAP Assortment Planning for Retail, you use the time objects `OFISCPER` (fiscal year period) and `OFISCVARNT` (fiscal year variant) provided as part of the technical BI Content. For more information, see Activate Technical Content [page 86] and Maintain Fiscal Year Variant [page 97].

Procedure

1. Log on to SAP HANA studio.
2. In the Modeler perspective, on the Quick Launch tab, select your SAP Customer Activity Repository system and choose Generate Time Data.
3. Select the Calendar Type.
   SAP HANA views included in SAP HANA content for SAP Customer Activity Repository require the presence of time data in `_SYS_BI.TIME DIMENSION` SAP HANA database tables. To populate these tables, select Gregorian as the Calendar Type.
   The Fiscal Calendar Type is not recommended. For analytical reports on a particular fiscal period, the SAP HANA views included in SAP HANA content for SAP Customer Activity Repository do not rely on the `_SYS_BI.M_FISCAL CALENDAR` SAP HANA database tables. Instead, SAP HANA content for SAP Customer Activity Repository uses the `sap.hba.ecc/Fiscal*` views for fiscal period-based reporting.
4. Enter a range of years that includes all the years of data that you plan to store in SAP Customer Activity Repository.

**Example**

If you plan to start using SAP Customer Activity Repository on January 1, 2014, enter 2014 as your starting year. But if you plan to access sales documents created in SAP ERP that date from January 2013, you should specify 2013 as your starting year.

5. Define the granularity as **Day**, which is the minimum granularity required by SAP Customer Activity Repository. You can choose a finer level of granularity, for example **Hour**, if necessary.

6. Choose the day that is the first day of the week in your company.

7. Choose **Generate**.

For more information, see:


### 6.3.4 Configure On-Shelf Availability (Optional)

**Note**

The steps in this section and all subsections are entirely **optional** and depend on your specific implementation requirements.

Note that configuration of the On-Shelf Availability module is mandatory if you want to generate intraday forecasts. For more information about this feature, see [http://help.sap.com/car](http://help.sap.com/car) > Application Help > SAP Customer Activity Repository > Unified Demand Forecast > General Services > Generate Intraday Forecasts.

On-Shelf Availability (OSA) has its own database schema on the SAP HANA Platform (SAPOSA). To use the OSA functionality in SAP Customer Activity Repository, perform the following post-installation steps.
6.3.4.1 Generate Run IDs for OSA Processing Steps

Use

Each scheduled run of an OSA processing step has a generated run ID. This is the unique identification for a job. The run ID is used to distinguish several runs within one period. Each processing step has its own ID generator:

Table 49:

<table>
<thead>
<tr>
<th>Processing step</th>
<th>Transaction for the Generator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intraweek Pattern</td>
<td>/OSA/NR_IWP</td>
</tr>
<tr>
<td>Estimation</td>
<td>/OSA/NR_EST</td>
</tr>
<tr>
<td>Monitoring</td>
<td>/OSA/NR_MON</td>
</tr>
<tr>
<td>Analysis</td>
<td>/OSA/NR_ANA</td>
</tr>
</tbody>
</table>

For each of the four transactions, you must define the range of run IDs.

Procedure

1. Execute transaction /OSA/NR_<XXX>. <XXX> represents the part of the transaction name that is specific for a processing step.
2. In the first row of the table, enter the following values for the fields No, From No., and To Number:
   ○ No: 01
   ○ From No.: 0000000000000001
   ○ To Number: 9999999999999999

6.3.4.2 Check Field Contents in SAP HANA Content for On-Shelf Availability

Use

There are two OSA-specific SAP HANA views that can be customized:

- AN_TRANSACTION
- PROMOTION_TRANS

You have to check if the fields in these views contain the mappings or formulas you need.
Caution

If you need to modify any of the views, be aware, that new installation will rewrite the modifications. It is therefore recommended to back up the modified views.

Procedure

If you want to change the mapping or a formula of a field, perform the following steps:

1. Define the data foundation that is the source for the view, that is, the table /POSDW/TLOGF.
2. Define filters for the view.
3. Map the fields from source to target.
4. Create measures and calculation fields.

For detailed information, see [Development and Modeling](http://help.sap.com/hana_appliance)

Definitions for a view taking the example of the AN_TRANSACTION view

The following definitions are set by default for the AN_TRANSACTION view:

- **Source of the view** is the table /POSDW/TLOGF
- **Examples of filters for the views:**
  - RECORDQUALIFIER = '5': Only sales records are used
  - DATASTATUS in ('2', '3'): Only those records are used which passed the SAP Customer Activity Repository validation
  - RETAILQUANTITY > 0.0: Negative quantities are not used by On-Shelf Availability
  - VOIDEDLINE = ' ': Cancelled transactions are not used by On-Shelf Availability
- **Examples of the fields mappings:**
  - MANDT: Client id. This field is mapped to the MANDT column of the /POSDW/TLOGF table.
  - STORE_ID: Store id. This field is mapped to the RETAILSTOREID column of the /POSDW/TLOGF table.
  - BUSINESSDAYDATE: Business day. This field is mapped to the BUSINESSDAYDATE column of the /POSDW/TLOGF table.
- **Examples of measures:**
  - RETAILQUANTITY: Amount of sold units. Refers to the SALESUOM (Sales Unit of Measure) field that is also defined in the /POSDW/TLOGF table. Contains the value of the RETAILQUANTITY field.
  - PRICE: Price specified in the store currency. Contains the value of the ACTUALUNITPRICE field.
- **Examples of calculated fields:**
  - TRANS_TIME_DBL: Value of the TRANS_TIME output field of type DOUBLE. The format of the transaction time that is stored in BEGINTIMESTAMP and ENDTIMESTAMP is “YYYYMMDDhhmmss”.
  - DISCOUNT: Total relative discount applied on the item. Calculated as (ITEMDISC + DISTDISC) / (RETAILQUANTITY * ACTUALUNITPRICE). If the price is not positive number, 0 is returned.
    - DISTDISC: global discount on the whole purchase; currently not used.
    - ItemDISC: item-specific discount; currently used.
6.3.4.3 Activate SAP HANA Content for On-Shelf Availability

Use

In this procedure, you activate all SAP HANA content required by On-Shelf Availability.

Procedure

1. Log on to your back-end system.
2. Execute transaction SE38.
3. Specify SNHI_NHDU_POST_PROCESS in the Program field and choose Execute.
4. If you are running SAP NetWeaver 7.4 SPS 05 or higher, make the following entries:

   Table 50:
   
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transport Container Name</td>
<td>/OSA/HCO_POSMEXT</td>
</tr>
<tr>
<td>Activate Delivery Unit Content</td>
<td>Select the checkbox.</td>
</tr>
<tr>
<td>Activate HTC</td>
<td>Do not select the checkbox.</td>
</tr>
</tbody>
</table>

5. Choose Execute.

All objects belonging to the delivery unit will be activated in the SAP HANA repository. This process can take several minutes. Once the activation process is complete, you are notified whether or not the import and activation of the SAP HANA delivery unity was successful.

6.3.4.4 Verify that SAP HANA Content for On-Shelf Availability has been activated

1. Log on to SAP HANA studio.
2. Open the Modeler perspective.
3. In the Navigator window, expand the database system for which you have activated the views.
4. Expand the Content folder.
5. Expand the package hierarchy by choosing sap > is > retail > posdmext > osa
6. Verify that the following views have been activated:
   ○ sap.is.retail.posdmext.osa.tlog.an_transaction
   ○ sap.is.retail.posdmext.osa.tlog.promotion_trans
   ○ sap.is.retail.posdmext.osa.status_log_view
   ○ sap.is.retail.posdmext.osa.reporting.MON_ANA_VIEW
   ○ sap.is.retail.posdmext.osa.reporting.STATUS_LOG_VIEW
7. Verify that the following procedures have been activated:

1. Procedures in the package sap.is.retail.posdmext.osa.common:
   - CREATE_LOG_ENTRY
   - PARSE_HOLIDAY_STRING
   - PARSE_TYPE_CODE_STRING

2. Procedures in the package sap.is.retail.posdmext.osa.tlog.dao:
   - GET_TRX_FOR_PRODUCT
   - GET_TRX_FOR_STORE
   - GET_TRX_FOR_SUBDEP
   - GET_TRX_FOR_SUBDEP_WITH_MIN
   - GET_TRX_INFO_FOR_PRODUCT
   - GET_TRX_FOR_SUBDEP_CURRENCY

3. Procedures in the package sap.is.retail.posdmext.osa.pattern.dao:
   - PERSIST
   - GET_INTRA_WEEK_PATTERN_RUNS
   - GET_INTRA_WEEK_PATTERN_LATEST
   - GET_INTRA_WEEK_PATTERN
   - GET_INTRA_WEEK_PATTERN_FOR_PRODUCT

4. Procedures in the package sap.is.retail.posdmext.osa.pattern.runner.internal:
   - CALL_FUNCTION
   - CALL_ALGO_FOR_STORE
   - CALL_ALGO_FOR_SUBDEP
   - CALL_ALGO_PRODUCT_IN_SUBDEP

5. Procedures in the package sap.is.retail.posdmext.osa.pattern.runner.public:
   - RUN_FOR_PRODUCT_IN_SUBDEP
   - RUN_FOR_STORE
   - RUN_FOR_SUBDEP

6. Procedure in the package sap.is.retail.posdmext.osa.pattern.test:
   - TEST_L_INTEGRATION

7. Procedure in the package sap.is.retail.posdmext.osa.estimation.config:
   - GET_CONFIG

8. Procedures in the package sap.is.retail.posdmext.osa.estimation.dao:
   - PERSIST
   - GET_PARAMETER
   - GET_PARAMETERS

9. Procedures in the package sap.is.retail.posdmext.osa.estimation.runner.internal:
   - CALL_FUNCTION
   - CALL_ALGO_PRODUCT_IN_SUBDEP

10. Procedure in the package sap.is.retail.posdmext.osa.estimation.runner.public:
    - RUN_FOR_PRODUCT_IN_SUBDEP

11. Procedure in the package sap.is.retail.posdmext.osa.estimation.test:
    - TEST_L_INTEGRATION
12. Procedures in the package `sap.is.retail.posdmext.osa.monitor.dao`:
   - PERSIST
   - CREATE_STATUS_LOG_ENTRIES
   - UPDATE_STATUS_TABLE
   - CREATE_STATUS_LOG_ENTRIES_FOR_EXCL_PRODUCTS
   - UPDATE_STATUS_TABLE_FOR_EXCL_PRODUCTS

13. Procedures in the package `sap.is.retail.posdmext.osa.monitor.runner.internal`:
   - CALL_FUNCTION
   - CALL_ALGO_PRODUCT_IN_SUBDEP
   - RUN_FOR_PRODUCT_IN_SUBDEP

14. Procedures in the package `sap.is.retail.posdmext.osa.monitor.runner.public`:
   - GET_QUALIFIED_PRODUCT_FOR_RUNNER
   - RUN_MONITOR

15. Procedure in the package `sap.is.retail.posdmext.osa.monitor.test`:
   - TEST_L_INTEGRATION

16. Procedure in the package `sap.is.retail.posdmext.osa.analysis.calc`:
   - COMPUTE_LOST_SALES

17. Procedure in the package `sap.is.retail.posdmext.osa.analysis.dao`:
   - PERSIST

18. Procedures in the package `sap.is.retail.posdmext.osa.analysis.runner.internal`:
   - CALL_FUNCTION
   - CALL_ALGO_PRODUCT_IN_SUBDEP

19. Procedure in the package `sap.is.retail.posdmext.osa.analysis.runner.public`:
   - RUN_FOR_PRODUCT_IN_SUBDEP

6.3.4.5 Configure SAP NetWeaver Gateway and Activate OData Service

Use

This configuration step is only required if you use separate products or developments on top of SAP Customer Activity Repository that communicate via OData service. After you have installed SAP NetWeaver Gateway, configure the Gateway system and configure the settings for OData service.

Procedure

The main steps to do this are as follows:
1. Activate SAP NetWeaver Gateway.
2. Define RFC connections from SAP NetWeaver Gateway to your back-end system.
3. Define settings for OData service for the SAP NetWeaver Gateway.
4. Define settings for Push Functionality (optional).
5. Set up users and Authorizations for SAP NetWeaver Gateway.
6. Activate the OData Service in the SAP NetWeaver Gateway system (transaction /IWFND/maint_service) for the requested URI (for example: /sap/opu/odata/OSA/ON_SHELF_AVAILABILITY/).

For detailed information, see SAP Library for SAP NetWeaver Gateway on SAP Help Portal at http://help.sap.com/nwgateway

6.3.5 Ensure that Third Party CRM Sales Orders are Transferred to SAP ERP (Optional)

Use

Sales documents are accessed by SAP Customer Activity Repository (either through replication or direct data access) from a source SAP ERP system. One way that sales documents of type Sales Order can be generated in a SAP ERP system is through the transfer of sales orders created using an SAP CRM source system or a third party CRM system.

When customers create sales orders using SAP CRM systems, these sales orders are inherently compatible to the sales document structure in SAP ERP. They are transferred to SAP ERP via Data Exchange for Sales Orders: CRM Enterprise - ERP System process. For more information, see SAP Library for SAP CRM on SAP Help Portal at http://help.sap.com/crm. Select the applicable version of SAP CRM and under Application Help, open SAP Library and choose Basic Functions > Business Transaction > Data Exchange for Business Transactions.

Customers who use third party CRM systems to create sales orders, and who want to access these sales orders from SAP Customer Activity Repository, must ensure that their sales order data:

- Includes the information required by SAP Customer Activity Repository
- Has been transferred to SAP ERP prior to being able to access this data from SAP Customer Activity Repository

Procedure

1. Ensure that the fields required by SAP Customer Activity Repository are filled during the transfer of sales order data from your third party CRM system to SAP ERP.
2. Ensure that sales order data has been transferred from your third party CRM system to SAP ERP.
6.3.6 Partition /POSDW/TLOGF Table (Optional)

Use

SAP Customer Activity Repository application contains the Point of Sale Data Management software component version RTLPOSDM 200 which is used to receive a large volume of data from your connected stores. Point of Sale Data Management, or more specifically, its POS Inbound Processing Engine (PIPE), processes the incoming transactions and stores them in the /POSDW/TLOGF table.

Since every transaction line item is stored as a separate row in the /POSDW/TLOGF table, the table can quickly grow to become very large. To improve standard database operations, such as inserting, updating, deleting and reading and mass operations, such as archiving or index merging, SAP recommends that you partition the /POSDW/TLOGF table.

Also, you can select to store extension segments in a dedicated /POSDW/TLOGF_EXT table using the Store Extensions in Separate Table option of the Define General Settings Customizing activity. Table /POSDW/TLOGF_EXT should be partitioned in the same way as the /POSDW/TLOGF table.

For more information on extension segments, see the Appendix of the Operations Guide, SAP Customer Activity Repository.

i Note

Partitioning is typically used in distributed system, but it may also be beneficial for single-host systems.

Procedure

1. Read the Table Partitioning in the SAP HANA Database section of the SAP HANA Administration Guide.
2. Plan your partition specifications in accordance to the following guidelines:
   ○ A single partition should not contain more than 1 billion rows.
   ○ The total amount of partitions of a single table should not exceed 1000.
   ○ Because the actual act of partitioning a table does use system resources, do not start partitioning the /POSDW/TLOGF table until its volume has surpassed 250 million rows.
3. Partition your /POSDW/TLOGF (and, optionally the /POSDW/TLOGF_EXT) table according to SAP Note 1719282.

6.3.7 Customize Copies of SAP HANA Views (Optional)

Use

In this optional procedure, you create copies of views included in SAP HANA Live for SAP ERP or in the SAP HANA content for SAP Customer Activity Repository. You then customize these copies to reflect your specific data model extensions.
Caution

Do not modify standard SAP HANA content.

For example, you would need to execute this procedure if you have extended your POS transaction data model. The views delivered with the SAP HANA content for SAP Customer Activity Repository are built on the standard /POSDW/TLOGF table. If you have added custom fields to the /POSDW/TLOGF table, you will have to create views that expose these fields.

In general, if you have extended any standard SAP data models, you must copy and adapt the standard SAP HANA content.

Caution

If you have created a copy of a view shipped as part of the standard SAP HANA content and have made modifications to this copy, a subsequent upgrade of SAP HANA Live for SAP ERP or SAP HANA content for SAP Customer Activity Repository will not update your copied and modified version of the view. SAP Notes or enhancements shipped by SAP will also have to be manually implemented on the copied, and subsequently modified, SAP HANA content.

Procedure

1. Log on to SAP HANA studio.
2. Open the Modeler and use the Navigator to access the folder that contains the view that you want to copy. For example, <Your System Name> > Content > sap > is > retail > car > Calculation Views.
3. Identify the view you want to copy. For example, sap.is.retail.car/POSSalesQuery.
4. Use the Auto Documentation feature of SAP HANA studio to identify all reuse and private views that are consumed by your selected view, as well as any query views that might consume your view. To do so:
   1. Right-click on the selected view, and choose Auto Documentation from the context menu.
   2. Browse to the location where you want to save the file and choose Finish.
   3. Open the generated *.pdf file, and locate the Cross-References section of the document.
      The Cross-References section displays the hierarchy of calculation (query, reuse, and private) views that are accessed by the selected view. Affected underlying, as well as all consuming views, in this hierarchy must also be copied and modified as a result of your extension.
      For example, calculation views sap.is.retail.car/POSSales, sap.is.retail.car/POSLogItem, and sap.is.retail.car/TLOGF_ITEM_COM are all consuming the /POSDW/ TLOGF table and are consumed by the sap.is.retail.car/POSSalesQuery view. Therefore, if you have extended the /POSDW/TLOGF table, all these views must be copied and modified.
5. For each view identified in the previous step, do the following:
   1. In the Navigator panel, select an object and in the context menu, choose Copy.
   2. Navigate to the package where you want to paste the view and choose Paste.

Note

You must have write permissions on the target package to which you are pasting the view. Also, you should copy the view to your own package. Do not modify the original sap package.
3. Modify the copied view as required. For more information, see the Creating Views section of the SAP HANA Developer Guide.
4. Right-click on the copied and modified view and select Activate.

### 6.3.8 Configure Demand Data Foundation (Optional)

In this procedure, you configure the DDF module in SAP Customer Activity Repository as required for your scenario.

#### Required Configuration

**Caution**

The implementation and configuration of DDF is mandatory for the following scenarios:

- You want to model and forecast demand using the UDF module in SAP Customer Activity Repository. For information about setting up UDF, see Configure Unified Demand Forecast (Optional) [page 154].
- You want to use the Omnichannel Promotion Pricing module in SAP Customer Activity Repository. For more information, see Configure Omnichannel Promotion Pricing for Use with SAP Customer Activity Repository [page 166].
- You want to use SAP Allocation Management for Retail.
- You want to use SAP Assortment Planning for Retail.
- You want to use SAP Merchandise Planning for Retail.
- You want to use SAP Promotion Management for Retail.

See the Common Master Guide for additional configurations and integration information. You can find this guide on SAP Help Portal at [http://help.sap.com/car<your release> Installation and Upgrade Information Master Guide](#). For more information, see the following:

- [http://help.sap.com/car<your release> Application Help Demand Data Foundation Integration Information Master Data Replication from SAP ERP to Demand Data Foundation](#)
- [SAP Customer Activity Repository Administration Guide, sections Configuring Demand Data Foundation (DDF), Configuring Data Replication from SAP ERP to DDF, and Configuring DDF Integration Scenarios](#)

#### Prerequisites

You have consulted SAP Note 2379029. This is the Release Information Note (RIN) for SAP Customer Activity Repository 3.0. It provides up-to-date information on the current release, together with a list of important SAP Notes that you must apply to complete the installation process.
6.3.8.1 Activate Business Functions for DDF and UDF

In this procedure, you activate the business functions for DDF and UDF that are relevant for your scenario.

Use

Note

As of SAP Customer Activity Repository 2.0 FP3, most of the existing business functions have been set to obsolete. You no longer need to activate them to be able to use the Demand Data Foundation (DDF) and Unified Demand Forecast (UDF) modules in SAP Customer Activity Repository. There is now only 1 recommended business function for DDF, and 2 required business functions for UDF. Nothing will happen if you activate any of the obsolete business functions by accident. The new, simpler activation procedure is described in the following.

You must implement DDF in the following scenarios:

- You want to model and forecast demand using UDF.
- You want to use applications residing in the ABAP back-end server that use data acquired and maintained in DDF.

Procedure

1. Check which business functions are relevant for your scenario:
   - For DDF (optional): We recommend that you activate the optional business function Decompression of Lane Price and Time Dependent Data (/DMF/DDF_IMDB_LANE_TD) to benefit from optimized memory usage.
   - For UDF (required): If you want to model and forecast demand with UDF, you must activate the following business functions:
     - Activation of Forecast Engine (/DMF/FORECAST)
     - Activation of Unified Demand Forecast (/DMF/DDF_UDF)

2. Read the following documentation for each business function that you want to activate:
   - Business function description under http://help.sap.com/car<your release> Application Help Demand Data Foundation Business Functions
   - Execute transaction SFW5, select the business function, and follow the instructions under Release Information.

3. Execute transaction SFW5 and activate the business functions that are relevant for your scenario.

Recommendation

- Business functions should be activated by a system administrator.
- Once a business function is active, we recommend that you do not deactivate it.
6.3.8.2 Configure Automatic Flattening of Hierarchies

You need to configure the system so it automatically creates and updates flat structures for the product and location hierarchies in Demand Data Foundation (DDF). The flat structures are required so the consuming applications can correctly recognize the hierarchies.

Context

Flat structures describe the parent-child relationships of hierarchies in a flattened format. A hierarchy can be vertically or horizontally flattened. Each row of the resulting flat structure contains one parent-child relationship.

When you create (or update) a product hierarchy, product group, location hierarchy, or location group in DDF, the system should create (or update) the corresponding flat structure. Without this, you get hierarchy errors in the consuming applications.

To configure the automatic flattening of hierarchies, follow these steps:

Procedure

1. Carefully read SAP Note 1425876 and follow the instructions.
2. Execute transaction SWETYFV and ensure that you have activated all required event type linkages and have enabled the specified event queues. In particular, check that the Linkage Activated and Enable Event Queue options are for each of the following events: LOCATION_CREATED, LOCATION_UPDATED, CREATE_LOC_HIER, CREATE_PROD_HIER. If you need to change a setting, you can do so in the Details screen of each event.

For more information about event handling, see SAP Note 1098805, in particular sections Events and Transactions for troubleshooting.

Results

You have set up the automatic flattening of the hierarchies. Whenever you now create (or update) a hierarchy, the system will automatically run the /DMF/TREE_FLATTENER_PROD_INS report (for product hierarchies) or the /DMF/TREE_FLATTENER_LOC_INS report (for location hierarchies) and create (or update) the corresponding flat structure.
6.3.8.3 Import SAP NetWeaver Portal Roles for DDF

To set up user authorizations for Demand Data Foundation (DDF), you can use the PFCG roles from the SAP NetWeaver Business Client (NWBC) and from the SAP NetWeaver Portal. Both sets of roles operate in the same manner. Using the SAP NetWeaver Portal is optional.

**Use**

The roles have been created for use in SAP NetWeaver Business Client. To use the functions of these roles in SAP NetWeaver Portal, you must upload the roles from the SAP back-end system to the portal. The uploaded objects are converted into portal objects.

**Procedure**

1. Use the Role Upload tool to generate the SAP NetWeaver Portal roles automatically. For more information about this tool, see SAP Note 1685257.
   You can also enhance the SAP NetWeaver Portal roles; for example, you can create your own iViews.
   You can upload the following roles for DDF:
   - SAP_ISR_DDF_MASTER
   - SAP_ISR_DDF_READONLY_MASTER

   For descriptions of these roles and information about maintaining roles in SAP Customer Activity Repository, see Authorizations section in the SAP Customer Activity Repository 3.0 Administration Guide.

6.3.8.4 Enable Time-Dependent Article Hierarchies

**Use**

You can create SAP ERP article hierarchies with different statuses (Active, Disabled, Planned). Time-dependent article hierarchies have status Planned. They only become active during a defined validity period in the future.

If you want to use time-dependent article hierarchies, you must first create them as such in your SAP ERP system. Then in order for the Demand Data Foundation module in your SAP Customer Activity Repository system to recognize a time-dependent hierarchy, you must enable it as described in the following.
Procedure

To enable time-dependent article hierarchies, follow these steps:

1. Make sure that you have implemented the following SAP Notes:
   ○ 2244521
   ○ 2245133
   ○ 2245134

2. In Customizing, activate the time-dependent article hierarchy under Cross-Application Components Demand Data Foundation Data Maintenance Product Hierarchy Control Parameters for Product Hierarchies. For more information, see the Customizing activity documentation (transaction SPRO).

More Information

For more information about replicating data to DDF, see the following:

- http://help.sap.com/car<your release> Application Help Demand Data Foundation Integration Information Master Data Replication from SAP ERP to Demand Data Foundation

For more information about Customizing for article hierarchies in SAP ERP, see the Customizing activities under Logistics - General Article Hierarchy.

6.3.8.5 Check Performance-Related Configuration Options

Use

Depending on your implementation scenario, you have additional configuration options for DDF that allow you to optimize performance.
**Procedure**

Check the following options and implement those that are relevant for your scenario:

<table>
<thead>
<tr>
<th>Use Case</th>
<th>Configuration Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>You have an installation on a multiple-host SAP HANA system.</td>
<td>Consider table partitioning. For more information, see Partition Tables for UDF and DDF (Optional) [page 157].</td>
</tr>
<tr>
<td>You want to use the <em>Sales Projection</em> function in SAP Assortment Planning for Retail and have large data volumes to process.</td>
<td>The function relies heavily on the DDF module. You can optimize performance by implementing SAP Note 2080423.</td>
</tr>
</tbody>
</table>

**More Information**

If you encounter issues during the setup, see the Troubleshooting [page 166] section for possible solutions.

### 6.3.9 Configure Unified Demand Forecast (Optional)

**Note**

The Unified Demand Forecast (UDF) module in SAP Customer Activity Repository supports different implementation scenarios. The steps in this section and all subsections are optional and depend on your specific scenario:

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Implement and Configure UDF</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Promotion Management for Retail</td>
<td>Mandatory (for what-if forecasts)</td>
</tr>
<tr>
<td>SAP Allocation Management for Retail</td>
<td>Optional</td>
</tr>
<tr>
<td>SAP Assortment Planning for Retail</td>
<td></td>
</tr>
<tr>
<td>SAP Merchandise Planning for Retail</td>
<td></td>
</tr>
</tbody>
</table>

To enable the UDF functionality for your scenario, perform the following post-installation steps.
6.3.9.1 Complete UDF Setup

In this procedure, you complete the post-installation tasks for the Unified Demand Forecast module to enable demand modeling and forecasting in SAP Customer Activity Repository.

Prerequisites

- You have installed the SAP RTL AFL FOR SAP HANA software component as described in the following sections:
  - For initial installations: Install SAP Customer Activity Repository Retail Applications Bundle
    Download and Install the Application Function Library (AFL)
  - For upgrade scenarios: Upgrade SAP Customer Activity Repository Retail Applications Bundle
    Download and Install the Application Function Library (AFL)
  - The component includes the application functions for UDF.

- You have consulted SAP Note 2379029. This is the Release Information Note (RIN) for SAP Customer Activity Repository 3.0. It provides up-to-date information on the current release, together with a list of important SAP Notes that you must apply to complete the installation process.

- You have configured DDF as described in Configure Demand Data Foundation (Optional) [page 149].

- You have consulted the Common Master Guide for additional integration and configuration information for DDF and UDF. You can find this guide on SAP Help Portal for SAP Customer Activity Repository at http://help.sap.com/car<your release> Installation and Upgrade Information. In particular, you are aware that different business processes related to DDF and UDF are available for different business scenarios:

<table>
<thead>
<tr>
<th>Business Scenario</th>
<th>Business Process</th>
<th>DDF</th>
<th>UDF</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Customer Activity Repository</td>
<td>Enabling Demand Data Foundation and Creating Demand Forecast</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>SAP Allocation Management for Retail</td>
<td>Enabling Demand Data Foundation</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>SAP Assortment Planning for Retail</td>
<td>Enabling Demand Data Foundation and Creating Demand Forecast</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>SAP Merchandise Planning for Retail</td>
<td>Enabling Demand Data Foundation</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>SAP Promotion Management for Retail</td>
<td>Enabling Demand Data Foundation and Creating Demand Forecast</td>
<td>x</td>
<td>x (required for what-if forecasts)</td>
</tr>
</tbody>
</table>

For more information about these scenarios, see again the Common Master Guide, sections Business Overview and Business Scenarios.
Procedure

Perform Mandatory Configuration Steps

The following steps are mandatory if you want to model and forecast demand with UDF:

1. Set up the users, roles, and privileges for UDF as described in Authorization Requirements for Unified Demand Forecast.

2. If your source master data system is an SAP S/4HANA system, you must implement SAP Note 2376424 to enable UDF for this scenario.

3. Activate the SAP HANA content for SAP Customer Activity Repository as described in Activate SAP HANA Content [page 138].
   In particular, make sure to select the Forecasting business scenario in the activation report.

4. Analyze and implement the following SAP Notes:
   - 1911141: Setting UDF-specific performance optimization parameters in the SAP HANA database
   - 1898341: Configuration changes for demand modeling and forecasting to prevent decomposition errors
   - 2389537: Correction of a data issue in demand modeling

5. Check and, if necessary, change the default setting for how the covariance matrix is generated during modeling.
   In Customizing (transaction SPRO), navigate to Cross-Application Components Demand Data Foundation Modeling and Forecasting Define Modeling Control Settings. Depending on your scenario, you can choose between the “full” covariance matrix (default setting) and the “reduced” covariance matrix:
   
<table>
<thead>
<tr>
<th>Your scenario is...</th>
<th>What to do...</th>
</tr>
</thead>
<tbody>
<tr>
<td>You want to use the forecast confidence index (FCI) functionality in SAP Promotion Management for Retail.</td>
<td>Leave the default setting for all the time series sources. The full covariance matrix is mandatory for the FCI. For more information on how to configure the FCI, see Configuring Unified Demand Forecast.</td>
</tr>
<tr>
<td>○ You want to use SAP Promotion Management for Retail, but without the FCI. ○ You do not want to use SAP Promotion Management for Retail.</td>
<td>For sizing reasons, we strongly recommend that you select the Reduced Covariance Matrix option for all the time series sources.</td>
</tr>
</tbody>
</table>

For more information, see the Customizing activity documentation.

Perform Optional Configuration Steps

You have the following additional options:

1. Analyze the following optional SAP Notes and implement the notes that are relevant for your scenario:
   - 2176058: Performance-related note that you must implement if you want to forecast complex offers (such as Buy X Get Y) in production mode
   - 2161484: Information about an ABAP report that you can use to validate the input data for modeling and forecasting and identify potential issues

2. Set up table partitioning for your scenario.
   For more information, see Partition Tables for UDF and DDF (Optional) [page 157].
3. Set up the generation of intraday forecasts.
   If you want to generate intraday forecasts, you must configure both the UDF module and the OSA module in SAP Customer Activity Repository:
   2. Configure UDF as described here in this guide. At a minimum, you must perform the mandatory configuration steps listed above.
   3. Configure OSA as described in Configure On-Shelf Availability (Optional) [page 140].
   4. Do the Customizing (transaction SPRO) for UDF and OSA that you need for your scenario:
      ○ For UDF, see the activities and their documentation under Cross-Application Components > Demand Data Foundation > Modeling and Forecasting.
      ○ For OSA, see the activities and their documentation under SAP Customer Activity Repository > On-Shelf Availability.
   4. Consult the Configuring Unified Demand Forecast section in the SAP Customer Activity Repository Administration Guide for additional configuration options for UDF features.
   5. Set up forecast visualization with the Analyze Forecast SAP Fiori app:
      This analytical app is provided as part of the SAP FIORI FOR SAP CARAB front-end product version, which you have already installed. To set up forecast visualization with this app, proceed as described in Configure the Analyze Forecast App [page 159].
      For more information about the app, see http://help.sap.com/car <your release> Application Help > SAP Customer Activity Repository > Additional Content > Standalone SAP Fiori Apps for SAP Customer Activity Repository > Analyze Forecast, including all subsections.

More Information

If you encounter issues during the setup, see the Troubleshooting [page 166] section for possible solutions.

6.3.10 Partition Tables for UDF and DDF (Optional)

Use

i Note

This section is only relevant for installations on multiple-host SAP HANA systems.

If you have an installation on a single-host SAP HANA system, you can skip this section.

To forecast consumer demand, you use the Unified Demand Forecast (UDF) and Demand Data Foundation (DDF) modules in SAP Customer Activity Repository. UDF provides the actual modeling and forecasting services. DDF provides the required data layer (for the import, export, and maintenance processes, for example).
If your forecasting scenario involves large numbers of products and locations, the relevant UDF and DDF tables can become very large. To improve standard database operations (such as inserting, updating, deleting, and reading) and mass operations (such as archiving or index merging), we therefore recommend that you set up partitioning for those tables.

As the UDF application functions run directly in the SAP HANA database, much of the partitioning guidance for SAP HANA systems also applies to forecasting scenarios with UDF and DDF. Your main reference, therefore, is the SAP HANA Administration Guide, which you can find under System Administration. Make sure to select the guide for your specific SAP HANA Platform SPS (if necessary, choose Earlier releases in the navigation tree on the left).

Prerequisites

- You have installed and configured UDF and DDF as described in this guide.
- You have the system privileges and object privileges required to perform table partitioning operations. For more information, see the Tile Catalogs for Administration and Monitoring section of the SAP HANA Administration Guide.
- You are aware of the limitations for table partitioning. For more information, see the Partitioning Limits section of the SAP HANA Administration Guide.

Procedure

1. Read sections Table Partitioning and Optimize Table Partitioning of the SAP HANA Administration Guide to learn about the partitioning of SAP HANA systems.
2. Read SAP Note 2190377 to learn which UDF and DDF tables are relevant for partitioning and what partitioning aspects to consider.
3. Partition the tables as described in the note.

Recommendation

To help you with the partitioning decisions, consult the sizing information for your system landscape. For example, check the number of records estimated for the large tables to decide which tables to partition and how many partitions you need.

For more information on system sizing and a sizing questionnaire for SAP Customer Activity Repository, see http://help.sap.com/car (<your release>) Additional Information Sizing.
6.3.11 Configure Standalone SAP Fiori Apps for SAP Customer Activity Repository (Optional)

Note
The steps in this section and all subsections are optional and depend on your specific implementation requirements.

6.3.11.1 Configure the Analyze Forecast App

In this procedure, you perform several implementation tasks on the front-end server and the back-end server to configure the Analyze Forecast SAP Fiori app in SAP Customer Activity Repository. You can use the app to visualize detailed demand modeling and forecasting information for performing in-depth analyses.

Prerequisites

Note
Depending on your implementation scenario, several of the following prerequisites might already be fulfilled in your system landscape.

General Prerequisites
- Front-end server: To determine which version of SAP FIORI FRONT-END SERVER you need, see the prerequisites for this release:
  - For initial installations: Prerequisites section in the Common Installation Guide
  - For upgrade scenarios: Prerequisites section in the Common Upgrade Guide
- SAP Fiori system landscape: You have set up the landscape as described under http://help.sap.com/fiori_implementation
  Required System Landscape → With SAP NetWeaver 7.4 → Setup of SAP Fiori System Landscape with SAP HANA XS
  For system landscape diagrams of supported scenarios, see http://help.sap.com/fiori_bs2013 → General Implementation → Setup of SAP Fiori System Landscape for SAP Business Suite → Setup of SAP Fiori System Landscape for SAP Business Suite with SAP HANA XS
- SAP Fiori launchpad: You have set up the launchpad as described under http://help.sap.com/fiori_implementation
  Configuration Information → With SAP NetWeaver 7.4 → Setup of SAP Fiori Launchpad
  The SAP Fiori launchpad is the access point to apps on desktop or mobile devices. Users can access an app via its corresponding tile on the launchpad. For more information, see http://help.sap.com/fiori_implementation
  Additional Information → SAP Fiori Launchpad
- SAP Fiori launchpad designer: You have set up this administrator tool as described under http://help.sap.com/netweaver
  User interface add-on 2.0 for SAP NetWeaver → Application Help → SAP Fiori
Launchpad ➤ Setting up the Launchpad and Using the Launchpad Designer. In the procedure below, you will later do app-specific configuration settings in the designer.

- SAP NetWeaver Gateway: You have installed and configured the gateway. In particular, make sure that you have done the following:
  - Performed the general SAP Gateway configuration and activated the central Internet Communication Framework (ICF) services (SAP Note 1560585 and Perform General SAP Gateway Configuration [page 114]).
  - You can skip the Connect SAP Gateway to your Back-End System section because the back-end for Analyze Forecast is provided via SAP HANA Extended Application Services (SAP HANA XS).
  - Activated SAP Gateway on your front-end server (Activate SAP Gateway [page 116]).
  - Activated the common OData services so you can use the SAP Fiori launchpad (Activate Common OData Services [page 117]).

- SAP Web Dispatcher: You have configured the dispatcher and set up the routing rules for browser requests as described in the following:
  - Configure the SAP Web Dispatcher [page 135]
  - Section Configuring SAP Web Dispatcher of the Central Implementation Information at http://help.sap.com/saphelp_hba/helpdata/en/5e/9d0c52bcc19b33e10000000a44538d/content.htm (in particular, see step Configure SAP Web Dispatcher for SAP HANA XS)

For a configuration example, see http://help.sap.com/fiori_implementation ➤ Additional Information ➤ SAP Fiori Launchpad ➤ Setting Up the Launchpad ➤ Configuring SAP Web Dispatcher.

- Central SAP Fiori UI component: This component contains the SAPUI5 control library and the SAP Fiori launchpad. You have configured it as described in Configure Central SAP Fiori UI Component [page 119].

- SAP Jam (optional): You have integrated the SAP Jam collaborative environment as described in the following:
  - Configure SAP Jam (Optional) [page 125]

Prerequisites Specific to SAP Customer Activity Repository Retail Applications Bundle

- DDF: You have configured the DDF module as described in Configure Demand Data Foundation (Optional) [page 149].

- UDF: You have configured the UDF module as described in Configure Unified Demand Forecast (Optional) [page 154].

- SAP HANA content: You have activated all SAP HANA content for SAP Customer Activity Repository, as described in Activate SAP HANA Content [page 138].
  - Note that with this step, you have also activated the SAP HANA content for Analyze Forecast. In SAP HANA studio, you can find this content under Content ➤ sap.hba.t.rtl.udf.afc.

- Front-end server: You have installed the server as described in the Install ABAP Front-End Server section of the Common Installation Guide. This installation must include the SAP NetWeaver Gateway, the central SAP Fiori UI component, and the product-specific SAP Fiori UI component.

- As Analyze Forecast is a standalone app, you do not need the SAP Smart Business Modeler Apps Framework.

- You have implemented SAP Note 2372802, which fixes a time zone issue in the app.
Procedure

To configure *Analyze Forecast*, follow these steps:

1. Read the app-specific information on SAP Help Portal for SAP Customer Activity Repository at [http://help.sap.com/car](http://help.sap.com/car) &gt; Application Help &gt; SAP Customer Activity Repository &gt; Additional Content &gt; Standalone SAP Fiori Apps for SAP Customer Activity Repository &gt; Analyze Forecast including all subsections.

2. Configure user access to the SAP HANA data for the app.

**Note**

You can find the general SAP Fiori Help section for this step at [http://help.sap.com/fiori_implementation](http://help.sap.com/fiori_implementation) &gt; App Implementation Information &gt; With SAP NetWeaver 7.4 &gt; App Implementation for Analytical Apps &gt; Configuring Access to SAP HANA Data.

Use this section as your starting point. However, to configure *Analyze Forecast*, you only need to perform a subset of the steps described there. Proceed as follows:

1. Synchronize the SAP HANA database users. Each user requires both a user in the ABAP front-end server (to enable navigation in the SAP Fiori launchpad) and a database user in SAP HANA (to enable access to the relevant views).
   
   Follow the steps in [Configuring Access to SAP HANA Data](http://help.sap.com/fiori_implementation) &gt; Synchronizing SAP HANA Database Users.

2. Assign the app-specific SAP HANA role `sap.hba.t.rtl.udf.afc.roles::AnalyzeForecast.hdbrole` to the users of the app. The role enables them to access the app-specific SAP HANA data to be able to analyze sales and forecast values.
   
   Follow the steps in [Configuring Access to SAP HANA Data](http://help.sap.com/fiori_implementation) &gt; Assigning Roles for Accessing SAP HANA Data.

3. Create the analytic privileges to give the users read-only access to the SAP HANA views for the app. You can find all these views in the `sap.hba.t.rtl.udf.afc.v` folder in your SAP HANA studio. Without the correct analytic privileges, the users only see empty views.
   
   Follow the steps in [Configuring Access to SAP HANA Data](http://help.sap.com/fiori_implementation) &gt; Creating Analytic Privileges.

   For more information about analytic privileges, see the following:


3. Customize the navigation target for the app in the SAP Fiori launchpad on the front-end server.

   In [Launchpad Customizing](http://help.sap.com/fiori_implementation) (transaction **LFD_CUST**), choose **UICAR001 TRANSACTIONAL** &gt; **AnalyzeForecast** and make the following app-specific settings:

   ○ **Link Text**: *AnalyzeForecast*
   
   ○ **Application Type**: URL
   
   ○ **URL**: `/sap/bc/ui5_ui5/sap/analyzfcst_v2`
   
   ○ **Application Alias**: *AnalyzeForecast*
4. Configure the SAP Fiori launchpad designer for **Analyze Forecast**.

1. Launch the SAP Fiori launchpad designer with one of the following URLs:
   - **In CUST mode:**
     ```
     ```
     Use this mode for client-specific configurations, specifying the respective client.
   - **In CONF mode:**
     ```
     ```
     Use this mode for global configurations across all clients. In this URL, you additionally specify the `scope` parameter.

2. Configure the app tile in the SAP Fiori launchpad designer.
   If the tile for **Analyze Forecast** has not yet been created, create it as a static tile using the following settings:
   - **Title:** Analyze Forecast
   - **Icon:** sap-icon://Fiori5/F0812
   - **Use semantic object navigation:** Select this option.
   - **Semantic Object:** ForecastDemand
   - **Action:** showUDFAnalyzeForecast
   - **Parameters:** bk-client=<backend client>
   - Leave the other options empty.


3. Configure the target mapping in the SAP Fiori launchpad designer.
   If the target mapping has not yet been created, choose **Target Mappings** and create a new entry with the following settings:
   - **Semantic Object:** ForecastDemand
   - **Action:** showUDFAnalyzeForecast
   - **Application Type:** SAP Fiori App using LPD_CUST
   - **Launchpad Role:** UICAR001
   - **Launchpad Instance:** TRANSACTIONAL
5. Complete the implementation on the front-end server.

### Note


5. Complete the implementation on the front-end server.

### Note

For more information on how to activate ICF services and OData services, see [Implementation Tasks on Front-End Server: Activate ICF Services of SAPUI5 Application](http://help.sap.com/nw74).

Follow the steps in [Implementation Tasks on Front-End Server ➤ Front-End Server: Activate ICF Services of SAPUI5 Application](http://help.sap.com/nw74).

2. Add the start authorizations for the app-specific OData service (sap.hba.t.rtl.udf.afc.odata::AnalyzeForecast.xsodata) to the role on the front-end server. The users need the start authorizations for the activated OData service to be able to launch the app.

Follow the steps in [Implementation Tasks on Front-End Server ➤ Add Start Authorizations for OData Services to Role on Front-End](http://help.sap.com/nw74).

3. Create the SAP_CAR_TCR_A PFCG role on the front-end and assign the required launchpad catalogs and groups. SAP_CAR_TCR_A is the back-end server authorization role delivered for all analytical apps in SAP Customer Activity Repository.

### Note

If you already have an SAP Fiori launchpad open, you must clear your browser cache to apply any modifications made to your user roles. Otherwise, your changes will not be reflected in the SAP Fiori user interface.

Follow the steps in [Implementation Tasks on Front-End Server ➤ Create PFCG Role on Front-End and Assign Launchpad Catalogs and Groups](http://help.sap.com/nw74).

4. Set up the catalogs, groups, and roles in the SAP Fiori launchpad.

Follow the steps in [Implementation Tasks on Front-End Server ➤ Setup of Catalogs, Groups, and Roles in the SAP Fiori Launchpad](http://help.sap.com/nw74).
5. Take the front-end PFCG role that you have created before and assign it to the users of the app. The role contains the catalogs, groups, and start authorizations for the OData service that the users need. Follow the steps in Implementation Tasks on Front-End Server Front-End Server: Assign Roles to Users.

Result

You have successfully configured the Analyze Forecast app.

More Information

- You can extend the app with custom content. For more information, see http://help.sap.com/car DISPATCH <your release> Application Help Additional Content Standalone SAP Fiori Apps for SAP Customer Activity Repository Analyze Forecast App Extensibility: Analyze Forecast.
- For generic information about implementing SAP Fiori apps, see http://help.sap.com/fiori_implementation.
- If you encounter issues during the implementation, see the Troubleshooting [page 166] section for possible solutions.

6.3.12 Configure Omnichannel Article Availability and Sourcing for Use with SAP Customer Activity Repository (Optional)

You need to integrate SAP Retail, SAP Customer Activity Repository, SAP Hybris Commerce, and SAP Hybris Commerce, integration package for SAP for Retail, as well as set up asynchronous order management and the data replication between SAP Retail and SAP Customer Activity Repository.

6.3.12.1 Set up Data Replication Between SAP Retail and SAP Hybris Commerce

In SAP Retail and SAP Hybris Commerce, set up the asynchronous order management scenario as follows:

1. Set up asynchronous replication of articles via the Data Hub from SAP Retail to SAP Hybris Commerce. For more information, see the documentation for SAP Hybris Commerce at https://help.hybris.com/6.2.0/hcd/8bc6b884866910148532f2e1e500f95f.html Getting Started with SAP ERP Integration. Follow the steps for the asynchronous order management scenario.
2. Set up asynchronous replication of orders via the Data Hub from SAP Hybris Commerce to SAP Retail (see link above).
3. Configure asynchronous order management.
For more information, see the documentation for SAP Hybris Commerce at https://help.hybris.com/6.2.0/hcd/8b8ac51b866910148e68c3be8963eb96.html Configuring Asynchronous Order Management.

6.3.12.2 Set up Data Replication Between SAP Retail and SAP Customer Activity Repository

1. In SAP Retail, create an RFC connection between SAP Retail and SAP Customer Activity Repository (transaction SM59).
2. In SAP Customer Activity Repository, set up SLT replication from SAP Retail to SAP Customer Activity Repository (see SAP Note 2385706).
For OAA, the following tables must be replicated via SLT:
   ○ Tables used directly by OAA:

<table>
<thead>
<tr>
<th>Table</th>
<th>Used for</th>
</tr>
</thead>
<tbody>
<tr>
<td>MARA</td>
<td>Check whether article exists in SAP Customer Activity Repository</td>
</tr>
<tr>
<td>MARM</td>
<td>Quantity conversion (conversion of sales unit into base unit)</td>
</tr>
<tr>
<td>LFA1</td>
<td>Input help for eligible vendors in Customizing of OAA profiles. Used to check whether the vendor exists that was entered as eligible vendor.</td>
</tr>
<tr>
<td>EINA</td>
<td>Input help for eligible vendors in Customizing of OAA profiles. Used to check whether purchasing info records exist for the vendor that was entered as eligible vendor.</td>
</tr>
<tr>
<td>VBAK</td>
<td>Database trigger that updates temporary reservations when a sales order is replicated from SAP Retail to SAP Customer Activity Repository</td>
</tr>
<tr>
<td>T001W</td>
<td>Database trigger that updates temporary reservations when a sales order is replicated from SAP Retail to SAP Customer Activity Repository</td>
</tr>
<tr>
<td>OAA_ATP_PROFILE</td>
<td>Input help for ATP parallelization profile in Customizing of OAA profiles</td>
</tr>
<tr>
<td>VBAP</td>
<td>Calculation of dynamic rough stock indicators</td>
</tr>
<tr>
<td>VBUP</td>
<td>Calculation of dynamic rough stock indicators</td>
</tr>
</tbody>
</table>

   ○ Tables required for Inventory Visibility view

InventoryVisibilityWithSalesOrderReservedQuantity, such as MARD and VBFA
6.3.12.3 Set Up Data Replication Between SAP Hybris Commerce and SAP Customer Activity Repository

1. In SAP Hybris Commerce, in the Backoffice application under SAP Integration > HTTP Destination, create the HTTP destination of SAP Customer Activity Repository that is used for availability calculation and sourcing.

2. In SAP Hybris Commerce, in the Backoffice application under SAP Integration > SAP Global Configuration > Backend Connectivity, enter the HTTP destination of SAP Customer Activity Repository created before.

**Note**

In the standard Solr configuration for products in SAP Hybris Commerce, ProductStoreStockValueProvider is used to replicate the store availability situation from the Hybris database into the Solr index.

If you use OAA, availability information is provided through synchronous calls into SAP Customer Activity Repository for every article/store combination instead. If your product catalog is rather large, this is why indexing the complete product catalog can take very long. In this case, we recommend to either deactivate the value provider or to create a custom one. If you deactivate the value provider, faceted search according to store availability is not possible in the product catalog. OAA functionality is not affected.

6.3.13 Configure Omnichannel Promotion Pricing for Use with SAP Customer Activity Repository

1. In Customizing for SAP Customer Activity Repository, under Omnichannel Promotion Pricing > Configuring Omnichannel Promotion Pricing, activate and configure Omnichannel Promotion Pricing.

2. In transaction SFW5, activate business function MDG_FOUNDATION. This activates Data Replication Framework (DRF) functionality. You need DRF to be able to send regular prices and OPP promotions to an external system via IDocs.

3. To use the central promotion pricing service, you have to install the XS Advanced (XSA) Runtime. For information about the installation of the XS Advanced runtime, see the SAP HANA Server Installation and Update Guide."Installing an SAP HANA System" > "Installing XS Advanced Runtime".

6.3.14 Troubleshooting

**Use**

This section proposes possible solutions to issues that may occur when you install and implement your SAP Customer Activity Repository solution. It also provides guidance on how you can improve the system configuration for specific use cases. If you need to report a customer incident, see the information in the final section.
## Table 56:

<table>
<thead>
<tr>
<th>Areas</th>
<th>Issues</th>
<th>Explanations</th>
<th>Possible Solutions</th>
</tr>
</thead>
</table>
| Installation / Upgrade    | You want to download a revision of software component SAP RTL AFL FOR SAP HANA. | You need the exact download path on the SAP Support Portal at [http://support.sap.com](http://support.sap.com). | - For initial installations: Install SAP Customer Activity Repository Retail Applications Bundle  
- For upgrade scenarios: Upgrade SAP Customer Activity Repository Retail Applications Bundle |
|                           | You get an error indicating that software component SAP RTL AFL FOR SAP HANA is not compatible. | You must install compatible releases ("revisions") of the following:  
- SAP RTL AFL FOR SAP HANA  
- SAP HANA AFL  
- SAP HANA database | - For initial installations: Install SAP Customer Activity Repository Retail Applications Bundle  
- For upgrade scenarios: Upgrade SAP Customer Activity Repository Retail Applications Bundle |
|                           | You want to know what AFL components are installed and active in your SAP HANA database. | For example, you want to check if an AFL component was installed or upgraded correctly. | SAP Note [2188129](http://support.sap.com) |
|                           | You want to install or upgrade an application function library (such as SAP RTL AFL FOR SAP HANA) and are experiencing issues with the SAP HANA Lifecycle Management tool (hdblcm or hdblcmgui). | You need information on possible causes and solutions. | - SAP Note [2078425](http://support.sap.com)  
- SAP Note [2082466](http://support.sap.com)  
- See the SAP HANA Server Installation and Update Guide for your SAP HANA Platform SPS. You can find this guide on SAP Help Portal under `<your SPS>` > Installation and Update > |
<p>|                           | You get syntax errors when installing the CAR RETAIL APPL BUNDLE back-end product version. | You need guidance on whether to take action. The answer depends on your implementation scenario. | SAP Note <a href="http://support.sap.com">2089829</a> |
|                           | You get an import error when installing the RTLAPPS software component of the CAR RETAIL APPL BUNDLE back-end product version. | A program error must be fixed. | SAP Note <a href="http://support.sap.com">2377525</a> |</p>
<table>
<thead>
<tr>
<th>Areas</th>
<th>Issues</th>
<th>Explanations</th>
<th>Possible Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You get the error <code>SAP DBTech JDBC: [258]: insufficient privilege: Not authorized.</code></td>
<td>You are using software component <code>SAP HANA AFL 1.0</code> and have performed an upgrade of your SAP HANA Platform. Previously assigned privileges might have been lost during the upgrade.</td>
<td>SAP Note 2022080</td>
</tr>
<tr>
<td></td>
<td>In an upgrade or when implementing a transport, you get one of the following errors:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Retcode 512: SQL-error “259: invalid table name: Could not find table/view</td>
<td>An issue in the SAP HANA content must be fixed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Retcode 512: SQL-error “328: invalid name of function or procedure</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>In an upgrade, you get the following error when running program <code>RUTDDLSCREATE</code>:</td>
<td>An issue that affects CDS views must be fixed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 ETW678X start export of <code>R3TRDLS &lt;CDS Viewname&gt;</code> ...</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3WETW000 DDL &lt;CDS Viewname&gt; is not activated.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2EETW190 “DDLS” &lt;CDS Viewname&gt; has no active version.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 ETW679 end export of <code>R3TRDLS &lt;CDS Viewname&gt;</code>.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SAP HANA content</td>
<td>You want to check the dependencies of a specific view.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>You want to check the dependencies of a specific view.</td>
<td>You might need this information to solve a dependency or activation issue.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>You might need this information to solve a dependency or activation issue.</td>
<td>• In SAP HANA studio: Select the view and choose <code>Auto Documentation</code> from the context menu. This generates a file with detailed information on the view. Consult the <code>Cross References</code> section.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you are using the SAP HANA Live View Browser app: Select the view and choose <code>Cross References</code>.</td>
<td></td>
</tr>
<tr>
<td>Areas</td>
<td>Issues</td>
<td>Explanations</td>
<td>Possible Solutions</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
|                       | You get an error indicating that you are attempting to access in-active or invalid SAP HANA content. | You have not installed software component SAP RTL AFL FOR SAP HANA. This component contains back-end functionality for the Unified Demand Forecast module and the On-Shelf Availability module. Even if you don’t intend to use those modules, you must install the component. | ● For initial installations: Install SAP Customer Activity Repository Retail Applications Bundle. Download and Install the Application Function Library (AFL).  
● For upgrade scenarios: Upgrade SAP Customer Activity Repository Retail Applications Bundle. Download and Install the Application Function Library (AFL). |
|                       |                                                                        | You are trying to activate the SAP HANA content using the wrong SAP Note.     | Follow the steps in Activate SAP HANA Content [page 138].                          |
|                       | You get the error **Table ABAP:/DMF_ORG_ASSIGN not found.**            | A program error must be fixed.                                                | ● SAP Note 2218875  
● SAP Note 2224582                                                             |
<p>|                       | You get the error <strong>Object DDF_ORG_ASSIGN (Calculation View), package sap.is.ddf.udf.data_validation, was processed with errors.</strong> | A program error must be fixed.                                                | SAP Note 2224582                                                             |
|                       |                                                                        | You get the error <strong>SQLScript: Could not derive table type for variable &quot;UDF_FC_HORIZON&quot;.</strong> | A program error must be fixed.                                                | SAP Note 2125672                                                             |
|                       |                                                                        | SAP HANA view sap.is.ddf.fms does not activate properly.                     | A program error must be fixed.                                                | SAP Note 2203930                                                             |
|                       | You want to use omnichannel promotion pricing but cannot install the SAP HANA XS advanced (XSA) runtime in your SAP Customer Activity Repository system. | You cannot install XSA as long as SAP HANA dynamic tiering is active on the same host. | SAP Note 2388443                                                             |</p>
<table>
<thead>
<tr>
<th>Areas</th>
<th>Issues</th>
<th>Explanations</th>
<th>Possible Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customizing</td>
<td>You cannot see the Customizing activities for Unified Demand Forecast (UDF) in the SAP Customizing Implementation Guide (transaction SPRO). Either the activities are not displayed at all or you see different activities. When you try to display the correct activities by activating business functions in the Switch Framework (transaction SFW5), you get an error.</td>
<td>You might not have activated all required business functions for UDF.</td>
<td>Activate Business Functions for DDF and UDF [page 150]</td>
</tr>
<tr>
<td>Hierarchies</td>
<td>You get errors when creating or updating location hierarchies and/or product hierarchies.</td>
<td>The system does not generate the flat structures for the hierarchies. You need to do some configuration steps so that the hierarchies get flattened automatically.</td>
<td>• Follow the steps in Configure Automatic Flattening of Hierarchies [page 151]. • Consult the following sections in the SAP Customer Activity Repository Administration Guide: ○ Configuring Demand Data Foundation (DDF) ○ Configuring Data Replication from SAP ERP to DDF</td>
</tr>
<tr>
<td></td>
<td>You get errors when importing article hierarchies from your master data system.</td>
<td>A program error must be fixed.</td>
<td>• SAP Note 2244521 • SAP Note 2245134</td>
</tr>
<tr>
<td></td>
<td>You want to know which locations are included in each version of an offer.</td>
<td>You can implement an easy enhancement for table /DMF/GFR_LG_LOC.</td>
<td>SAP Note 2208619</td>
</tr>
<tr>
<td></td>
<td>An error occurs for a DDL SQL view when you execute the CREATE VIEW statement.</td>
<td>A program error must be fixed.</td>
<td>SAP Note 2377525</td>
</tr>
<tr>
<td>Areas</td>
<td>Issues</td>
<td>Explanations</td>
<td>Possible Solutions</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| Modeling and forecasting | You get the error 905 Structured Query Language (SQL) exception detected: &1&2&3&4. | An SQL error must be fixed.                       | Use the system log (transaction SM21) to find the underlying SQL exception:  
  ● To help find the correct log entries, specify the user and the approximate time frame.  
  ● Look for entries with the same error as in this message.  
  ● Note that the log may span several lines. This is indicated by a red priority icon and an initial “>”.  
  ● Attempt to determine the root cause and a corrective action based on the message texts of the applicable log entries. |
|                          | You get the errors 901 Failed execution for &1 and 926 Failed decomposition. | You most likely have a data issue, such as:  
  ● The load balancing settings are not correct.  
  ● Or there are no active product locations. | • See the message long texts (transaction SE91).  
  • SAP Note 1898341 |
<p>|                          | You get the errors 901 Failed execution for &amp;1 and 905 Structured Query Language (SQL) exception: &amp;1&amp;2&amp;3&amp;4 and 926 Failed decomposition. | You most likely have an SQLScript error.          | See the message long texts (transaction SE91). |
|                          | You get the error Could not execute 'call _SYS_AFL... or the error Repository: Internal error during statement execution... | The privileges for calling application function libraries (AFLs) are not assigned correctly or are incomplete. | SAP Note 1846194 |</p>
<table>
<thead>
<tr>
<th>Areas</th>
<th>Issues</th>
<th>Explanations</th>
<th>Possible Solutions</th>
</tr>
</thead>
</table>
| You get one of the following errors during modeling or forecasting: | ● 1341 Procedure versions validation failed: Procedure version is not matched with given version number #  
● 1341 Procedure versions validation failed: Version validation is not enabled for this procedure | An SAP HANA version check might be out of sync.                              | ● Try running the failed modeling or forecasting process again several times. This allows the SAP HANA version management to synchronize the versions. If the error occurred during modeling, also run forecasting again.  
● SAP Note 1972414 (for development experts) |
| You want to forecast complex offers (such as Buy X Get Y). | You must set up a specific task decomposition to run production forecasts with the Unified Demand Forecast (UDF) module. |                                                                              | SAP Note 2176058                                                                    |
| You are using the Update Sales Projection function in SAP Assortment Planning for Retail (workbooks Product Planning and Size Planning). You are experiencing performance issues when using the function with large data volumes. | You can enhance the performance by implementing an SAP Note.               |                                                                              | SAP Note 2080423                                                                    |
| DRF data replication framework (transaction DRFOUT) | You have deleted a vendor from the /DMF/D_VENDOR table but this deletion is not replicated to the master data system. | A program error must be fixed.                                               | SAP Note 1872136                                                                    |
| You get an error when using the DRF with the PMPL SAP ERP outbound implementation. | A program error must be fixed.                                        |                                                                              | ● SAP Note 1904782  
● SAP Note 2167629  
● See the application help for SAP Customer Activity Repository at http://help.sap.com/car/<your release> Application Help  
Demand Data Foundation  
Integration Information  
Master Data Replication from SAP ERP to Demand Data Foundation |
<table>
<thead>
<tr>
<th>Areas</th>
<th>Issues</th>
<th>Explanations</th>
<th>Possible Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance</td>
<td>You are experiencing performance issues in your SAP HANA database.</td>
<td>You need information on how to troubleshoot and resolve those issues and how to enhance performance in general.</td>
<td>See the SAP HANA Troubleshooting and Performance Analysis Guide under <a href="http://help.sap.com/hana_platform/">http://help.sap.com/hana_platform/</a>&lt;your SAP HANA SPS&gt; System Administration</td>
</tr>
<tr>
<td></td>
<td>You get a runtime error or exit message and need information about possible causes and solutions.</td>
<td>Different causes are possible.</td>
<td>Use the ABAP dump analysis (transaction ST22) to search for short dumps and call up detailed error information.</td>
</tr>
<tr>
<td>Remote Function Calls (RFCs), function modules</td>
<td>You are experiencing workflow issues when executing an RFC function module.</td>
<td>Different causes are possible.</td>
<td>SAP Note 1098805 (detailed troubleshooting information for different causes, tips &amp; tricks)</td>
</tr>
<tr>
<td></td>
<td>You have changed the listing information in your master data system and replicated the changes to your SAP Customer Activity Repository system. However, the listing information there is not updated correctly.</td>
<td>A program error must be fixed.</td>
<td>SAP Note 1932525</td>
</tr>
<tr>
<td></td>
<td>You get the error Product &amp;1, location &amp;2: The Valid From time for &amp;3 must be 00:00:00 (message 364 in message class /DMF/MSG_HL).</td>
<td>A program error must be fixed.</td>
<td>SAP Note 2163602</td>
</tr>
</tbody>
</table>

Common Installation Guide CARAB 2.0
Post-Installation

CUSTOMER 173
<table>
<thead>
<tr>
<th>Areas</th>
<th>Issues</th>
<th>Explanations</th>
<th>Possible Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Fiori</td>
<td>You cannot open the <em>Analyze Forecast</em> app in your SAP Fiori launchpad.</td>
<td>The back-end reuse library might not be loading correctly.</td>
<td>You can do the following in the back-end system:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. In transaction <strong>SICF</strong>, search for the <code>/sap/bc/ui5_ui5/sap/ddfreuse_v2</code> service and check that it is active.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. If the service is active, reset the SAP Fiori cache:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>In transaction <strong>SE38</strong>, execute the following reports: /UI5/APP_INDEX_CALCULATE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>and /UI2/INVALIDATE_GLOBAL_CACHES and /UI2/INVALIDATE_CLIENT_CACHES.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Clear your browser cache and check whether you can now open the app.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The machine on which you want to open the <em>Analyze Forecast</em> app is set to a negative time zone offset (such as UTC-7). The app crashes.</td>
<td>A program error must be fixed.</td>
<td><strong>SAP Note</strong> 2372802</td>
</tr>
</tbody>
</table>

### More Information

#### Reporting Customer Incidents

When you report an incident for your installation, you must specify an application component. You can find the component list for SAP Customer Activity Repository on the SAP Support Portal at [http://support.sap.com/swdc](http://support.sap.com/swdc)

**Support Packages and Patches** > **Software Downloads** > **By Alphabetical Index (A-Z)** > **C** > **CAR RETAIL APPLICATIONS BUNDLE** > **CAR RETAIL APPL BUNDLE 2.0** > **Info** > **scroll down to: Customer Support**.

For more information on reporting incidents for SAP Customer Activity Repository, see **Support Desk Management**.

For generic information on reporting incidents or to search the SAP knowledge base for solutions, see the SAP Support Portal at [http://support.sap.com/](http://support.sap.com/) **Knowledge Base & Incidents**.
6.4  SAP Merchandise Planning for Retail

Post-installation of SAP Merchandise Planning for Retail.

**Note**

Some of the activities in this section may have already been performed in the corresponding section under SAP Customer Activity Repository. Such activities do not need to be repeated during the setup and installation of consuming applications.

6.4.1  Configure Demand Data Foundation

6.4.1.1  General Settings

1. Verify Client Administration
   Ensure that you have updated the client details (transaction SCC4).

   **Note**
   
   The currency setting here does not determine the currency used in SAP Merchandise Planning for Retail 1.1. This setting is intended for SAP BW configuration and does not affect the choice of currency one uses for planning.

2. Verify Logical Systems
   Ensure that the following Customizing activities under SAP NetWeaver > Application Server > IDoc Interface / Application Link Enabling (ALE) > Basic Settings > Logical systems are completed:
   1. Define the systems as logical systems
   2. Assign the logical system to your client

6.4.1.2  Configure Demand Data Foundation Steps

**Use**

SAP Merchandise Planning for Retail relies on data maintained in Demand Data Foundation (DDF). There are key DDF configuration steps required to use the SAP Merchandise Planning for Retail application.

**Procedure**

1. Perform the necessary configuration steps in DDF.
SAP Merchandise Planning for Retail uses master data and time series data stored in DDF. Before using the SAP Merchandise Planning for Retail application, you must ensure that DDF is fully configured and operational. For more information, see the configuration document Configuring Demand Data Foundation (DDF).

2. Configure data replication from SAP ERP to DDF.
SAP Merchandise Planning for Retail uses master data (such as product, location, and product hierarchy) as well as organizational data (such as sales organization and distribution channel) that is replicated from SAP ERP to DDF using DRFOUT.
For more information on setting up this data replication, see the following document Configuring Data Replication from SAP ERP to DDF.

6.4.1.3 Import SAP NetWeaver Portal Roles for DDF

To set up user authorizations for Demand Data Foundation (DDF), you can use the PFCG roles from the SAP NetWeaver Business Client (NWBC) and from the SAP NetWeaver Portal. Both sets of roles operate in the same manner. Using the SAP NetWeaver Portal is optional.

Use

The roles have been created for use in SAP NetWeaver Business Client. To use the functions of these roles in SAP NetWeaver Portal, you must upload the roles from the SAP back-end system to the portal. The uploaded objects are converted into portal objects.

Procedure

1. Use the Role Upload tool to generate the SAP NetWeaver Portal roles automatically. For more information about this tool, see SAP Note 1685257. You can also enhance the SAP NetWeaver Portal roles; for example, you can create your own iViews. You can upload the following roles for DDF:
   - SAP_ISR_DDF_MASTER
   - SAP_ISR_DDF_READONLY_MASTER
   - SAP_ISR_DDF_READONLY_MASTER

   For descriptions of these roles and information about maintaining roles in SAP Customer Activity Repository, see Authorizations section in the SAP Customer Activity Repository 3.0 Administration Guide.
6.4.2 Activate SAP Merchandise Planning for Retail Planning Framework Content

The planning framework used by SAP Merchandise Planning for Retail consists of the following elements:

- **Business Intelligence Content (BI Content) Objects**: A collection of local BI Content objects is used as the basis for the SAP BusinessObjects Analysis, edition for Microsoft Office workbooks. SAP BusinessObjects Analysis, edition for Microsoft Office workbooks are designed to consume data from BI Content objects. The local BI Content objects that are provided with the SAP Merchandise Planning for Retail applications use the integrated planning engine in SAP Business Warehouse (SAP BW). These local BI Content objects are used as an interface between the SAP HANA views and the SAP BusinessObjects Analysis, edition for Microsoft Office workbooks.

  **Note**

  The local BI Content provided with the SAP Merchandise Planning for Retail application is entirely independent of the SAP Business Warehouse BI Content and BI Content Extensions add-on. You can use this local BI Content directly in SAP Merchandise Planning for Retail.

- **SAP BusinessObjects Analysis, edition for Microsoft Office Workbooks**: Microsoft Excel-based spreadsheets that you use to plan assortments for the different locations in your retail business.

This section of the guide provides information on the SAP HANA content activation, BI Content activation and configuration, and data upload activities required to set up the SAP Merchandise Planning for Retail planning framework.

6.4.2.1 Activate SAP HANA Content for SAP Merchandise Planning for Retail

**Use**

In this procedure, you perform the final activation of SAP HANA content (views and stored procedures) required by the SAP Merchandise Planning for Retail application. This final activation results in a full activation of the SAP HANA content for SAP Merchandise Planning for Retail. Several SAP HANA views depend on local BI Content objects. The SAP HANA views have to be activated following the activation of these BI Content objects, as described in this procedure.

**Prerequisites**

As a mandatory prerequisite for a successful activation of SAP HANA content for SAP Merchandise Planning for Retail, you must have successfully completed all of the procedures listed in the previous sections of this guide as pertains to SAP Customer Activity Repository. In particular, you must have created all the necessary tables, as described in Create/Replicate Source Master Data System Tables [page 49].
Procedure

1. Ensure that the _SYS_REPO user has the authorizations required to successfully activate SAP HANA content.
   1. Provide user _SYS_REPO with object privilege SELECT, with option "Grantable to others", on the following physical DB schemas:
      ○ Physical database schema of your back-end system, typically this is called SAP<SID>.
      ○ Physical database schema that contains the SAP ERP tables
   You can use the following example SQL statement to grant the required privilege:
   ```sql
   GRANT SELECT ON SCHEMA <Your schema name> TO _SYS_REPO WITH GRANT OPTION;
   ```
   2. Log on to SAP HANA Studio.
   3. Open the Modeler and use the Navigator to access your back-end system.
   4. Expand the Content folder located under your system name in the Navigator.
   5. Expand the package listed below:
      ○ sap.is.retail.rap.mpr
      All the content in the underlying folders should be active.

More Information


6.4.2.2 Activate SAP Merchandise Planning for Retail Local BI Content

Procedure

1. On your back-end system, open the Data Warehousing Workbench (transaction RSA1).
2. In the Replicate Metadata dialog box, choose Only Activate.
3. If a message appears that you are only authorized to work in client. (Brain 009), then refer to SAP Note 316923 (do not import the support package, but use the description under section Workaround).
4. Select Do not show this question Again in the dialog that appears.
5. Choose Yes.
   Make sure that the current job has finished before you proceed with the next step. Check the status of the background job using transaction SM37 or SLG1. If there are problems, you must first solve them.
   You can use transaction RSTCO_ADMIN to restart the activation of the technical content and to verify the status of the activation.
i Note

In the case that you get the short-dump "RAISE_EXCEPTION" when installing InfoObjects from the BI content, see SAP Note 1637935 for a possible solution.

Also, see SAP Note 2090845 for important information on technical content activation.

Following activation, you can locate the technical content in the Data Warehousing Workbench as follows:

1. Selecting *Modeling* in the left-hand frame.
2. Expand *InfoObjects*.
3. In the right-hand frame, locate *Technical Content*.

### 6.4.2.3 Activate Application BI Content

⚠️ Caution

Proper authorization is required to complete these steps.

These instructions include maintenance steps for master data for info objects, /RAP/DSACT and /RAP/COMP as well as to activate content under the *Merchandise, Financial Planning for Retail* (/RAP/MP) InfoArea for the following object types:

- InfoObjects
- InfoCubes
- Composite Providers
- Aggregation levels
- Planning Sequence
- Queries
- Workbooks

The object types must be activated in the order above. Each object type and the detail objects are listed in the tables below.

- Use transaction RSA1 to launch the BW workbench.
- In the navigation window, select push button *BI Content* then choose *Info Objects*. When prompted for *Source System*, do not select any and select OK.
- Locate /RAP/AP. Expand to display: RAP Character InfoObject Catalog and RAP Key Figure InfoObject Catalog. Select the character catalog and drag to the *Collected Objects* window.
- Select *Install* and *Activate*.
- Repeat the previous step for the key figure catalog.

<table>
<thead>
<tr>
<th>InfoObject Description</th>
<th>InfoObject Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOP DC Stock at Cost</td>
<td>/RAP/BDCCV</td>
</tr>
<tr>
<td>InfoObject Description</td>
<td>InfoObject Name</td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Beginning of Period Stock Cost Value</td>
<td>/RAP/BOPCV</td>
</tr>
<tr>
<td>Beginning of Period Stock Units</td>
<td>/RAP/BOPUN</td>
</tr>
<tr>
<td>BOP Store Stock at Cost</td>
<td>/RAP/BSTCV</td>
</tr>
<tr>
<td>Division</td>
<td>/RAP/CDT1</td>
</tr>
<tr>
<td>Department</td>
<td>/RAP/CDT2</td>
</tr>
<tr>
<td>Class</td>
<td>/RAP/CDT3</td>
</tr>
<tr>
<td>Subclass</td>
<td>/RAP/CDT4</td>
</tr>
<tr>
<td>Store Comparability Indicator</td>
<td>/RAP/COMP</td>
</tr>
<tr>
<td>Country</td>
<td>/RAP/CONTRY</td>
</tr>
<tr>
<td>On Order Cost DC</td>
<td>/RAP/DCOCV</td>
</tr>
<tr>
<td>On Order Units DC</td>
<td>/RAP/DCOUN</td>
</tr>
<tr>
<td>Returns at Cost DC</td>
<td>/RAP/DCRECV</td>
</tr>
<tr>
<td>Return Units DC</td>
<td>/RAP/DCREUN</td>
</tr>
<tr>
<td>Sales DC Fulfilled at Cost</td>
<td>/RAP/DCSCV</td>
</tr>
<tr>
<td>DC Sales Units</td>
<td>/RAP/DCSUN</td>
</tr>
<tr>
<td>Distribution Channel</td>
<td>/RAP/DISTC</td>
</tr>
<tr>
<td>DataSlice Activation</td>
<td>/RAP/DSACT</td>
</tr>
<tr>
<td>Sales Direct Fulfilled at Cost</td>
<td>/RAP/DTSCV</td>
</tr>
<tr>
<td>End of Period Stock DC Cost Value</td>
<td>/RAP/EDCCV</td>
</tr>
<tr>
<td>End of Period Stock DC Units</td>
<td>/RAP/EDCUN</td>
</tr>
<tr>
<td>EOP Store Stock at Cost</td>
<td>/RAP/ESTCV</td>
</tr>
<tr>
<td>End of Period Stock Store Units</td>
<td>/RAP/ESTUN</td>
</tr>
<tr>
<td>Geographical Hierarchy Level 1</td>
<td>/RAP/GEOLV1</td>
</tr>
<tr>
<td>Geographical Hierarchy Level 2</td>
<td>/RAP/GEOLV2</td>
</tr>
<tr>
<td>Hierarchy ID</td>
<td>/RAP/HIEID</td>
</tr>
<tr>
<td>Inventory Adjustment at Cost</td>
<td>/RAP/IADCV</td>
</tr>
<tr>
<td>InfoObject Description</td>
<td>InfoObject Name</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Markdown Budget</td>
<td>/RAP/MRBUD</td>
</tr>
<tr>
<td>Promotion Budget</td>
<td>/RAP/PROBUD</td>
</tr>
<tr>
<td>Receipt Units DC</td>
<td>/RAP/RCPWD</td>
</tr>
<tr>
<td>Receipt Units Store</td>
<td>/RAP/RCWNS</td>
</tr>
<tr>
<td>Receipt DC at Cost</td>
<td>/RAP/RDCV</td>
</tr>
<tr>
<td>Receipt Store at Cost</td>
<td>/RAP/RDTCV</td>
</tr>
<tr>
<td>Return DC Cost Value</td>
<td>/RAP/REDCCV</td>
</tr>
<tr>
<td>Returns DC Units</td>
<td>/RAP/REDCUN</td>
</tr>
<tr>
<td>Weeks of Supply</td>
<td>/RAP/WKOSUP</td>
</tr>
<tr>
<td>Write Off Adjustment at Cost</td>
<td>/RAP/WOFFAD</td>
</tr>
<tr>
<td>Distribution Channel</td>
<td>/RAP/DISTC</td>
</tr>
<tr>
<td>On Order Cost Store</td>
<td>/RAP/ONOCS</td>
</tr>
<tr>
<td>Returns at Cost Store</td>
<td>/RAP/RETRCS</td>
</tr>
<tr>
<td>Return Units Store</td>
<td>/RAP/RETRUN</td>
</tr>
<tr>
<td>Location</td>
<td>/RAP/LOCAT</td>
</tr>
<tr>
<td>Sales Organization</td>
<td>/RAP/SLORG</td>
</tr>
</tbody>
</table>

- For the Info Cubes, go to object types and expand info area to locate /RAP/MP. Select and transfer to the Collect objects window.
- Select both cubes and install.

Table 58: Info Cubes (Planning writable)

<table>
<thead>
<tr>
<th>Info Cube Description</th>
<th>Info Cube Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Merchandise Planning, Plan</td>
<td>/RAP/MPRC01</td>
</tr>
<tr>
<td>Channel Planning, Plan</td>
<td>/RAP/MPRC02</td>
</tr>
</tbody>
</table>

Table 59: InfoObject Catalog (RAP)

<table>
<thead>
<tr>
<th>Catalog Description</th>
<th>Catalog Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAP Character InfoObject Catalog</td>
<td>/RAP/CHAR_CAT</td>
</tr>
<tr>
<td>RAP Key Figure InfoObject Catalog</td>
<td>/RAP/KYF_CAT</td>
</tr>
</tbody>
</table>
Table 60: Composite Providers

<table>
<thead>
<tr>
<th>Composite Provider Description</th>
<th>Composite Provider</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Merchandise Planning, Plan</td>
<td>/RAP/CP11</td>
</tr>
</tbody>
</table>

Table 61: Aggregation Levels

<table>
<thead>
<tr>
<th>Aggregation Description</th>
<th>Aggregation Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Merchandise Plan - Department Query</td>
<td>/RAP/C11A01</td>
</tr>
<tr>
<td>Channel Mix - Query/PF</td>
<td>/RAP/C11A02</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department PF</td>
<td>/RAP/C11A03</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class Query</td>
<td>/RAP/C11A04</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass Query</td>
<td>/RAP/C11A05</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division Query</td>
<td>/RAP/C11A06</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division PF</td>
<td>/RAP/C11A07</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class PF</td>
<td>/RAP/C11A08</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass PF</td>
<td>/RAP/C11A09</td>
</tr>
<tr>
<td>Channel Plan - Store Area Query PF</td>
<td>/RAP/C11A13</td>
</tr>
<tr>
<td>Channel Plan - Single Store Query</td>
<td>/RAP/C11A15</td>
</tr>
<tr>
<td>Channel Plan - Single Store Query PF</td>
<td>/RAP/C11A16</td>
</tr>
<tr>
<td>Channel Plan - Multi Store Query/PF</td>
<td>/RAP/C11A18</td>
</tr>
<tr>
<td>Channel Plan - Comp/Non Comp Query/PF</td>
<td>/RAP/C11A19</td>
</tr>
<tr>
<td>Channel Plan - Store Area PF</td>
<td>/RAP/C11A20</td>
</tr>
</tbody>
</table>

Master Data

In this step, you maintain master data for the info objects DataSlice Activation, /RAP/DSACT and Store Comparability Indicator, /RAP/COMP before continuing with the next activation.

1. Log on to your back-end system using SAP GUI.
2. Open the Edit InfoObjects (transaction RSD1).
3. In the Version Type section select Characteristic in the Editing Function section select InfoObject and enter /RAP/DSACT. Select Maintain.
4. On the Edit Characteristic /RAP/DSACT : Details screen, select the icon Maintain Master Data.
5. You are on the Change Master Data of InfoObject /RAP/DSACT maintenance screen.
6. Add or verify there is an entry for A and D. Save the table and close the window.
7. In your SAP GUI session use the green back arrow to return to Edit InfoObjects. In the Editing Function section select InfoObject and enter /RAP/COMP. Select Maintain.
8. You are on the Change Master Data of InfoObject /RAP/COMP maintenance screen.
9. Add or verify there is an entry for C, and the text “Comparable” and N, and the text “Non Comparable”. Save the table and close the window.

Table 62: Function Type for Planning

<table>
<thead>
<tr>
<th>Function Type Description</th>
<th>Function Type Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activation / Deactivation Data Slice</td>
<td>/RAP/MP_DATASLICE</td>
</tr>
<tr>
<td>MPR Channel Mix Top Down Distribution</td>
<td>/RAP/M_CHNMIX_TOPDWN</td>
</tr>
<tr>
<td>MPR Channel Plan Multi Store Top Down Distribution</td>
<td>/RAP/M_CHNPLN_MULTI</td>
</tr>
<tr>
<td>MPR Channel Plan Single Store Top Down from Multi</td>
<td>/RAP/M_CHNPLN_SNGL</td>
</tr>
<tr>
<td>MPR Channel Plan Comp/Non Comp Top Down Distribution</td>
<td>/RAP/M_CHNPLN_TOPDWN</td>
</tr>
<tr>
<td>MPR Distribute from CDT1 to CDT2</td>
<td>/RAP/M_DISTR_CDT1_2</td>
</tr>
<tr>
<td>MPR Distribute from CDT2 to CDT3</td>
<td>/RAP/M_DISTR_CDT2_3</td>
</tr>
<tr>
<td>MPR Distribute from CDT3 to CDT4</td>
<td>/RAP/M_DISTR_CDT3_4</td>
</tr>
</tbody>
</table>

Table 63: Planning Functions

<table>
<thead>
<tr>
<th>Planning Function Description</th>
<th>Planning Function Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Mix · Actualization</td>
<td>/RAP/C11A02_PF01</td>
</tr>
<tr>
<td>Channel Mix · Delete Plan Data</td>
<td>/RAP/C11A02_PF02</td>
</tr>
<tr>
<td>Channel Mix · Release</td>
<td>/RAP/C11A02_PF03</td>
</tr>
<tr>
<td>Channel Mix · Copy Version</td>
<td>/RAP/C11A02_PF05</td>
</tr>
<tr>
<td>Channel Mix · Bottom Up · Merchandise Plan</td>
<td>/RAP/C11A02_PF06</td>
</tr>
<tr>
<td>Merchandise Plan · Deactivate Data Slice</td>
<td>/RAP/C11A02_PF07</td>
</tr>
<tr>
<td>Channel Mix · Bottom Up · Comp/Non-Comp</td>
<td>/RAP/C11A02_PF08</td>
</tr>
<tr>
<td>Channel Mix · Bottom Up · Multi Stores</td>
<td>/RAP/C11A02_PF09</td>
</tr>
<tr>
<td>Channel Mix · Generate Combinations</td>
<td>/RAP/C11A02_PF10</td>
</tr>
<tr>
<td>Merchandise Plan · Activate Data Slice</td>
<td>/RAP/C11A02_PF11</td>
</tr>
<tr>
<td>Channel Plan · Activate Data Slice</td>
<td>/RAP/C11A02_PF12</td>
</tr>
<tr>
<td>Channel Plan · Deactivate Data Slice</td>
<td>/RAP/C11A02_PF13</td>
</tr>
<tr>
<td>Financial Merchandise Plan · Department · Copy Version</td>
<td>/RAP/C11A03_PF01</td>
</tr>
<tr>
<td>Planning Function Description</td>
<td>Planning Function Name</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Delete Plan Data</td>
<td>/RAP/C11A03_PF02</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Recalculate BOP</td>
<td>/RAP/C11A03_PF03</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Release</td>
<td>/RAP/C11A03_PF04</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Initialize BOP - T</td>
<td>/RAP/C11A03_PF05</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Bottom Up</td>
<td>/RAP/C11A03_PF06</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Top Down</td>
<td>/RAP/C11A03_PF07</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Actualization</td>
<td>/RAP/C11A03_PF08</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Generate Combination</td>
<td>/RAP/C11A03_PF09</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Initialize BOP - M</td>
<td>/RAP/C11A03_PF10</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Bottom Up - S. Store</td>
<td>/RAP/C11A03_PF11</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Copy Version</td>
<td>/RAP/C11A07_PF01</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Release</td>
<td>/RAP/C11A07_PF02</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Delete Plan Data</td>
<td>/RAP/C11A07_PF03</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Bottom Up</td>
<td>/RAP/C11A07_PF05</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Recalculate BOP</td>
<td>/RAP/C11A07_PF06</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Initialize BOP - T</td>
<td>/RAP/C11A07_PF07</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Bottom Up - S. Store</td>
<td>/RAP/C11A07_PF08</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Top Down Channel Mix</td>
<td>/RAP/C11A07_PF09</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Initialize BOP - M</td>
<td>/RAP/C11A07_PF11</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Actualization</td>
<td>/RAP/C11A07_PF12</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Generate Combination</td>
<td>/RAP/C11A07_PF13</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Copy Version</td>
<td>/RAP/C11A08_PF01</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Release</td>
<td>/RAP/C11A08_PF02</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Delete Plan Data</td>
<td>/RAP/C11A08_PF03</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Bottom Up</td>
<td>/RAP/C11A08_PF04</td>
</tr>
<tr>
<td>Planning Function Description</td>
<td>Planning Function Name</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Recalculate BOP</td>
<td>/RAP/C11A08_PF05</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Initialize BOP - T</td>
<td>/RAP/C11A08_PF06</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Generate Combination</td>
<td>/RAP/C11A08_PF07</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Top Down</td>
<td>/RAP/C11A08_PF08</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Initialize BOP - M</td>
<td>/RAP/C11A08_PF09</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Actualization</td>
<td>/RAP/C11A08_PF10</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Bottom Up - S. Store</td>
<td>/RAP/C11A08_PF11</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Copy Version</td>
<td>/RAP/C11A09_PF01</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Release</td>
<td>/RAP/C11A09_PF02</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Delete Plan Data</td>
<td>/RAP/C11A09_PF03</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Reconsiliation - Finalize</td>
<td>/RAP/C11A09_PF04</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Recalculate BOP</td>
<td>/RAP/C11A09_PF05</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Reconsiliation - Calc. Markdown</td>
<td>/RAP/C11A09_PF06</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Initialize BOP - T</td>
<td>/RAP/C11A09_PF07</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Reconsiliation - Calc. Promo</td>
<td>/RAP/C11A09_PF08</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Reconsiliation - Calc. OTB</td>
<td>/RAP/C11A09_PF09</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Reconsiliation - Aggr. OTB</td>
<td>/RAP/C11A09_PF10</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Reconsiliation - Aggr. Markdown</td>
<td>/RAP/C11A09_PF11</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Reconsiliation - Aggr. Promo</td>
<td>/RAP/C11A09_PF12</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Top Down</td>
<td>/RAP/C11A09_PF13</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Initialize BOP - M</td>
<td>/RAP/C11A09_PF14</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Generate Combination</td>
<td>/RAP/C11A09_PF15</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Actualization</td>
<td>/RAP/C11A09_PF16</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Bottom Up - S. Store</td>
<td>/RAP/C11A09_PF17</td>
</tr>
<tr>
<td>Channel Plan - Store Area - Fill all Periods</td>
<td>/RAP/C11A13_PF01</td>
</tr>
<tr>
<td>Planning Function Description</td>
<td>Planning Function Name</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Channel Plan · Store Area · Copy Store Area</td>
<td>/RAP/C11A13_PF03</td>
</tr>
<tr>
<td>Channel Plan · Single Store · Copy Version</td>
<td>/RAP/C11A16_PF01</td>
</tr>
<tr>
<td>Channel Plan · Single Store · Release</td>
<td>/RAP/C11A16_PF02</td>
</tr>
<tr>
<td>Channel Plan · Single Store · Delete Plan Data</td>
<td>/RAP/C11A16_PF03</td>
</tr>
<tr>
<td>Channel Plan · Single Store · Recalculate BOP</td>
<td>/RAP/C11A16_PF04</td>
</tr>
<tr>
<td>Channel Plan · Single Store · Initialize BOP · T</td>
<td>/RAP/C11A16_PF05</td>
</tr>
<tr>
<td>Channel Plan · Single Store · Create Combination</td>
<td>/RAP/C11A16_PF06</td>
</tr>
<tr>
<td>Channel Plan · Single Store · Initialize BOP · M</td>
<td>/RAP/C11A16_PF07</td>
</tr>
<tr>
<td>Channel Plan · Single Store · Actualization</td>
<td>/RAP/C11A16_PF08</td>
</tr>
<tr>
<td>Channel Plan · Single Store · Top Down</td>
<td>/RAP/C11A16_PF09</td>
</tr>
<tr>
<td>Channel Plan · Multi Store · Copy Version</td>
<td>/RAP/C11A18_PF01</td>
</tr>
<tr>
<td>Channel Plan · Multi Store · Delete Plan Data</td>
<td>/RAP/C11A18_PF02</td>
</tr>
<tr>
<td>Channel Plan · Multi Store · Release</td>
<td>/RAP/C11A18_PF03</td>
</tr>
<tr>
<td>Channel Plan · Multi Store · Bottom Up</td>
<td>/RAP/C11A18_PF04</td>
</tr>
<tr>
<td>Channel Plan · Multi Store · Generate Combinations</td>
<td>/RAP/C11A18_PF05</td>
</tr>
<tr>
<td>Channel Plan · Multi Store · Actualization</td>
<td>/RAP/C11A18_PF06</td>
</tr>
<tr>
<td>Channel Plan · Multi Store · Top Down · Comp/Non-Comp</td>
<td>/RAP/C11A18_PF07</td>
</tr>
<tr>
<td>Channel Plan · Multi Store · Top Down · Merchandise Plan</td>
<td>/RAP/C11A18_PF08</td>
</tr>
<tr>
<td>Channel Plan · Multi Store · Copy Store</td>
<td>/RAP/C11A18_PF09</td>
</tr>
<tr>
<td>Channel Plan · Comp/Non-Comp</td>
<td>/RAP/C11A19_PF01</td>
</tr>
<tr>
<td>Channel Plan · Comp/Non-Comp</td>
<td>/RAP/C11A19_PF02</td>
</tr>
<tr>
<td>Channel Plan · Comp/Non-Comp</td>
<td>/RAP/C11A19_PF03</td>
</tr>
<tr>
<td>Channel Plan · Comp/Non-Comp</td>
<td>/RAP/C11A19_PF04</td>
</tr>
<tr>
<td>Channel Plan · Comp/Non-Comp</td>
<td>/RAP/C11A19_PF05</td>
</tr>
<tr>
<td>Channel Plan · Comp/Non-Comp</td>
<td>/RAP/C11A19_PF06</td>
</tr>
<tr>
<td>Channel Plan · Comp/Non-Comp</td>
<td>/RAP/C11A19_PF07</td>
</tr>
<tr>
<td>Planning Function Description</td>
<td>Planning Function Name</td>
</tr>
<tr>
<td>------------------------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Channel Plan - Store Area - Aggr. Store Area</td>
<td>/RAP/C11A20_PF01</td>
</tr>
</tbody>
</table>

**Table 64: Planning Sequence**

<table>
<thead>
<tr>
<th>Planning Sequence Desc</th>
<th>Planning Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Mix - Copy Version</td>
<td>/RAP/C11A02_PS01</td>
</tr>
<tr>
<td>Channel Mix - Delete Plan Data</td>
<td>/RAP/C11A02_PS02</td>
</tr>
<tr>
<td>Channel Mix - Release</td>
<td>/RAP/C11A02_PS03</td>
</tr>
<tr>
<td>Channel Mix - Bottom Up - Merchandise Plan</td>
<td>/RAP/C11A02_PS04</td>
</tr>
<tr>
<td>Channel Mix - Bottom Up - Channel Plan - Comp/Non-Comp</td>
<td>/RAP/C11A02_PS05</td>
</tr>
<tr>
<td>Channel Mix - Bottom Up - Channel Plan - Multi Store</td>
<td>/RAP/C11A02_PS06</td>
</tr>
<tr>
<td>Channel Mix - Actualization</td>
<td>/RAP/C11A02_PS07</td>
</tr>
<tr>
<td>Activation of Data Slice</td>
<td>/RAP/C11A02_PS08</td>
</tr>
<tr>
<td>Deactivation of Data Slice</td>
<td>/RAP/C11A02_PS09</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Copy Version</td>
<td>/RAP/C11A03_PS01</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Delete Plan Data</td>
<td>/RAP/C11A03_PS02</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Recalculate BOP</td>
<td>/RAP/C11A03_PS03</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Release</td>
<td>/RAP/C11A03_PS04</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Initialize BOP - M</td>
<td>/RAP/C11A03_PS05</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Bottom Up</td>
<td>/RAP/C11A03_PS06</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Top Down</td>
<td>/RAP/C11A03_PS07</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Initialize BOP - P</td>
<td>/RAP/C11A03_PS08</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Initialize BOP - T</td>
<td>/RAP/C11A03_PS09</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Department - Actualization</td>
<td>/RAP/C11A03_PS10</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Departm. - Bottom Up - S. Store</td>
<td>/RAP/C11A03_PS11</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Copy Version</td>
<td>/RAP/C11A07_PS01</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Release</td>
<td>/RAP/C11A07_PS02</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Delete Plan Data</td>
<td>/RAP/C11A07_PS03</td>
</tr>
<tr>
<td>Planning Sequence Desc</td>
<td>Planning Sequence</td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Bottom Up</td>
<td>/RAP/C11A07_PS04</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Recalculate BOP</td>
<td>/RAP/C11A07_PS05</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Initialize BOP - P</td>
<td>/RAP/C11A07_PS06</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Initialize BOP - T</td>
<td>/RAP/C11A07_PS07</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Bottom Up - S. Store</td>
<td>/RAP/C11A07_PS08</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Top Down - Chan. Mix</td>
<td>/RAP/C11A07_PS09</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Initialize BOP - M</td>
<td>/RAP/C11A07_PS10</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Actualization</td>
<td>/RAP/C11A07_PS11</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Division - Top Down - Multi St.</td>
<td>/RAP/C11A07_PS12</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Copy Version</td>
<td>/RAP/C11A08_PS01</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Release</td>
<td>/RAP/C11A08_PS02</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Delete Plan Data</td>
<td>/RAP/C11A08_PS03</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Bottom Up</td>
<td>/RAP/C11A08_PS04</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Recalculate BOP</td>
<td>/RAP/C11A08_PS05</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Initialize BOP - P</td>
<td>/RAP/C11A08_PS06</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Initialize BOP - T</td>
<td>/RAP/C11A08_PS07</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Top Down</td>
<td>/RAP/C11A08_PS08</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Initialize BOP - M</td>
<td>/RAP/C11A08_PS09</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Actualization</td>
<td>/RAP/C11A08_PS10</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Class - Bottom Up - S. Store</td>
<td>/RAP/C11A08_PS11</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Initialize BOP - T</td>
<td>/RAP/C11A09_PF06</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Copy Version</td>
<td>/RAP/C11A09_PS01</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Release</td>
<td>/RAP/C11A09_PS02</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Delete Plan Data</td>
<td>/RAP/C11A09_PS03</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Reconsiliation - Finalize</td>
<td>/RAP/C11A09_PS04</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Recalculate BOP</td>
<td>/RAP/C11A09_PS05</td>
</tr>
<tr>
<td>Planning Sequence Desc</td>
<td>Planning Sequence</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Reconsiliation - Markdown Budge</td>
<td>/RAP/C11A09_PS06</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Initialize BOP - P</td>
<td>/RAP/C11A09_PS07</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Reconsiliation - Promo Budget</td>
<td>/RAP/C11A09_PS08</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Reconsiliation - OTB</td>
<td>/RAP/C11A09_PS09</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Top Down</td>
<td>/RAP/C11A09_PS10</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Initialize BOP - M</td>
<td>/RAP/C11A09_PS11</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Actualization</td>
<td>/RAP/C11A09_PS13</td>
</tr>
<tr>
<td>Financial Merchandise Plan - Subclass - Bottom Up - S. Store</td>
<td>/RAP/C11A09_PS14</td>
</tr>
<tr>
<td>Channel Plan - Store Area - Fill all Periods</td>
<td>/RAP/C11A13_PS01</td>
</tr>
<tr>
<td>Channel Plan - Store Area - Copy Store Area</td>
<td>/RAP/C11A13_PS02</td>
</tr>
<tr>
<td>Channel Plan - Single Store - Copy Version</td>
<td>/RAP/C11A16_PS01</td>
</tr>
<tr>
<td>Channel Plan - Single Store - Release</td>
<td>/RAP/C11A16_PS02</td>
</tr>
<tr>
<td>Channel Plan - Single Store - Delete Plan Data</td>
<td>/RAP/C11A16_PS03</td>
</tr>
<tr>
<td>Channel Plan - Single Store - Recalculate BOP</td>
<td>/RAP/C11A16_PS04</td>
</tr>
<tr>
<td>Channel Plan - Single Store - Initialize BOP - P</td>
<td>/RAP/C11A16_PS05</td>
</tr>
<tr>
<td>Channel Plan - Single Store - Initialize BOP - T</td>
<td>/RAP/C11A16_PS06</td>
</tr>
<tr>
<td>Channel Plan - Single Store - Initialize BOP - M</td>
<td>/RAP/C11A16_PS07</td>
</tr>
<tr>
<td>Channel Plan - Single Store - Actualization</td>
<td>/RAP/C11A16_PS08</td>
</tr>
<tr>
<td>Channel Plan - Single Store - Top Down</td>
<td>/RAP/C11A16_PS09</td>
</tr>
<tr>
<td>Channel Plan - Multi Store - Copy Version</td>
<td>/RAP/C11A18_PS01</td>
</tr>
<tr>
<td>Channel Plan - Multi Store - Delete Plan Data</td>
<td>/RAP/C11A18_PS02</td>
</tr>
<tr>
<td>Channel Plan - Multi Store - Release</td>
<td>/RAP/C11A18_PS03</td>
</tr>
<tr>
<td>Channel Plan - Multi Store - Bottom Up</td>
<td>/RAP/C11A18_PS04</td>
</tr>
<tr>
<td>Channel Plan - Multi Store - Actualization</td>
<td>/RAP/C11A18_PS05</td>
</tr>
<tr>
<td>Channel Plan - Multi Store - Top Down - Comp/Non-Comp</td>
<td>/RAP/C11A18_PS06</td>
</tr>
<tr>
<td>Planning Sequence Desc</td>
<td>Planning Sequence</td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Channel Plan - Multi Store - Top Down - Channel Mix</td>
<td>/RAP/C11A18_PS07</td>
</tr>
<tr>
<td>Channel Plan - Multi Store - Top Down - Merchandise Plan</td>
<td>/RAP/C11A18_PS08</td>
</tr>
<tr>
<td>Channel Plan - Multi Store - Copy Store</td>
<td>/RAP/C11A18_PS09</td>
</tr>
<tr>
<td>Channel Plan - Comp/Non-Comp - Copy Version</td>
<td>/RAP/C11A19_PS01</td>
</tr>
<tr>
<td>Channel Plan - Comp/Non-Comp - Delete Plan Data</td>
<td>/RAP/C11A19_PS02</td>
</tr>
<tr>
<td>Channel Plan - Comp/Non-Comp - Release</td>
<td>/RAP/C11A19_PS03</td>
</tr>
<tr>
<td>Channel Plan - Comp/Non-Comp - Actualization</td>
<td>/RAP/C11A19_PS04</td>
</tr>
<tr>
<td>Channel Plan - Comp/Non-Comp - Bottom Up</td>
<td>/RAP/C11A19_PS06</td>
</tr>
<tr>
<td>Channel Plan - Comp/Non-Comp - Top Down</td>
<td>/RAP/C11A19_PS07</td>
</tr>
<tr>
<td>Channel Plan - Store Area - Aggr. Store Area</td>
<td>/RAP/C11A20_PS01</td>
</tr>
</tbody>
</table>

**Queries**

There are too many queries to list in this section. Activate all queries under the /RAP/MP Info Area.

Table 65: Workbooks

<table>
<thead>
<tr>
<th>Workbook Description</th>
<th>Workbook Technical Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 - Channel Mix</td>
<td>/RAP/MPCHANNELMIX</td>
</tr>
<tr>
<td>01 - Channel Mix</td>
<td>/RAP/MPCHANNELMIXV2</td>
</tr>
<tr>
<td>03 - Merchandise Plan - Class</td>
<td>/RAP/MPCLASS</td>
</tr>
<tr>
<td>03 - Merchandise Plan - Class</td>
<td>/RAP/MPCLASSV2</td>
</tr>
<tr>
<td>02 - Merchandise Plan - Department</td>
<td>/RAP/MPDEPARTMENT</td>
</tr>
<tr>
<td>02 - Merchandise Plan - Department</td>
<td>/RAP/MPDEPARTMENTV2</td>
</tr>
<tr>
<td>01 - Merchandise Plan - Division</td>
<td>/RAP/MPDIVISION</td>
</tr>
<tr>
<td>01 - Merchandise Plan - Division</td>
<td>/RAP/MPDIVISIONV2</td>
</tr>
<tr>
<td>05 - Merchandise Plan - OTB Reconciliation Report</td>
<td>/RAP/MPOTBRECONSILIATION</td>
</tr>
<tr>
<td>05 - Merchandise Plan - OTB Reconciliation Report</td>
<td>/RAP/MPOTBRECONSILIATIONV2</td>
</tr>
<tr>
<td>05 - Channel Plan - Store Area Plan</td>
<td>/RAP/MPSTOREAREA</td>
</tr>
<tr>
<td>05 - Channel Plan - Store Area Plan</td>
<td>/RAP/MPSTOREAREAV2</td>
</tr>
<tr>
<td>02 - Channel Plan - Store Comparability</td>
<td>/RAP/MPSTORECOMP</td>
</tr>
</tbody>
</table>
6.4.2.4 Configure SAP Merchandise Planning for Retail Local BI Content

6.4.2.4.1 Enable the Planning Application Kit (PAK)

Use

To be able to use the SAP BusinessObjects Analysis, edition for Microsoft Office workbooks provided as part of the SAP Assortment Planning for Retail planning framework content, you must enable the Planning Application Kit.

Procedure

1. Read SAP Note 1637199.
2. In your back-end system, launch table/view maintenance (transaction SM30).
3. Enter RSPLS_HDB_ACT in the Table/View field and choose Maintain.
4. Choose New Entries.
5. In the HANA Integrtn. Active column select Deep HANA Integration Active and in the Functn. Active column, enable the checkbox.

6.4.2.4.2 Maintain RSADMIN Parameter for Input Cells

In this procedure, you maintain the RSADMIN parameter for Input Cells in the SAP BW application to suppress zero values for actual data versions.
1. Log on to your back-end system.
2. Open the **ABAP Editor** (transaction SE38).
3. Run program **SAP_RSADMIN_MAINTAIN**
4. In **RSAD Table Maintenance**, insert **ZERO_SUPPRESSION_ON_INPUTCELLS** in **OBJECT** and Execute.

### 6.4.2.4.3 Maintain Fiscal Year Variants

#### Use

In this section you maintain the required fiscal year variant values for week and month; **OFISCVARNT 'RW'** and **'RM'**.

**Caution**

SAP Merchandise Planning for Retail uses activated time objects **OFISCPER** (fiscal year period) and **OFISCVARNT** (fiscal year variant), provided as part of the technical BI Content.

If you are also using the **SAP Assortment Planning for Retail** application, you use the same fiscal year variant that was created for this application.

#### Procedure

**Fiscal Variant RW**

The steps provided in this procedure allow you to maintain **OFISCVARNT 'RW'** using the standard 4-5-4 calendar entries. If you are using alternative fiscal periods in your retail business, for example, each week starting on a Sunday instead of Saturday, you can provide your own entries instead of the ones suggested in this guide.

1. Log on to your back-end system.
2. Launch fiscal year variant maintenance (transaction GVAR).
3. Choose **New Entries**.
4. On the **New Entries: Overview of Added Entries** screen make the following sets of entries:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>User Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>FV</td>
<td>RW</td>
</tr>
<tr>
<td>Description</td>
<td>Planning week</td>
</tr>
<tr>
<td>Year-dependent</td>
<td>Select</td>
</tr>
</tbody>
</table>
5. Choose **Enter**. 
   An information message is displayed about creating more than 16 periods, choose **Continue**.

6. Choose **Back**.
   You can see the newly created entry.

7. Mark the entry **RW** and select **Periods** from the **Dialog Structure**.

8. Enter **2012** in the **Calendar yr** field and choose **Continue**. 
   Data for the previous year must be maintained.

9. Choose **New Entries**.

10. Open SAP Note [2112634](#), locate the entries for year 2012, and enter the data by copy-and-paste. Note that this SAP Note is applicable for both SAP Merchandise Planning for Retail and SAP Assortment Planning for Retail.

11. Choose **Enter** to finish your input.

   While making the fiscal year entries, an information message might be displayed stating that there are **Gaps in financial year variant periods RW**. This is an information message only, and the entered fiscal year data is saved.

12. Maintain the weekly fiscal year variant in the same way for the year 2017. The entries for year 2017 are also available in SAP Note [2112634](#).

13. Select **Shortened Fiscal Years** from the **Dialog Structure**.

14. Enter **2013** in the **Fiscal year** field and choose **Continue**.

15. Choose **New Entries**.

16. Enter **52** in the **No. of posting periods** field.

17. Choose **Back** twice.

18. Maintain the weekly fiscal year variant in the same way for the shortened fiscal years, that is, years 2013, 2014, 2015, 2016, and 2018. The corresponding tables are available in SAP Note [2112634](#).

19. Choose **Save** after you have finished the maintenance for year 2018.

**Fiscal Variant RM**

The next steps allow you to maintain **0FISCVARNT ‘RM’** using the standard 12 month calendar entries. If you are using alternative fiscal periods in your retail business, you can provide your own entries instead of the ones suggested in this guide. These month entries must align with the week values used in the prior step.

1. In the **Fiscal Year Variants** view, choose **New Entries**.
2. On the New Entries: Overview of Added Entries screen make the following sets of entries:

Table 67:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>User Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>FV</td>
<td>RM</td>
</tr>
<tr>
<td>Description</td>
<td>Planning month</td>
</tr>
<tr>
<td>Year-dependent</td>
<td>Select</td>
</tr>
<tr>
<td>Calendar yr</td>
<td>Do not select</td>
</tr>
<tr>
<td>Number of period postings</td>
<td>12</td>
</tr>
</tbody>
</table>

3. Choose Enter.


You can see the newly created entry.

To get the information to enter in the next step, open SAP Note 2112634. Note that this SAP Note is applicable for both SAP Merchandise Planning for Retail and SAP Assortment Planning for Retail. If you have used these dates for your weekly calendar, then align the month end dates to match. An example is contained in the table below using the 2015 calendar entries from the SAP Note.

5. Mark the entry RM and select Periods from the Dialog Structure and double click to open the Calendar year dialog.

6. Enter 2012 in the Calendar yr field and choose Continue.

7. Choose New Entries. For the year selected to enter the information that will define each period.

8. Enter the last valid calendar date of the period being added in the Month and Day fields.

9. Enter the relevant Period number.

10. In the Year Shift field, enter +1 if the fiscal year is later than the calendar year enter. Enter -1 if the fiscal year is before the calendar year.

11. Press Enter to accept the first row.

12. Continue adding each period to complete the fiscal year.

   Maintain the monthly fiscal year variant in the same way for the remaining years.

13. Choose Save after you have finished the maintenance for year 2018.

Choose Save after you have finished the maintenance for year the last year.

Table 68: 2015 Monthly Calendar

<table>
<thead>
<tr>
<th>Month</th>
<th>Day</th>
<th>Period</th>
<th>Year Shift</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>31</td>
<td>12</td>
<td>-1</td>
</tr>
</tbody>
</table>
6.4.2.4.4 Generate Time Dimension

Use

In this procedure you generate the time dimension. There is a weekly and monthly time dimension required. The steps provided in this procedure allow you to maintain the M_FISCALCALENDAR table in the _SYS_BI schema. Perform the steps for the weekly (RW), then the monthly (RM) dimensions.

Procedure

1. Log on to your SAP HANA studio.
2. From the Quick Launch tab page, choose Generate Time Data.
3. In the Generate Time Data dialog, input the following values:

   Table 69:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar Type</td>
<td>Fiscal</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
<td>Comment</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>From Year</td>
<td>2010</td>
<td>Ensure that you choose the first year that you have entered in transaction GVAR.</td>
</tr>
<tr>
<td>To Year</td>
<td>2020</td>
<td>Ensure that you choose the last year that you have entered in transaction GVAR.</td>
</tr>
<tr>
<td>Variant</td>
<td>RW: (Client) (1st iteration)</td>
<td>Ensure that you choose the fiscal year variant that you have defined in transaction GVAR for the appropriate client.</td>
</tr>
<tr>
<td></td>
<td>RM: (Client) (2nd iteration)</td>
<td></td>
</tr>
</tbody>
</table>

4. Choose button Generate.
5. Check table M_FISCALCALENDAR in the _SYS_BI schema to confirm the time generation.
Return to Step 2 in the procedure and repeat the steps for the monthly dimension.

### 6.4.2.4.5 Maintain Versions

In this step, you maintain the master data for the InfoObject /RAP/VERSN to support versions in workbooks.

1. Open the Edit InfoObjects (transaction RSD1).
2. In the Version Type section select Characteristic and in the Editing Function section select InfoObject.
   In the text input field enter /RAP/VERSN. Select Maintain.
3. On the Edit Characteristic /RAP/VERSN : Details screen, select the icon Maintain Master Data.
4. You are on the Change Master Data of InfoObject /RAP/VERSN maintenance screen.
5. Add the entries in the table below. Save the table and close the window.

**Table 70:**

<table>
<thead>
<tr>
<th>Version</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>MO1</td>
<td>MO Working Version</td>
</tr>
<tr>
<td>MO2</td>
<td>MO Simulation Version</td>
</tr>
<tr>
<td>MOR</td>
<td>MO Reporting Version</td>
</tr>
<tr>
<td>MOP</td>
<td>MO Inseason Version</td>
</tr>
<tr>
<td>MD1</td>
<td>MD Working Version</td>
</tr>
<tr>
<td>MD2</td>
<td>MD Simulation Version</td>
</tr>
<tr>
<td>MDR</td>
<td>MD Reporting Version</td>
</tr>
<tr>
<td>MDP</td>
<td>MD In season Version</td>
</tr>
<tr>
<td>MP1</td>
<td>MP Working Version</td>
</tr>
<tr>
<td>Version</td>
<td>Text</td>
</tr>
<tr>
<td>---------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>MP2</td>
<td>MP Simulation Version</td>
</tr>
<tr>
<td>MPR</td>
<td>MP Reporting Version</td>
</tr>
<tr>
<td>MPP</td>
<td>MP In season Version</td>
</tr>
<tr>
<td>MM1</td>
<td>MM Working Version</td>
</tr>
<tr>
<td>MM2</td>
<td>MM Simulation Version</td>
</tr>
<tr>
<td>MMR</td>
<td>MM Reporting Version</td>
</tr>
<tr>
<td>MMP</td>
<td>MM In season Version</td>
</tr>
<tr>
<td>MMF</td>
<td>MM Final Version</td>
</tr>
<tr>
<td>FO1</td>
<td>FO Working Version</td>
</tr>
<tr>
<td>FO2</td>
<td>FO Simulation Version</td>
</tr>
<tr>
<td>FOR</td>
<td>FO Reporting Version</td>
</tr>
<tr>
<td>FOP</td>
<td>FO In season Version</td>
</tr>
<tr>
<td>FD1</td>
<td>FD Working Version</td>
</tr>
<tr>
<td>FD2</td>
<td>FD Simulation Version</td>
</tr>
<tr>
<td>FDR</td>
<td>FD Reporting Version</td>
</tr>
<tr>
<td>FDP</td>
<td>FD In season Version</td>
</tr>
<tr>
<td>FM1</td>
<td>FM Working Version</td>
</tr>
<tr>
<td>FM2</td>
<td>FM Simulation Version</td>
</tr>
<tr>
<td>FMR</td>
<td>FM Reporting Version</td>
</tr>
<tr>
<td>FMP</td>
<td>FM In season Version</td>
</tr>
<tr>
<td>FL1</td>
<td>FL Working Version</td>
</tr>
<tr>
<td>FL2</td>
<td>FL Simulation Version</td>
</tr>
<tr>
<td>FLR</td>
<td>FL Reporting Version</td>
</tr>
<tr>
<td>FLP</td>
<td>FL In season Version</td>
</tr>
<tr>
<td>SAP</td>
<td>Store Area Plan</td>
</tr>
</tbody>
</table>
6.4.2.4.6 Maintain Time Hierarchy

The time hierarchy is used to summarize the fiscal periods for planning. In this step, you create 2 time hierarchies: YR/SEASON and YR/SEASON/MON/WK. Use transaction RSH1 to create the hierarchies for the InfoObject OFISCPER. The instructions are an example of the required steps that will be repeated for each year and time period.

Table 71:

<table>
<thead>
<tr>
<th>InfoObject</th>
<th>Time hierarchy example</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFISCPER</td>
<td>• Create the ORP_FISCHIER02 hierarchy name with the entry YR/SEASON in the Short Description field.</td>
</tr>
<tr>
<td></td>
<td>• Create the Year hierarchy node with Year in the Short Description.</td>
</tr>
<tr>
<td></td>
<td>• Choose the Year hierarchy node, and create the Spring hierarchy node with Spring in the Short Description field under the Year hierarchy node. Click continue</td>
</tr>
<tr>
<td></td>
<td>• Choose the Spring hierarchy node, use the Characteristic Nodes Button to insert the Fiscal year/Period value for each period for that season.</td>
</tr>
<tr>
<td></td>
<td>• Continue the process for each year, season and period. Save and activate the hierarchy when completed.</td>
</tr>
<tr>
<td></td>
<td>• Create the ORP_FISCHIER01 hierarchy name with the entry YR/SEASON/MON/WK in the Short Description field.</td>
</tr>
<tr>
<td></td>
<td>• Create the Year hierarchy node with Year value in the Short Description field.</td>
</tr>
<tr>
<td></td>
<td>• Choose the Year hierarchy node, and create the Spring hierarchy node with Spring in the Short Description field under the Year hierarchy node.</td>
</tr>
<tr>
<td></td>
<td>• Choose the Spring hierarchy node, and create the February hierarchy node with February in the Short Description field under the Spring hierarchy node.</td>
</tr>
<tr>
<td></td>
<td>• Choose the February hierarchy node, use the Characteristic Nodes Button to insert the Fiscal year/Period value for each period for that month.</td>
</tr>
<tr>
<td></td>
<td>• Continue the process for each year, season, month, period as desired. Save and activate the hierarchy when completed.</td>
</tr>
</tbody>
</table>

6.4.2.4.7 Activate Internet Communication Framework (ICF) Services

For security reasons, all Internet Communication Framework (ICF) services relevant to your SAP Merchandise Planning for Retail application are made available in an inactive state.

In this procedure, you activate the ICF service.

1. Log on to your back-end system.
2. Open the HTTP Service Hierarchy Maintenance screen (transaction S1CF).
3. Enter the following data:

<table>
<thead>
<tr>
<th>Field name</th>
<th>User action and values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hierarchy Type</td>
<td>SERVICE</td>
</tr>
</tbody>
</table>

4. Choose **Execute**.
5. On the **Maintain Service** screen, expand the hierarchy of **Default_host**.
6. Expand SAP.
7. Select the **BW** entry.
8. From the context menu choose **Activate** service.
9. In the confirmation dialog box, choose **Yes** to activate all sub-nodes below the **BW** node in the hierarchy.
10. Choose **Back**.

### 6.4.2.4.8 Maintain Source System IDs

In this procedure, you maintain the source system IDs.

1. Log on to your back-end system.
2. Open the Data Warehouse Workbench: Modeling screen (transaction **RSA1**).
3. Choose **InfoProvider**.
4. Choose from the menu **Tools** > **Asgnmt of Srce Syst. to Srce Syst. ID**
5. Enter a unique 2 digit Source System ID for all of your systems.
   - You have the following example:

<table>
<thead>
<tr>
<th>Source System Source</th>
<th>Name Source</th>
<th>System ID</th>
<th>System ID Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>FILE</td>
<td>FILE</td>
<td>01</td>
<td>Flat files</td>
</tr>
</tbody>
</table>

6. Choose **Enter**.
7. Enter a **Source System ID Text** for each system.
8. Choose **Save**.
9. If the system displays a dialog box with the information **Empty source system IDs are not saved**, choose **Enter**.
10. Choose **Back**.

### 6.4.2.4.9 Connect File System in SAP BW

In this procedure, you perform the settings that are necessary for the connectivity for an external system - PC files on the Workstation (for example Excel files) or files on the application server in SAP BW.

1. Log on to your back-end system.
2. Open the Data Warehouse Workbench: Modeling screen (transaction **RSA1**).
3. Choose **Modeling**.
4. Choose **Source Systems**.
5. In the right-hand frame, mark the entry **File**.
6. Right-click the folder of **File**.
7. Choose **Create**.
8. Enter the following data:

<table>
<thead>
<tr>
<th>Field name</th>
<th>User action and values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logical system name</td>
<td><strong>FILE</strong></td>
</tr>
<tr>
<td>Source system name</td>
<td><strong>FILE</strong></td>
</tr>
</tbody>
</table>

9. Choose **Continue**.
10. Right-click the **FILE** Source System.
11. Follow the context menu path **Activate**.

### 6.4.2.5 Maintain Process Chain Related

Maintain BW process chain variants relevant for SAP Merchandise Planning for Retail.

**Context**

In this procedure, you activate the following infoobjects and maintain the BW process chain variants.

<table>
<thead>
<tr>
<th>InfoObject Description</th>
<th>InfoObject Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characteristic Rels. for Financial Merchandise Planning</td>
<td>Plan /RAP/MPRC01</td>
</tr>
<tr>
<td>Characteristic Rels. for Channel Planning</td>
<td>Plan /RAP/MPRC02</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>InfoObject Description</th>
<th>InfoObject Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Slices for Financial Merchandise Planning, Plan</td>
<td>/RAP/MPRC01</td>
</tr>
<tr>
<td>Data Slices for Channel Planning, Plan</td>
<td>/RAP/MPRC02</td>
</tr>
</tbody>
</table>
Table 77: Process Chain Doc Process Chain

<table>
<thead>
<tr>
<th>InfoObject Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>/RAP/MPPC01_01</td>
</tr>
</tbody>
</table>

Table 78: Process Chain Starter

<table>
<thead>
<tr>
<th>InfoObject Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>/RAP/MPPC01_01</td>
</tr>
</tbody>
</table>

Procedure

In this process you will create variants and activate the BW process chains.

1. Planning Sequence Data Slice Activation
   1. Go to transaction RSPLAN
   2. Select the Planning Sequence button.
   3. In the planning sequence field, enter /RAP/C11A02_PS08 and choose Edit button.
   4. Select the Variables button.
   5. Select the Geographical Level 1 Input help and select a value.
   6. Select the Save As Button.
   7. In the Variables prompt, choose F9 to turn Cross User-variant on.
   8. Enter a variant name. For description enter Data Slice Activation and select the Cross-User Variant check box.
   9. Select the Continue button.
   10. Select the Continue button in the variables screen.
   11. Go to transaction RSA1.
   12. In the navigation panel, select the Modeling button, then Process Chain.
   13. In the process chain panel, right click on Merchandise Planning - Actualization and choose Edit.
   14. In the right tree, right click on Execute Planning Sequence Data Slice Activation (/RAP/MPPC01_10) and choose Maintain Variant.
   15. Load the variant created in step h (if not already loaded).
   16. Select the Transfer button and save.

2. Planning Sequence Deactivation of Data Slice
   1. Go to transaction RSPLAN
   2. Select the Planning Sequence button.
   3. In the planning sequence field, enter /RAP/C11A02_PS09 and choose Edit button.
   4. Select the Variables button.
   5. Select the Geographical Level 1 Input help and select a value.
   6. Select the Save As Button.
   7. In the Variables prompt, choose F9 to turn Cross User-variant on.
   8. Enter a variant name. For description enter Data Slice Deactivation and select the Cross-User Variant check box.
   9. Select the Continue button.
   10. Select the Continue button in the variables screen.
   11. Go to transaction RSA1.
   12. In the navigation panel, select the Modeling button, then Process Chain.
13. In the process chain panel, right click on Merchandise Planning - Actualization and choose Edit.
14. In the right tree, right click on Execute Planning Sequence Data Slice Deactivation (/RAP/MPPC01_11) and choose Maintain Variant.
15. Load the variant created in step h (if not already loaded).
16. Select the Transfer button and save.

3. Planning Sequence Channel Mix - Actualization
1. Go to transaction RSPLAN
2. Select the Planning Sequence button.
3. In the planning sequence field, enter /RAP/C11A02_PS07 and choose Edit button.
4. Select the Variables button.
5. Select the Geographical Level 1 Input help and select a value.
6. Select the Save As Button.
7. Enter a variant name. For description enter Channel Mix - Actualization and select the Cross-User Variant check box.
8. Select the Continue button.
9. Select the Continue button in the variables screen.
10. Go to transaction RSA1.
11. In the navigation panel, select the Modeling button, then Process Chain.
12. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.
13. In the right tree, right click on Execute Planning Sequence Channel Mix - Actualization (/RAP/MPPC01_02) and choose Maintain Variant.
14. Load the variant created in step h (if not already loaded).
15. Select the Transfer button and save.

4. Planning Sequence Financial Merchandise Plan - Division - Actualization
1. Go to transaction RSPLAN
2. Select the Planning Sequence button.
3. In the planning sequence field, enter /RAP/C11A07_PS11 and choose Edit button.
4. Select the Variables button.
5. Select the Geographical Level 1 Input help and select a value.
6. Select the Save As Button.
7. Enter a variant name. For description enter MP - Division - Actualization and select the Cross-User Variant check box.
8. Select the Continue button.
9. Select the Continue button in the variables screen.
10. Go to transaction RSA1.
11. In the navigation panel, select the Modeling button, then Process Chain.
12. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.
13. In the right tree, right click on Execute Planning Sequence Financial Merchandise Plan - Division - Actualization (/RAP/MPPC01_03) and choose Maintain Variant.
14. Load the variant created in step h (if not already loaded).
15. Select the Transfer button and save.

5. Planning Sequence Financial Merchandise Plan - Department - Actualization
1. Go to transaction RSPLAN
2. Select the **Planning Sequence** button.
3. In the planning sequence field, enter \RAP/C11A03_PS10 and choose **Edit** button.
4. Select the **Variables** button.
5. Select the **Geographical Level 1 Input** help and select a value.
6. Select the **Save As** button.
7. In the Variables prompt, choose **F9** to turn Cross User-variant on.
8. Enter a variant name. For description enter **MP - Department - Actualization** and select the Cross-User Variant check box.
9. Select the **Continue** button.
10. Select the **Continue** button in the variables screen.
11. Go to transaction RSA1.
12. In the navigation panel, select the **Modeling** button, then Process Chain.
13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.
14. In the right tree, right click on **Execute Planning Sequence Financial Merchandise Plan - Department - Actualization**(/RAP/MPPC01_04) and choose **Maintain Variant**.
15. Load the variant created in step h (if not already loaded).
16. Select the **Transfer** button and save.

6. Planning Sequence Financial Merchandise Plan - Class - Actualization
1. Go to transaction RSPLAN
2. Select the **Planning Sequence** button.
3. In the planning sequence field, enter \RAP/C11A08_PS10 and choose **Edit** button.
4. Select the **Variables** button.
5. Select the **Geographical Level 1 Input** help and select a value.
6. Select the **Save As** button.
7. In the Variables prompt, choose **F9** to turn Cross User-variant on.
8. Enter a variant name. For description enter **MP - Class - Actualization** and select the Cross-User Variant check box.
9. Select the **Continue** button.
10. Select the **Continue** button in the variables screen.
11. Go to transaction RSA1.
12. In the navigation panel, select the **Modeling** button, then Process Chain.
13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.
14. In the right tree, right click on **Execute Planning Sequence Financial Merchandise Plan - Class - Actualization**(/RAP/MPPC01_05) and choose **Maintain Variant**.
15. Load the variant created in step h (if not already loaded).
16. Select the **Transfer** button and save.

7. Planning Sequence Financial Merchandise Plan - Subclass - Actualization
1. Go to transaction RSPLAN
2. Select the **Planning Sequence** button.
3. In the planning sequence field, enter \RAP/C11A09_PS13 and choose **Edit** button.
4. Select the **Variables** button.
5. Select the **Geographical Level 1 Input** help and select a value.
6. Select the **Save As** button.
7. In the Variables prompt, choose **F9** to turn Cross User-variant on.
8. Enter a variant name. For description enter **MP - Subclass - Actualization** and select the Cross-User Variant check box.

9. Select the *Continue* button.

10. Select the *Continue* button in the variables screen.

11. Go to transaction RSA1.

12. In the navigation panel, select the *Modeling* button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

14. In the right tree, right click on **Execute Planning Sequence Financial Merchandise Plan - Subclass - Actualization(/RAP/MPPC01_06)** and choose *Maintain Variant*.

15. Load the variant created in step h (if not already loaded).

16. Select the *Transfer* button and save.

---

Planning Sequence Channel Plan - Store Comp - Actualization

1. Go to transaction RSPLAN

2. Select the *Planning Sequence* button.

3. In the planning sequence field, enter **/RAP/C11A19_PS04** and choose *Edit* button.

4. Select the *Variables* button.

5. Select the *Geographical Level 1 Input* help and select a value.

6. Select the *Save As* Button.

7. In the Variables prompt, choose *F9* to turn Cross User-variant on.

8. Enter a variant name. For description enter **CP - Store Comp - Actualization** and select the Cross-User Variant check box.

9. Select the *Continue* button.

10. Select the *Continue* button in the variables screen.

11. Go to transaction RSA1.

12. In the navigation panel, select the *Modeling* button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

14. In the right tree, right click on **Execute Planning Sequence Channel Plan - Store Comp - Actualization(/RAP/MPPC01_06)** and choose *Maintain Variant*.

15. Load the variant created in step h (if not already loaded).

16. Select the *Transfer* button and save.

---

Planning Sequence Channel Plan - Multi Store - Actualization

1. Go to transaction RSPLAN

2. Select the *Planning Sequence* button.

3. In the planning sequence field, enter **/RAP/C11A18_PS05** and choose *Edit* button.

4. Select the *Variables* button.

5. Select the *Geographical Level 1 Input* help and select a value.

6. Select the *Save As* Button.

7. In the Variables prompt, choose *F9* to turn Cross User-variant on.

8. Enter a variant name. For description enter **CP - Multi Store - Actualization** and select the Cross-User Variant check box.

9. Select the *Continue* button.

10. Select the *Continue* button in the variables screen.

11. Go to transaction RSA1.

12. In the navigation panel, select the *Modeling* button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.
14. In the right tree, right click on **Execute Planning Sequence Channel Plan - Multi Store - Actualization(/RAP/MPPC01_08)** and choose **Maintain Variant**.

15. Load the variant created in step h (if not already loaded).

16. Select the **Transfer** button and save.

10. Planning Sequence Channel Plan - Single Store - Actualization

   1. Go to transaction **RSPLAN**
   2. Select the **Planning Sequence** button.
   3. In the planning sequence field, enter **/RAP/C11A16_PS08** and choose **Edit** button.
   4. Select the **Variables** button.
   5. Select the **Geographical Level 1 Input** help and select a value.
   6. Select the **Save As** button.
   7. In the Variables prompt, choose **F9** to turn Cross-User variant on.
   8. Enter a variant name. For description enter **CP - Single Store - Actualization** and select the Cross-User Variant check box.
   9. Select the **Continue** button.
   10. Select the **Continue** button in the variables screen.
   11. Go to transaction **RSA1**.
   12. In the navigation panel, select the **Modeling** button, then Process Chain.
   13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.
   14. In the right tree, right click on **Execute Planning Sequence Channel Plan - Single Store - Actualization(/RAP/MPPC01_09)** and choose **Maintain Variant**.

15. Load the variant created in step h (if not already loaded).

16. Select the **Transfer** button and save.

### 6.4.2.6 Maintain BEX Variables

In this step, you maintain the variables **/RAP/HIEID_MSM_01** and **/RAP/UNIT_MSM_01**. To do this launch the **Query Designer** and follow the steps below.

1. Log in to the system desired and select the **Open query** icon. In the prompt search the **InfoAreas** for Merchandise, Financial Planning for Retail and select.

2. Open query **Channel Mix - query/PF** (**/RAP/CP11A02_IRQ01**).

3. In the **Filter** panel, **Characteristic Restrictions** and select **Hierarchy ID** and expand. Choose the variable **Hierarchy ID** beneath to focus the value in the **Properties** panel.

4. Select the **Default Values** tab and enter the same hierarchy id used in the Customizing activity.

5. Return to the **Filter** panel, **Characteristic Restrictions** and select **Unit of Measure** and expand. Choose the variable **Unit of Measure** beneath to focus the value in the **Properties** panel.

6. Select the **Default Values** tab and enter the value 'PC' to represent the default unit of measure value for pieces.

7. Save the Query and exit.

To support versions in workbooks.
6.4.2.7 Generate Missing Data Reports

Use

There are two reports required to populated supporting tables.

Procedure

The first report will generate entries for table /RAP/RS_VARCUSTS.

- Use transaction code SE38 and enter /RAP/SEED_BW_CUSTOMIZING_DATA in the Program field. Use the Execute button to run the report.

The second report is used to set the session client on the HANA system.

- Use transaction code SE38 and enter /RAP/MPR_REPORTING_CLIENT in the Program field. Use the Execute button to run the report.

6.4.2.8 Create Geographical Location Hierarchies

SAP Merchandise Planning for Retail supports up to 2 levels of geographical location hierarchies. For example, you create the first level for the world regions, the second level for countries, and then the location hierarchy. The location hierarchy node assigned to a geographical location hierarchy must be a distribution chain hierarchy (DC), which is a type 04 or a promotion location hierarchy which is a type 05.

Do the following steps to create a geographical location hierarchy:

1. Log in to the application server using SAP GUI and execute transaction code NWBC.
2. Select the Services menu.
3. In the left navigation menu select Location Services Location Hierarchy. In the POWL menu on the right, select the Create button, then Geographical Location Hierarchy in the dropdown.
4. Enter the location hierarchy name, description and the master data system for your new geographical location hierarchy.
5. Select the Editor tab.

### Note

- The Location and Import tabs are disabled.

Enter or search for the distribution chain location hierarchy or promotion location hierarchy that you want to add to your geographical location hierarchy.

6. Add the desired DC location hierarchy or promotion location hierarchy to your geographical location hierarchy. You may have either or both types of hierarchies added to the same geographical location hierarchy node.
7. Save your entries.

In the example below you have two level 2 hierarchies. The level 3 hierarchies are the actual distribution chain location hierarchies and/or promotion location hierarchies that were selected (created in a previous activity).

- **GLOBAL (GEOLEVEL1)**
  - **NORTH_AMERICA (GEOLEVEL2)**
    - **DC Hierarchy for Sales Org/Dist. Channel XYZ (GEOLEVEL3)**
      This will assign all locations for the sales org / distribution channel XYZ to North America’s node.
    - **Promotion location hierarchy PL123 (GEOLEVEL3)**
      This will assign all locations for the promotion location hierarchy PL123 to North America’s node.
  - **SOUTH_AMERICA (GEOLEVEL2)**
    - **DC Hierarchy for Sales Org/Dist. Channel ABC (GEOLEVEL3)**
      This will assign all locations for the sales org / distribution channel ABC to South America’s node.

### 6.4.2.9 Maintain Article and Geographical Hierarchy

**Use**

There are two types of hierarchies used in SAP Merchandise Planning for Retail. The Geographical and the Article Hierarchy.

**Procedure**

There is a Customizing activity to define the required hierarchies. Use transaction code **SPRO** and in the Dialog Structure navigate to **Cross-Application Components ➤ Assortment Planning for Retail ➤ Imported Demand Data Foundation Settings ➤ Basic Settings** and choose **Define Default Values**.

- In the **Hierarchy ID** field use the prompt to select the applicable article hierarchy id. If SAP Assortment Planning for Retail is installed, it is already populated.
- In the **Geo Hierarchy ID** field use the prompt to select the applicable geo hierarchy id.

### 6.4.2.10 Reporting Currency for Geo Hierarchy Level 2

The geographical hierarchy level 2 requires a reporting currency. Do the following steps to create a geographical location hierarchy currency:

1. In your back-end system, launch table/view maintenance transaction code **SM30**.
2. In the **Maintain Table Views: Initial Screen** enter /RAP/GEOLVL_CUST in the **Table/view field** and select the **Maintain** button.
3. Choose **New Entries**.
4. Use the **F4** help to select the **Geographical Level 02** desired.
5. Use the F4 help to select the Reporting Currency associated with the Geographical Level 02 selected.
6. Repeat for each Geographical Level 02 required.
7. Save your entries.

6.4.2.11 Verify the Connection Between the SAP Merchandise Planning for Retail System and SAP BusinessObjects Analysis, edition for Microsoft Office

The SAP Merchandise Planning for Retail application includes several SAP BusinessObjects Analysis, edition for Microsoft Office workbooks. These workbooks, which are installed on your back-end system as part of the local BI Content, can only be opened using SAP BusinessObjects Analysis, edition for Microsoft Office.

In this step, you verify that you can open the SAP Merchandise Planning for Retail workbooks from SAP BusinessObjects Analysis, edition for Microsoft Office.

1. Open SAP BusinessObjects Analysis, edition for Microsoft Office from Start ➤ All Programs ➤ SAP Business Intelligence ➤ SAP BusinessObjects Analysis ➤ Analysis for Microsoft Excel.
2. From the File menu, select Analysis ➤ Open Workbook (Open Workbook from SAP NetWeaver).
3. Select your back-end system.
   Tip: The list of systems corresponds to the systems available in your SAP Logon.
4. If single sign-on is not configured provide your user information.
5. Search for /RAP/MP* on the Search tab.
6. Open any of the workbooks from the list of SAP Merchandise Planning for Retail workbooks. The opening of the workbook indicates that there are no issues with the connection between your back-end system and SAP BusinessObjects Analysis, edition for Microsoft Office.

6.4.2.12 Verify Users, Privileges, and Roles

Use

Prior to proceeding with the post-installation steps for the application, you need to ensure that the required database and back-end application users have all the required privileges, roles and authorizations.

Prerequisites

You have read and implemented the procedure described in Verify SAP HANA User and Privileges [page 40].
Procedure

1. Ensure that the SAP HANA database users listed below exist and that they have the required additional roles/privileges.

<table>
<thead>
<tr>
<th>User</th>
<th>Role/Privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP&lt;SID&gt;</td>
<td>○ Privilege EXECUTE on procedure TRUNCATEPROCEDUREOBJECTS</td>
</tr>
<tr>
<td></td>
<td>○ Privilege EXECUTE on procedure GETPROCEDUREOBJECTS</td>
</tr>
<tr>
<td>_SYS_REPO</td>
<td></td>
</tr>
<tr>
<td>&lt;Your User Name&gt;*</td>
<td>○ Privilege REPO.READ on package bw2hana/SAP&lt;SID&gt;_/RAP/&lt;InfoCube&gt;_REPORTING</td>
</tr>
<tr>
<td></td>
<td>The corresponding privileges will be created automatically when activating BI Content.</td>
</tr>
<tr>
<td></td>
<td>○ Session Client of this database user has to be set to the appropriate back-end system client.</td>
</tr>
<tr>
<td></td>
<td>1. Log on to SAP HANA Studio.</td>
</tr>
<tr>
<td></td>
<td>2. Open the Modeler perspective and use the Navigator to access your back-end system.</td>
</tr>
<tr>
<td></td>
<td>4. Set the Session Client to the client number created in Set Up SAP Client [page 47].</td>
</tr>
<tr>
<td></td>
<td>This step is necessary to use the SAP Merchandise Planning for Retail planning framework, where SAP BusinessObjects Analysis, edition for Microsoft Office workbooks obtain data from SAP HANA views. For more information, see the Assign Default Client section in the SAP HANA Modeling Guide.</td>
</tr>
</tbody>
</table>

*The username on SAP HANA database level, back-end system and on the front-end server (SAP NetWeaver Gateway) must be identical.

2. Ensure that your back-end application user has the following roles/authorizations.
6.4.3 Configure Data Replication Steps

6.4.3.1 Initial Load of Data to DDF Using DRFOUT

Use

SAP Merchandise Planning for Retail uses master data, such as product, location, and product hierarchy, that is replicated from SAP ERP (more specifically, the SAP Retail add-on to SAP ERP) to the DDF module in SAP Customer Activity Repository using the DRFOUT data replication framework.

Note

Not all of the master data is replicated into DDF using DRFOUT. Some data must be replicated separately using SLT replication.
SAP Merchandise Planning for Retail requires that the following master data is replicated from a connected SAP ERP system using DRFOUT:

Table 82:

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Master Data</th>
<th>Technical Details</th>
<th>For more information, see:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Product Hierarchy</td>
<td>• SAP ERP Description: Material Group Hierarchy</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a>&lt;your release&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DRFOUT Outbound Implementation: PMCH</td>
<td>➤ Application Help ➤ Demand Data Foundation ➤ Integration Information ➤ Inbound Interfaces For Remote Function Call (RFC) Communication ➤ Product Hierarchy Master Data ➤ Product Master Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DDF Inbound Interface: /DMF/ MDIF_PROD_HIER_INBOUND</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Product</td>
<td>• SAP ERP Description: Material</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a>&lt;your release&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DRFOUT Outbound Implementation: PMAT</td>
<td>➤ Application Help ➤ Demand Data Foundation ➤ Integration Information ➤ Inbound Interfaces For Remote Function Call (RFC) Communication ➤ Product Master Data ➤ Product Location Master Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DDF Inbound Interface: /DMF/ MDIF_PRODUCT_INBOUND</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Location</td>
<td>• SAP ERP Description: Plant</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a>&lt;your release&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DRFOUT Outbound Implementation: PPLT</td>
<td>➤ Application Help ➤ Demand Data Foundation ➤ Integration Information ➤ Inbound Interfaces For Remote Function Call (RFC) Communication ➤ Product Location Master Data ➤ Product Location Master Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DDF Inbound Interface: /DMF/ MDIF_LOCATION_INBOUND</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Product Location</td>
<td>• SAP ERP Description: Material/Plant</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a>&lt;your release&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DRFOUT Outbound Implementation: PMPL</td>
<td>➤ Application Help ➤ Demand Data Foundation ➤ Integration Information ➤ Inbound Interfaces For Remote Function Call (RFC) Communication ➤ Product Location Master Data ➤ Product Location Master Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DDF Inbound Interface: /DMF/ MDIF_PROD_LOC_INBOUND</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Product Location</td>
<td>• SAP ERP Description: Sales Price</td>
<td><a href="http://help.sap.com/car">http://help.sap.com/car</a>&lt;your release&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DRFOUT Outbound Implementation: PSPR</td>
<td>➤ Application Help ➤ Demand Data Foundation ➤ Integration Information ➤ Inbound Interfaces For Remote Function Call (RFC) Communication ➤ Product Location Master Data ➤ Product Location Master Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DDF Inbound Interface: /DMF/ MDIF_PROD_LOC_INBOUND</td>
<td></td>
</tr>
</tbody>
</table>
### Prerequisites

Before replicating data from SAP ERP to DDF using DRFOUT, the following prerequisites must be fulfilled:

- The following business functions are activated in SAP ERP:
  - ISR_APPL_OUTBOUND_DMF
  - ISR_RETAIL_OUTBOUND_DMF
You have noted the different terms for the following objects:

Table 83:

<table>
<thead>
<tr>
<th>SAP ERP</th>
<th>SAP Retail</th>
<th>DDF / SAP Merchandise Planning for Retail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material</td>
<td>Article</td>
<td>Product</td>
</tr>
<tr>
<td>Plant</td>
<td>Site</td>
<td>Location</td>
</tr>
</tbody>
</table>

Procedure

1. Read the Business Process Documentation associated with the Enabling Demand Data Foundation and Creating Demand Forecast business process of the Customer Activity Repository scenario in SAP Solution Manager.
2. Read the Configuring Data Replication from SAP ERP to DDF configuration document associated with the Enabling Demand Data Foundation and Creating Demand Forecast business process of the Customer Activity Repository scenario in SAP Solution Manager.

6.4.3.2 Initial Load of Sales Data from BW

Use

If you have accumulated large amounts of historical sales data using SAP POS Data Management or SAP Customer Activity Repository, it is possible that you are storing these large data sets in a connected SAP BW system. In such a case, you can perform the initial load of the sales time series (historical POS data) data into DDF using the BI Interface for Time Series report.

Procedure

1. Log on to your back-end system.
2. Execute transaction SE38.
4. Read the documentation associated with the report, carry out the described customizing, and run the report accordingly.
6.4.3.3 Initial Load of Goods Movement KPIs

Load goods movement Key Performance Indicators (KPI) for returns, receipts, and open quantity.

Context

The goods movement data is stored in the SLT replicated tables EKPO, EKET, EKBE, MARA and MARM in the Customer Activity Repository. You perform the initial load of this data into DDF using the /RAP/MPR_ECC_KPI_CALC report. This report will load 2 years of data from the current date. In addition it is recommended you run this report weekly to update the aggregated KPIs with the ongoing ERP activity.

Procedure

1. Log on to your back-end system.
2. Execute transaction SE38.
3. Specify /RAP/MPR_ECC_KPI_CALC in the Program field and choose Execute.

6.4.3.4 Delta Load of Data to DDF Using DRFOUT

We recommend that you schedule a weekly periodic task to replicate inventory data (outbound implementation PINV) from the SAP ERP system to the system for SAP Merchandise Planning for Retail 1.0 SP4. This replication builds up the inventory history data that is needed by SAP Merchandise Planning for Retail 1.0 SP4.
6.4.3.5 Delta Load of Sales Data in SAP Customer Activity Repository

Use

Once the initial load of historical sales data is completed or, if you are working on a brand new system implementation and do not have to perform an initial sales data load, you need to configure the periodic delta load of sales data in SAP Customer Activity Repository.

Procedure

1. Ensure that you have properly configured the POS Sales Transfer and Audit functionality in SAP Customer Activity Repository to receive transaction data from your connected POS systems.
   For more information, see Business Process Documentation associated with the Performing POS Data Transfer and Audit business process of the SAP Customer Activity Repository Solution Manager scenario.
2. Ensure that you have configured the Supply - DMF-Based Applications outbound tasks to load sales data from POS Sales Transfer and Audit to DDF.
   For more information, see http://help.sap.com/car Application Help POS Transaction Management Task Processing Tasks for Sending Data to Follow-On Applications.

   ➤ Recommendation
   If you are not storing aggregated sales data in an SAP BW system, and have historical sales data that you would like to load into DDF from POS Sales Transfer and Audit, you can configure the Supply - DMF-Based Applications outbound tasks to perform this initial load.

3. Monitor the transfer of sales time series data as described in http://help.sap.com/car Application Help Demand Data Foundation Integration Information Inbound Processing.
4. Specify Point of Sale Data as the source of sales data in Customizing under Cross-Application Components Demand Data Foundation Data Maintenance Define Time Series Source.

More Information

6.4.3.6 Delta Load of Goods Movement KPIs

Once the initial load of historical goods movement KPIs data is completed you should continue to update your data on a weekly basis. As data is replicated from SAP ERP activity the values for goods movement KPIs can only be added to the Demand Data Foundation when you execute the report `/RAP/MPR_ECC_KPI_CALC`.

6.4.3.7 Replicate SAP ERP Tables for SAP Merchandise Planning for Retail

**Use**

In this procedure, you ensure that all SAP Retail or SAP S/4HANA tables that are relevant for SAP Merchandise Planning for Retail have not only been created but have also been filled with data. More specifically, you replicate the contents of relevant tables from the source SAP Retail or SAP S/4HANA system to your back-end system.

**i Note**

If you have already replicated the relevant tables in the Create/Replicate Source Master Data System Tables [page 49] procedure, you can skip this procedure.

The steps outlined in this procedure are required when you are implementing one of the system landscape variants that require data to be replicated from a source SAP Retail or SAP S/4HANA system. If your source SAP Retail or SAP S/4HANA system and your back-end system are co-deployed on the same SAP HANA database, proceed to the next procedure.

SAP Merchandise Planning for Retail requires that the following master data is replicated from a connected SAP ERP system using SLT replication:

<table>
<thead>
<tr>
<th>Master Data</th>
<th>SAP ERP Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Material Data</td>
<td>MARA,</td>
</tr>
<tr>
<td>Units of Measure for Material</td>
<td>MARM,</td>
</tr>
<tr>
<td>Purchasing Document Item</td>
<td>EKPO,</td>
</tr>
<tr>
<td>History per Purchasing Document</td>
<td>EKBE</td>
</tr>
<tr>
<td>Scheduling Agreement Schedule Lines</td>
<td>EKET</td>
</tr>
</tbody>
</table>

**Procedure**

1. Define client transformation rules for all SAP ERP tables that you plan to replicate.
In most cases, you need to apply transformation rules to map the client of the source SAP ERP system to the client on the target back-end system.

⚠️ Caution

Transformation rules must be defined before replicating tables.

For more information, refer to one of the following:
- Set Up SAP Client [page 47]
- SAP Note 1733714

2. Read SAP Note 2054656 and replicate the tables listed in the file attached to this SAP Note. For more information, see:

⚠️ Caution

This procedure includes the replication of tables from your source SAP ERP system. Trigger-based replication includes deletion in source tables by archiving activities (since on the database level it is impossible to distinguish between delete actions caused by archiving and regular deletion of data records). As a result, SAP LT (Landscape Transformation) Replication Server replicates archiving activities as delete actions in the SAP HANA database.

More specifically, when data is archived in your source SAP ERP system, records are deleted from their respective database tables. Therefore, when these tables are replicated to another SAP HANA database, the records that were archived in the source tables are deleted in the target database tables.

When deciding on the frequency at which to archive data in the source SAP ERP system, you must consider and balance the performance requirements of your SAP ERP system and the amount of historical data that should be replicated to and available in your back-end system.

6.4.4 Specify Analysis Workbooks Settings

6.4.4.1 Enable Macros

Use

In this procedure, you enable your SAP BusinessObjects Analysis, edition for Microsoft Office workbooks to use macros.
Procedure

1. Open the SAP BusinessObjects Analysis, edition for Microsoft Office from Start → All Programs → SAP Business Intelligence → SAP BusinessObjects Analysis → Analysis for Microsoft Excel.
2. Choose File → Options → Customize Ribbon.
3. Under Customize the Ribbon, select Main Tabs.
4. Enable the entry Developer and confirm by choosing OK.
5. Now you will see the new Developer tab in your SAP BusinessObjects Analysis, edition for Microsoft Office.
7. Choose Enable all macros.

6.4.4.2 General Workbook Settings

Use

You use Analysis for Microsoft Excel in which you can launch the planning workbooks.

Procedure

If you are unable to see the Analysis and SAP Planning for Retail tabs on the menu of Analysis for Microsoft Excel, perform the following steps in the Options, Add-Ins of the Excel options:

1. Enter COM in the Manage field and choose Go.
2. In the COM Add-Ins box, select the Analysis and Planning options and choose Go. If you do not find them in the list, Enter Disabled in the Manage field and choose Go.

Now you are able to view the Analysis and SAP Planning for Retail tabs. On the Analysis tab right click and, go to Settings, and ensure that the Planning field is selected.

6.5 SAP Promotion Management for Retail

6.5.1 Activate Internet Communication Framework (ICF) Services

For security reasons, all Internet Communication Framework (ICF) services relevant to your SAP Promotion Management for Retail application are made available in an inactive state. In this procedure, you activate an ICF service required for the SAP Manage Promotional Offers Fiori app.

1. Log on to your front-end system.
2. Open service maintenance (transaction SICF).
3. In the Maintain Service screen, select the service by specifying the following:
   ○ Hierarchy Type: SERVICE
   ○ Virtual Host: DEFAULT_HOST
   ○ Service Path: /sap/bc/bsp/sap/
   ○ Service name: pmroffers
4. Choose Execute.
5. To activate the service, choose Service/host Activate.
7 Additional Information

7.1 Workbook Design Example

Use

In this procedure, you walk through an example of creating an SAP BusinessObjects Analysis, edition for Microsoft Office workbook. You can use steps of this procedure to create customized versions of the SAP-delivered assortment planning workbooks.

Prerequisites

The necessary BI queries must exist in the back-end system.

Procedure

1. Open SAP BusinessObjects Analysis, edition for Microsoft Office from Start ➔ All Programs ➔ SAP Business Intelligence ➔ SAP BusinessObjects Analysis ➔ Analysis for Microsoft Excel.
2. Select the cell in the worksheet where the crosstab with the data from the selected data source should be inserted.
3. From the menu, choose Analysis ➔ Insert ➔ Select Data Source.
5. In the Select Data Source dialog box, select the source system, then choose Next.
6. In the Logon to system <Your System Name> dialog box, enter your logon data, then choose OK.
7. In the Select Data Source dialog box, choose tab Search.
8. In the Search tab, you can search for the description or technical name of a data source, that is, the name of the BI query that will provide the data for your workbook. For example, search for /RAP/M01A01_IRQ02 or /RAP/M01A01_IRQ01. In general, you can search for /RAP* to find any SAP Assortment Planning for Retail query.
9. Select the required data source, and then choose OK.
10. On the Prompts screen, make the relevant entries base on the selected query in the Specify Value for Prompts area.
11. Choose OK, and then you will see the table is inserted in the sheet. You can now analyze the data and change the displayed data set according to your needs. You can also add other components to your analysis, for example charts.
12. Choose menu Analysis ➔ Display to open the design panel.
13. Choose the Components tab in the bottom right corner, and right-click Book1 and choose Use Planning Sequence.
14. In the Search For field of the Open Planning Sequence dialog box enter your planning sequence and choose Search.
15. Select the required planning sequence, and then choose OK. The planning sequence will be displayed under Book1 Planning Objects in the design panel.
16. Select the cell in the worksheet where a button should be inserted.
17. From the menu, choose Developer Insert Button (Form Control), and insert the button using drag and drop.
18. In the Assign Macro dialog box, choose New.
19. In the VB edit, maintain the relevant code in the Sub ButtonX_Click area.
20. Choose Close.
21. Right-click the button, and choose Edit Text. Replace the button name with a meaningful name.
22. Position your cursor where the condition will be defined, and make the relevant entries.
23. Select the sheet and position the cursor where the variable list will be inserted, for example cell H1 in sheet1.
24. Choose menu Analysis Info Field Variables, and the variables will be inserted into the relevant sheet.
25. Maintain the relevant entries in the sheet.
26. Choose your Planning Sequence in the design panel.
27. In the section of Variables of Planning Sequence, make the relevant entries.
28. Choose Save Button.
29. Provide a file name and save the workbook as type Excel Macro-Enabled Workbook (*.x1sm).
30. Choose Save.

Result

The customized workbook is created.
Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings (“Code”) included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP’s current view of accessibility criteria as of the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with “you”, or a gender-neutral noun (such as “sales person” or “working days”) is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency (see: http://help.sap.com/disclaimer).